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P r e f a c e

SPSS Data Entry is a tool for fast and flexible survey design and data collection, 
offering a drag-and-drop interface for developing both printed and online data entry 
forms. Data Entry also helps prepare your data for analysis because when you specify 
the questions and responses that appear on your forms, you also define the variables 
you’ll use to run analyses.

SPSS Data Entry is designed to be used with statistical software from SPSS Inc. 
You can read your Data Entry files into and out of SPSS programs at will. Throughout 
the documentation, tips and techniques are described to help you get the maximum 
benefit from both Data Entry and your data analysis software.

Data Entry Builder and Data Entry Station

You can purchase Data Entry Builder by itself or in combination with multiple copies 
of Data Entry Station, depending on your needs.

Data Entry Builder includes everything that you need to build custom forms, enter 
data, and check data for accuracy using rules.

Data Entry Station is a scaled-down version of SPSS Data Entry intended only for 
entering or checking data. If you have a large team, buying one or more copies of 
Data Entry Station in combination with Data Entry Builder can speed the data 
entry process by allowing more people to get involved.

Serial Numbers

Your serial number is your identification number with SPSS Inc. You will need this serial 
number when you contact SPSS Inc. for information regarding support, payment, or an 
upgraded system. The serial number was provided with your SPSS Data Entry package.
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Customer Service

If you have any questions concerning your shipment or account, contact your local 
office, listed on the SPSS Web site at http://www.spss.com/worldwide/. Please have 
your serial number ready for identification when calling.

Training Seminars

SPSS Inc. provides both public and onsite training seminars. All seminars feature 
hands-on workshops. Seminars will be offered in major cities on a regular basis. For 
more information on these seminars, contact your local office, listed on the SPSS Web 
site at http://www.spss.com/worldwide/.

Technical Support

The services of SPSS Technical Support are available to registered customers of SPSS 
Data Entry. Customers may contact Technical Support for assistance in using SPSS 
Data Entry or for installation help for one of the supported hardware environments. To 
reach Technical Support, see the SPSS Web site at http://www.spss.com, or contact your 
your local office, listed on the SPSS Web site at http://www.spss.com/worldwide/. Be 
prepared to identify yourself, your organization, and the serial number of your system.

Tell Us Your Thoughts

Your comments are important. Please let us know about your experiences with SPSS 
Data Entry. We especially like to hear about new and interesting applications using 
SPSS Data Entry. Please send e-mail to suggest@spss.com, or write to SPSS Inc. 
Marketing Department, Attn.: Director of Product Planning, 233 South Wacker Drive, 
11th Floor, Chicago, IL 60606-6412. 

Contacting SPSS 

If you would like to be on our mailing list, contact your local office, listed on the SPSS 
Web site at http://www.spss.com/worldwide/.
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Data Entry Overview

SPSS Data Entry is a powerful tool for fast, accurate data entry—and much more. 
When you need data fast and clean, you need SPSS Data Entry.

Design survey questionnaires. Data Entry is a powerful tool for building forms and 
questionnaires. You can choose from a number of sample surveys to help you get 
started, copy preformatted questions from question libraries, or build your own forms 
from scratch. You can also generate forms from existing SPSS data files.

Create paper and online forms. You may find that you can use the same form in print 
that you use online, or you can develop alternate versions of a form—one optimized 
for online data entry, the other used for your printed questionnaire. You can map 
questions on both forms to a common set of variables so that if you later make changes 
to one of your variables (for example, to the wording of a question), questions on both 
forms are updated automatically.

Successful surveys begin with well-defined questions. Too often, researchers consider 
how to enter and analyze their data only after they’ve mailed their questionnaires. In 
Data Entry, as you create your questions and responses, you also define the variables 
you’ll use to conduct your analyses. The result is data that are not only clean but also 
ready to analyze.

Fast, efficient data entry. Data Entry has a number of features to speed online data 
entry. You can create Skip & Fill rules to automatically fill in specific questions based 
on previous responses or use Table Entry view to quickly enter data into a tabular grid 
similar to a spreadsheet.

Enter clean data. Create Validation rules to ensure that data are entered correctly the 
first time, or use Checking rules to screen for logical inconsistencies (for example, if 
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a male respondent claims to be pregnant, you most likely have an error). You can also 
check for errors in your existing data files. Double-entry verification is available using 
the file compare facility.

Analyze your data using statistical software from SPSS. SPSS Data Entry is designed to 
be used with statistical software from SPSS Inc., maker of powerful tools for data 
analysis. You can read your Data Entry files into and out of SPSS programs at will. 
Throughout the documentation, tips and techniques are described to help you get the 
maximum benefit from both Data Entry and your data analysis software.

Steps for Using SPSS Data Entry

A typical user conducting a survey would work through the following steps:

Build a form or questionnaire, complete with questions, variables, and rules.

Distribute or administer the questionnaire.

Collect, enter, and clean data.

Analyze the data using statistical software from SPSS.

Alternatively, you can use the checking facility to check your existing data files or 
generate a form from an existing data file.

Forms

A file can have one form or many forms, each composed of questions. The form 
toolbox includes tools to create custom questions with different types of response 
controls, including multiple response questions, and tools to quickly arrange groups of 
questions in a tabular matrix. You can also add text annotations, pictures, and other 
elements.

Data Entry Builder allows you to use the same form for online data entry that you 
use for your printed questionnaire, which saves you time. (For online data entry, you 
can use either Data Entry Station 4.0 or the Data Entry Enterprise Server 4.0.) You can 
also develop alternate versions of a form—one optimized for online data entry, the 
other used for your printed questionnaire, and both linked to a common set of variables.
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Figure 1-1
Use the same form online and in print
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Questions and Variables

Questions are the foundation of any survey and the building blocks of data entry forms. 
Each question on a form has one or more controls that allow users to enter a response. 
A number of control types are available, including text boxes, check boxes, option 
buttons, and drop-down lists.

Figure 1-2
Variables displayed in Builder window

Answers to questions are stored in variables. The variables are created as you define 
your questions so that you’ll be ready to enter data and run your analyses when the time 
comes. For example, the question Date of purchase? might be bound to a variable 
named pdate. In fact, you can think of a question as a representation of one or more 
variables on a form.
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Rules

Rules can validate data as they are entered, check logical relationships between 
variables, or automatically fill in or skip over specified questions. You can add rules to 
your forms to ensure that data are clean as they are entered or use the data checking 
facility to identify problems with existing data files. Beyond simple data validation, 
rules can check logical relationships between variables (for example, if gender equals 
male, then pregnant must be no) or speed data entry by automatically filling in data 
based on responses to specific questions.

Figure 1-3
Rule Wizard
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Collecting, Entering, and Cleaning Data

You can gather data via traditional mail or by conducting interviews over the phone or 
in person. Use Data Entry Builder or Data Entry Station to enter responses from 
interviews or printed questionnaires. Purchase multiple copies of Data Entry Station to 
increase your team’s productivity by distributing the task of entering data among team 
members, even across multiple sites. 

For example, suppose you have several offices conducting phone interviews in 
different parts of the country. At the end of each day, each site sends you a file via 
e-mail containing the cases entered that day, and you merge the data from all of the 
sites into a single file (using the Add Files utility).

Once the data are entered, you can use the data checking facility to identify and 
report errors. You can clean the data in either Data Entry or your statistical software 
program. If you want to be doubly safe, double-entry verification is also available.

Analyzing Data Using SPSS Software

SPSS Data Entry is designed to be used with statistical software from SPSS Inc., maker 
of powerful tools for data analysis. Whether you need simple reporting and summary 
statistics or in-depth analysis using advanced statistical procedures, such as Factor, 
Reliability, or Cluster Analysis, SPSS offers products to meet your needs.

Figure 1-4
Cases displayed in SPSS Data Editor
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Data Entry saves data in a standard SPSS data file, a spreadsheet-like format with rows 
and columns. Each row is a case, and each column is a variable. For example, if you 
ask 100 people 10 questions, you’d have a data file with 100 cases (rows). The number 
of variables that you have depends upon the types of questions and your survey. For 
example, if your survey has 10 questions, and each question has 5 check-box answers, 
your survey will have at least 50 variables. Each case has information about one 
submitted survey, and variables store the answers to questions.

Throughout the documentation, tips and techniques are described to help you get the 
most from both Data Entry and your data analysis software.

Data Entry Product Components

Depending on your needs, you can purchase Data Entry Builder by itself or in 
combination with multiple copies of Data Entry Station. You can also purchase the 
SPSS Data Entry Enterprise Server.

Data Entry Builder

Data Entry Builder includes everything that you need to build custom forms, enter data, 
and check data for accuracy using rules. Builder offers an easy-to-use graphical 
environment for defining variables and questions, developing custom forms, and 
creating Validation, Skip & Fill, and Checking rules to ensure that the data are clean. 
Sample surveys and question libraries are also included. If you’re a lone researcher or a 
one-PC shop, a single copy of Data Entry Builder should have everything that you need.
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Figure 1-5
Form window, Builder window, and toolbox

Data Entry Station

Data Entry Station is a scaled-down version of SPSS Data Entry intended only for 
entering or checking data. While you cannot use Data Entry Station to create new 
surveys or data files (these tasks must be done in Data Entry Builder), you can add data 
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to an existing file. Similarly, you can use rules to check your data in Data Entry Station, 
but to create new rules, you’ll need Builder.

It is expected that Data Entry Station will be purchased in combination with at least 
one copy of Data Entry Builder (since you can’t use Station to create surveys). If you 
have a large team, buying one or more copies of Data Entry Station in combination 
with Data Entry Builder can speed the data entry process by allowing more people to 
get involved.

SPSS Data Entry Enterprise Server

You can purchase SPSS Data Entry Enterprise Server if you have a large team or if you 
wish to deploy surveys over the Web. The SPSS Data Entry Enterprise Server provides 
two powerful tools for data collection: the Network Server and the Web Server. The 
Network Server is designed for teamwork. A team member may play more than one 
role during the course of a survey, but every member is able to work more efficiently. 
For any survey that will be deployed at your site, team members may include:

Survey designer. The team member who develops the survey form, including the 
questions, valid responses, and rules. (This may be the same person as the survey 
administrator.)

Survey administrator. The team member who deploys and maintains the survey. The 
administrator may be responsible for exporting the survey files from Data Entry 
Builder, and registering the survey master files with the Data Entry Network Server, 
which is used by the entire team. Once the files are registered, users of both Builder 
and Station can submit cases.

Survey analyst. The team member who analyzes the survey data, usually with the SPSS 
for Windows application. This person uses the data collected in the survey’s master 
.sav file, or other data sources. (This may be the same person as the survey designer.)

System administrator. The team member who is responsible for installing the Data 
Entry Network Server. The system administrator is also responsible for the computer 
system that hosts the Data Entry Network Server. This person may also administer the 
data sources at your site. 

The Data Entry Web Server displays your survey as HTML. When an Internet or 
intranet user answers your survey and submits the information, the Data Entry Web 
Server collects the data and sends it to the Network Server, where it is saved in a master 
file in .sav format. When your survey is complete, you can open the .sav file in SPSS 



10

Chapter 1

for data analysis or in SPSS Data Entry Builder for cleaning. For more information on 
the SPSS Data Entry Enterprise Server, refer to the SPSS Data Entry Enterprise Server 
User’s Guide.

Question Libraries and Sample Files

Data Entry Builder includes several question library files with fully formatted sample 
questions that you can copy and paste into your forms. The libraries include examples 
of categorical questions, as well as open-ended questions, demonstrating how these 
types of questions can be implemented in Data Entry using text boxes, check boxes, 
option buttons, and drop-down lists. Multiple response questions and tabular response 
item matrices are also included.

You can copy questions from the library into your form and use them as they are or 
customize each to your particular needs. The emphasis is on demographics, but by 
modifying the question text and response items, the questions in the libraries may serve 
as the starting point for almost any type of survey. 

A number of fully formatted sample files are also included with Data Entry Builder. 
Each demonstrates a simplified solution for a given scenario.

You can access the question libraries via the Edit menu in Builder. The samples are 
installed in the same directory as your Data Entry software.

Where to Go from Here

For an introduction to using Data Entry, see Chapter 2 or the online tutorial. (To 
run the tutorial, start Data Entry and select Tutorial from the Help menu.)

To define questions and variables for a new survey, see Chapter 4 and Chapter 7.

To use the question libraries, see Chapter 9.

To create a form from an existing data file, see Chapter 4.

To customize your forms, see Chapter 10.

To create Validation, Checking, or Skip & Fill rules, see Chapter 11.

To enter data, see Chapter 14.

To use the data checking facility to check for errors in your existing data files, see 
Chapter 15.
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Quick Tour

In this chapter, you will learn how to: 

Create a short survey using three different question types.

Create a simple Skip & Fill rule.

Save the file.

Enter data into the survey.

Figure 2-1
Quick Tour survey
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Starting Builder
Figure 2-2
Windows Start menu

E From the Windows Start menu choose:

Programs
SPSS Data Entry 4.0

SPSS Data Entry Builder
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Figure 2-3
Form window, Builder window, and toolbox

When you open Builder, a blank form is displayed. You can open an existing file or 
start working with the blank form to create a new file. The Builder window is where 
you will view and manage your forms, questions, variables, and rules. The Form 
window is where you will create your forms. You will use the toolbox to add questions, 
lines, rectangles, and pictures to your forms.
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There are several different types of questions that you can create, depending on 
what sort of data that you want to collect. The questions are covered in more detail in 
Chapter 4. For this survey, you will learn how to create an option button question, a 
text box question, and a multiple response check box question.

Turning on Automatic Question Numbering

Before you create any questions, you can decide whether you want your questions 
automatically numbered. If you delete, cut, or paste questions, your question numbers 
automatically update to reflect the change. 

To turn on automatic question numbering:

E Click on your form to select it.

Figure 2-4
Changing the AutoNumber property in the Properties window

E In the Properties window, change the AutoNumber property to True.

When the AutoNumber property is set to True, any question that you create will contain 
a question number. For now, set your form’s AutoNumber property back to False. Later 
in the Quick Tour, you will learn how to manually add question numbers.
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Creating an Option Button Question

The option button question is used when you want to ask a question that will require 
one answer and will provide the respondent a limited number of responses. Each 
response is one option button. The first question in your survey is How often do you 
travel overseas? The possible responses are Never, Every Other Year, Every Year, and 
Twice a Year or More.

You will use the form toolbox to create the option button question. If the toolbox is not 
visible, from the menus choose:

View
Toolbox

Figure 2-5
Selecting option buttons from the well

E Move the mouse pointer over the option button question tool and hold down the left 
mouse button to display the option button well.

E Drag and release the mouse in the option button well to specify one column of four 
option buttons.
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The cursor changes to indicate that the option button tool is selected.

E Click on the form to create the question.

Note: If you want to move your question, simply click on the question container, which 
is the box surrounding the question, and drag to another place on the form.

Figure 2-6
Created option button question
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Figure 2-7
Editing the question and response text

E To edit the question text and response text, double-click on them.

E For the question text, type How often do you travel overseas?

E For the first option button, type Never. For the second, type Every Other Year. For the 
third, type Every Year. For the fourth, type Twice a Year or More.

When you create questions using the toolbox, variables are automatically created at the 
same time.

E To define the variable for the question, right-click on the question and choose Variable 

Properties.
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Figure 2-8
Selecting Variable Properties from the context menu

The Variable Properties window is displayed. Each tab in the Variable Properties 
window allows you to define a different aspect of the variable.

Figure 2-9
Variable Properties window
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The Variable Label area and Question Text area will already show How often do you 
travel overseas? If you edit the question text, the changes will appear on your form and 
vice versa. 

E Type TRAVEL in the Variable name area. Variable names are restricted to eight 
characters. 

E Click the Values tab.

Figure 2-10
Variable Properties window: Values tab

The changes that you made on the form to the option buttons are displayed in the 
Response Item column. Note that each option button control on the form represents a 
response item in the Variable Properties window. You don’t have to make any further 
changes. 

E Click the Valid Values tab.
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Figure 2-11
Variable Properties window: Valid Values tab

E Select Values which are labeled and response items. 

This creates a simple Validation rule that limits entered data to the four response items 
that you defined: Never, Every Other Year, Every Year, and Twice a Year or More.

E Close the Variable Properties window.

Connection between Questions and Variables 

Questions and variables are not the same thing in the program, but they are closely 
related. You can use the program without ever understanding this connection, but the 
many different methods for adding and removing responses from questions and 
variables will make more sense to you if you do.

A question is a representation of a variable on a form, and the question text and response 
items displayed in questions are actually stored in the variable bound to the question.



21

Quick Tour

This makes it easy to keep your questions and forms up to date and provides 
multiple ways of doing things. You can edit question text and response choices directly 
on your form or in the Variable Properties window. Either way, the result is the same. 
Similarly, if you want to remove one of the buttons in an option button question, you 
can select and delete the button right on the form or delete the corresponding response 
item in the Variable Properties window. The result is the same, so use whichever 
method is convenient for you.

Creating a Text Box Question

Use the text box question when you want to ask a question that will require a text 
answer. The second question of your survey is Last overseas destination.

E Click the text box question tool from the toolbox.

E Click on the form to create the question.

Figure 2-12
Created question
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E Double-click on the question and type Last overseas destination:.

Figure 2-13
Editing the question text

E To define the variable, right-click and choose Variable Properties.

E In the Variable Properties window, type DESTIN for the variable name. (The question 
text that you entered on the form is already displayed.)
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Figure 2-14
Variable Properties window: Format tab

E Click the Format tab.

E Choose String as the variable type and specify the number of characters as 50.

E Close the Variable Properties window.

Customizing Your Form

You can change the properties of your form or question to alter the appearance and 
functionality of your form. You can:

Change the font, size, and color of text.

Apply custom styles to questions, such as raised, flat, or sunken.

Change the border style, color, and width.

Change the position and alignment of text within controls.

Enable or disable questions and controls.

Require respondents to answer a question or select a certain number of responses 
for a multiple response set.
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To view the properties for an item:

E Click on the item.

E From the Form menu choose:

View
Properties

Figure 2-15
Properties window
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Builder Window
Figure 2-16
Builder window

The Builder window allows you to access the objects that make up your file.

E From the Builder window menus choose:

View
Variables

You can see a list of your variables. 

E Double-click DESTIN to view the properties of the variable. Close the Variable 
Properties window.

E From the Builder window menus choose:

View
Rules

You can see the Validation rule that you created for TRAVEL.
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Creating a Multiple Response Set

When you have a question that may require more than one response, you can create a 
multiple response set. When you create a multiple response set, you create a variable 
for each response. 

The third question in your survey is Which of the following continents would you 
consider visiting? The possible responses are Europe, Australia, Asia, South America, 
and Africa. Use the check box question tool to create the question.

The tool well allows you to specify the number and arrangement of the check boxes.

E Move the mouse pointer over the check box question tool and hold down the left mouse 
button to display the check box well.

E Drag and release the mouse in the well to specify one column of five check boxes.

Figure 2-17
Using the check box well
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E Click on the form to create the question.

Figure 2-18
Created check box question

E Double-click on the question text and type Which of the following continents would 
you consider visiting? 

E For the check boxes, type Europe, Australia, Asia, South America, and Africa.

E To define the multiple response set, from the Builder window menus choose:

View
Variables

When you want to define several variables at once, the Builder window provides easy 
access to the variables.
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Figure 2-19
Builder window

When you created the check box question, you created a multiple response set, which 
appears in the Builder window as $set001. The set consists of five variables. Each 
check box represents a subquestion with its own variable, since each check box is 
storing a response to the question. You will have to define your set and then define each 
of the variables.

E In the Builder window, double-click $set001 to view the properties of the set.
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Figure 2-20
Set Properties window: General tab

E To change the set name, type TRIP in the Name text box. All sets must start with a $, 
which is automatically provided for you.

E Type trip in the Alias text box. Because of the naming conventions of JScript, which is 
the language the program uses to make rules, sets must have an alias.

The counted value for dichotomies is the number stored in the check box representing 
the selected variable. When you are performing statistical analysis, your analysis 
software will know which responses were chosen because their variables will have the 
counted value stored inside of them.

E To specify the counted value, select 1 from the drop-down list.

E Click the Members tab.
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Figure 2-21
Set Properties window: Members tab

You can see the five variables, which are represented on your form by each of the check 
boxes. If you wanted to add another member, you could use the Insert New Variable 
button. 

E Click the General tab in the Set Properties window. 

E To define your variables, in the Builder window, click var00001. 

E Change the name from var0001 to europe. Since the variable name already conforms 
to JScript naming conventions, you need not specify an alias.

E Change the names of the other variables. Change var00002 to austral, var0003 to asia, 
var0004 to southam, and var0005 to africa.

E Close the Variable Properties window.
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Adding Question Numbers

You can manually add question numbers to questions. 

E Hold down the Shift key and click on each question to select your three questions.

E From the Form menu choose:

Layout
Numbering

Add Question Number

Question numbers are added to your question. If you were to delete one of the 
questions, your questions would automatically renumber. If you add a question, your 
new question will not have a question number. Questions are not automatically 
numbered unless you set the form’s AutoNumber property to True.

Saving Your Data File
Now that you have created variables, you can save your data file.

E From the Builder window menus choose:

File
Save

Figure 2-22
Save As dialog box

E Type quickt.sav and click Save.
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Creating a Skip & Fill Rule

Skip & Fill rules allow you to skip questions that are not applicable for certain cases 
and fill in values for questions based on previously entered values. You will now create 
a rule so that when a person enters Never for question 1, the program will automatically 
enter Not applicable to question 2 and skip to question 3.

E From the Form window menus choose:

Rules
Rule Wizard…

Figure 2-23
Rule Wizard dialog box

E Select Skip & Fill rule and click Next.
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You can learn about Validation and Checking rules from the online rules tutorial or 
from Chapter 11 and Chapter 12.

Figure 2-24
Rule Wizard - Skip & Fill Assignments dialog box

E In the Skip & Fill Assignments dialog box, select the check box next to question 1 and 
click Next.
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Figure 2-25
Rule Wizard - Skip & Fill Rule

E In the Variables drop-down list, select TRAVEL.

E In the Operators drop-down list, select IsLabeled.

E In the Values drop-down list, select Never.

As you make your selections, the rule script is written in the Expression window in the 
middle of the Rule Wizard. Your rule is tied to question 1. When you enter Never in 
question 1, the rule is activated. The next step is to tell the rule that when Never is 
entered in question 1, it should fill Not Applicable for question 2 and then skip to 
question 3.

E In the Then area of the Rule Wizard, click Fill Values.
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Figure 2-26
Fill when Expression is True dialog box

E In the text area next to DESTIN, type Not Applicable.

E Click Continue.

E In the Then area of the Rule Wizard, click Skip to a Question.

Figure 2-27
Skip when Expression is True dialog box
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E In the drop-down list of questions, select Question3.

E In the drop-down list of forms, select Form1.

E Click Continue.

E In the Rule Wizard, click Finish.

When you enter Never in question 1, the program will fill in Not Applicable in question 2 
and automatically skip to question 3.

E From the Builder window menus choose:

View
Rules

Figure 2-28
Rules in the Builder window

The rule named Form1_Question1 is the rule you just created. A Skip & Fill rule is 
named after the question it is attached to. The rule named TRAVEL is the Validation 
rule you created in the Variable Properties window as part of this Quick Tour. A 
Validation rule is named after the variable it is attached to.

Entering Data

Now you are ready to enter data.
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E From the Form window menus choose:

View
Form Entry

Figure 2-29
Form Entry view

Entering Data in Form Entry View

E Use the mouse or the arrow keys to select an answer for the first question. 

E Press the Tab key to move to the second question.

E In the text box, type the location of your last overseas destination and 
press the Tab key. 

E Use the mouse to select an answer for the first question.

E Press the Tab key to move to the second question.

E In the text box, type a location.
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E To save your file, from the File menu choose:

File
Save

Note: If you try to save your file or switch to another view when no option is selected 
in the first question, you will receive a validation error. The Validation rule that you 
created in the Variable Properties window will not permit you to save a file or switch 
views without answering the first question. If you receive the alert, you can use the 
Navigation toolbar’s back arrow to move to the previous case. Then, you can save your 
file or switch the view.

Entering Data in Table Entry View

E From the Form window menus choose:

View
Table Entry

Each column in Table Entry view represents a variable. Each row is a case. 

Figure 2-30
Table Entry view

E Click on the first cell in the bottom row.
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A new case is inserted.

E Click the arrow in the cell and select a response from the list.

E Press the Tab key to move to the next cell.

E Type a location.

E Press the Tab key to add this case and move to the next case.

Closing Your File

E From the Builder window menus choose:

File
Save

File
Close

Opening Your File in SPSS

Now that you have a few cases in your file, you can see what your file looks like in 
SPSS. 

E From the Windows Start menu choose:

Programs
SPSS for Windows

Note: Builder is designed to be used with statistical analysis software programs from 
SPSS Inc.

E From the Data Editor menus choose:

File
Open

Data 

E Select quickt.sav and click Save.
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Figure 2-31
Builder file in SPSS

In SPSS, you can analyze your data, delete variables, edit your file, or save the file to 
be exported into a number of spreadsheet and database programs. Any changes that 
you make to the file will be reflected when you open the file again in Builder. For 
example, if you delete a variable while in SPSS and save the file, you will find that 
when you open your file in Builder, both the question and the variable are no longer in 
the file. It is always a good idea to make a backup copy of your file before you change 
it in SPSS.

E To close SPSS, from the Data Editor menus choose:

File
Exit 

You have completed the first part of the Quick Tour. To learn how to create a question 
that can receive more than one answer or a Skip & Fill rule, keep reading.

Where to Go from Here
To define questions and variables for a new survey, see Chapter 4 and Chapter 7.

To create a form from an existing data file, see Chapter 4.

To customize your forms, see Chapter 10.

To create Validation, Checking, or Skip & Fill rules, see Chapter 11.

To enter data, see Chapter 14. You can also open the sample survey for a reference 
on how to set up your file.



41

 
 

Chapter

3
Working in Builder

While you work in Builder, you will use:

The Builder window

Design and Entry views

The Form window

The toolbar

The Properties windows

Builder Window
Figure 3-1
Builder window
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The Builder window provides a base for working with your file. Within the Builder 
window, you can display and access the forms, questions, variables, and rules that 
make up your file. 

Use the View menu or toolbar to specify whether you want to display forms, 
questions, variables, or rules in the Builder window.

Double-click on the name of a form, question, or variable to go to that element or 
access its properties.

Use the File menu to create a new file, open an existing file, or print forms in your 
file.

Use the Insert menu to insert new forms, variables, or multiple response sets.

Use the View menu to switch among the Design, Form Entry, and Table Entry 
views.

Click on a column within the Builder window to sort the items in the Builder 
window.

Design View, Form Entry View, and Table Entry View

Design view. In Design view, you design forms, questions, variables, and rules. You can 
add questions to the form or select and modify existing questions, variables, and rules, 
change the tab order, or make any changes to the design of the form, questions, 
variables, and rules. The design view also provides you with an HTML preview option, 
which allows you to preview how your survey will look online. However, you cannot 
add cases to the data file, modify existing data, or run rules.

Form Entry view. You can enter data and use the data-checking facility to check for rule 
violations in an existing data file. You can use the Tab key to move between questions, 
moving freely through the form and adding or modifying data as you wish. However, 
you cannot make any changes to the form properties without switching back to Design 
view.

Table Entry view. Table Entry view is an alternative to Form Entry view for entering 
data. Data are displayed in a spreadsheet-like format, where cases are rows and 
questions are columns, allowing you to view and print multiple cases.
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To Switch between Views

From the Form or Builder window menus choose:

View
Form Entry (Table Entry, Design)

Working with Multiple Builder Windows
Figure 3-2
Two Builder windows
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You can have more than one file open at a time, which can be useful for cutting, 
copying, and pasting between the files and comparing them. When you open more than 
one file, each file has its own Builder window, listing the elements in that file. When 
multiple Builder windows are displayed, be sure you are looking in the correct Builder 
window for the file that you want to access.

Figure 3-3
Two files: One in Design view, one in Table Entry view

When you have two files open, you can switch views freely within a file. For example, 
you can have one file open in the Design view, while the other file is open in the Form 
Entry or Table Entry view.
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Inserting Forms, Variables, Sets, and Rules
Figure 3-4
Inserting a variable

You can use the Insert menu in the Builder window to insert objects into your file. You 
can insert forms, variables, multiple response sets, rules, and procedures. The Insert 
menu is helpful for creating objects quickly, particularly variables. 

Managing Objects

The Builder window is an easy place to work with your file objects. You can:

Define variables and multiple response sets.

Copy and paste forms, variables, rules, and sets. If you have multiple files open, 
each has its own Builder window, allowing you to copy and paste between Builder 
windows.

Copy and paste variable or set properties. If you have multiple files open, each has 
its own Builder window, allowing you to copy and paste between Builder 
windows.

Delete variables, questions, forms, and rules.
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Toolbars

Each window has a toolbar that provides quick and easy access to common tasks. Some 
windows have more than one toolbar. Hold the mouse pointer over a tool to display a 
ToolTip that briefly describes what the tool does.

Figure 3-5
Toolbar with ToolTip Help

To Show or Hide a Toolbar

E From the menus choose:

View
Toolbars…

E In the Show Toolbars dialog box, select the toolbars that you want to show (or hide).

You can also control the size of the toolbar buttons and the display of the ToolTips.

Figure 3-6
Show Toolbars dialog box
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To Move a Toolbar

E Click anywhere in the toolbar outside the toolbar buttons.

E Drag the toolbar where you want it.

Dragging the toolbar to the left or right side of the window attaches a toolbar 
vertically to that side.

Dragging the toolbar to the top or bottom of the window attaches the toolbar 
horizontally.

Dragging the toolbar anywhere other than the window borders creates a detached, 
floating toolbar.

Dragging the sides or corners of a floating toolbar changes the shape and 
arrangement of tools (vertical column, horizontal column, or rectangular).

Form Toolbox

You use the form toolbox to add questions, text labels, and pictures to forms. Tools are 
available for creating questions with different types of response controls as well as 
annotations and pictures. Hold the mouse briefly over a tool for a description of the tool.

Figure 3-7
Form window toolbox

For detailed information on creating questions with the toolbox, see Chapter 4.
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To Display the Form Toolbox

E To show (or hide) the toolbox, from the Form window menus choose:

View
Toolbox

The toolbox includes tools for adding questions, pictures, and annotations to forms.

E Hold the mouse briefly over a tool for a description of the tool.

E Click a tool with the mouse to select the tool.

E After selecting a tool, click on the form to add the question, text label, or picture to your 
form.

You can drag the toolbox to the top, bottom, or side of the window to dock it like any 
other toolbar or leave it as a free-floating palette. For more information on creating 
questions with the toolbox, see Chapter 4.
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Properties Window

The Properties window allows you to specify properties of forms, questions, controls, 
and toolbox tools. Properties determine the appearance, position, and behavior of form 
objects and tools.

Figure 3-8
Properties window

The Properties window always displays properties of the currently selected objects 
or toolbox tools. If multiple objects are selected, properties common to both objects 
are displayed.

The left column displays the name of each property; the right column displays the 
current value.

Click on any property and press F1 for help on that property.

Changes to properties are updated immediately on the form.
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To Set Properties for a Form, Question, Control, or Tool
Figure 3-9
Setting default properties for a question tool

E To display (or hide) the Properties window, from the Form window menus choose:

View
Properties

E Select one or more objects on a form, or select a tool in the form toolbox.

Properties of the selected objects or tool are displayed.

E Change properties in the right column of the Properties window. 
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For some properties, you simply type a value; for others, you make selections from a 
drop-down list or double-click to open a dialog box.

E Press F1 for help on the selected property.

Changes to default tool properties are applied to objects subsequently created with the 
tool. 

As a shortcut, you can access the Properties window by right-clicking on an object 
and selecting Properties or by pressing Alt-Enter when working in the Form window.

Setting Properties for Multiple Objects

To set properties for multiple objects, hold down the Shift key as you click on objects 
with the mouse. Properties common to all selected objects are displayed in the 
Properties window, allowing you to modify them with a single action.

Variable Properties Window

The Variable Properties window allows you to define your variables. You can access 
the Variable Properties window from the Builder window or from a question on a form.

Changes made in the Variable Properties window are applied immediately—you 
don’t need to close the window after making changes. You can edit multiple variables 
by selecting them one after another in the Builder window, without closing the 
Variable Properties window between each selection.
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Figure 3-10
Variable Properties window

To Define Properties for a Variable or Set 

E To access Variable Properties from the Builder window, from the menus choose:

View
Variables

E In the variable list, right-click on a variable or multiple response set and select 
Variable/Set Properties.

E To access variable properties from a question on a form, right-click on the question and 
select Variable Properties.

See Chapter 7 for more information on defining variable properties.
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Questions

Questions are the foundation of any survey and the building blocks of data entry 
forms. Each question on a form has two visible components:

Question text.

One or more response controls that allow the user to enter a response. 

A number of control types are available, including text boxes, check boxes, option 
buttons, and drop-down lists. Most response control types display enumerated 
response items (for example, yes or no) from which the user can choose.

Answers to questions are stored in variables. In fact, you can think of a question as 
a representation of one or more variables on a form. The question text and response 
items displayed in questions are also properties of the variable bound to the question.

Figure 4-1
Questions on a form
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Question Numbering

Before you create any questions, you can decide whether you want your questions to 
be automatically numbered. When you set your form’s AutoNumber property to True, 
all questions that you create are numbered. If you delete, cut, or paste questions, your 
question numbers automatically update to reflect the change. 

The question numbers are controlled by the tab order of your form. The tab order 
specifies the sequence in which users can move through questions on the form by 
pressing Tab (or Shift-Tab) in Form Entry or Table Entry view. By default, the tab 
order corresponds to the order in which your questions are created. Tab order may 
become an issue if you change the order of questions on the form. When you opt to 
automatically number your questions, you will have to keep your tab order up to date. 
For more information on tab order, see Chapter 10.

If you have already created questions, the procedure for obtaining question numbers 
is slightly different. For more information on adding question numbers to existing 
forms, numbering static text, or customizing the appearance of question numbers, see 
Chapter 5.

To Turn on Automatic Question Numbering

E Click your form to select it.

E In the Properties window, set AutoNumber to True.

Adding Questions to Forms
You can add questions to a form using the form toolbox or by dragging existing 
variables from the Builder window onto a form.

Figure 4-2
Form toolbox
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If you’re starting a new project, using the form toolbox is probably the easiest 
method. As you add each question to the form, a variable or multiple response set 
is automatically created.

If you prefer, you can first define your variables in the Builder window and then 
drag variables from the Builder window onto a form to generate questions based 
on those variables. You can also use this method to generate a form from an 
existing data file.

To Create Questions and Variables Using the Form Toolbox

E If the form toolbox is not visible, from the Form window menus choose:

View
Toolbox

E In the toolbox, click the desired question tool to select the tool.

E Click on the form to create the question.

Figure 4-3
Clicking on a question tool
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Figure 4-4
Clicking on the form to create the question

As you add each question, a variable or multiple response set is automatically created.

E To define variable properties, right-click on the question and select Variable Properties.

E To change question properties, right-click on the question container and select 
Properties.

Note: You can also change response control properties.
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Tool Wells

Tool wells allow you to create questions with more than one response control—for 
example, a group of option buttons or a multiple response question with several check 
boxes or drop-down lists.

Figure 4-5
Option button tool well

Hold the mouse pointer briefly over a tool and press the left mouse button until the well 
appears. Then, drag and release the mouse in the tool well to indicate the number and 
arrangement of controls. The well expands as you drag, allowing you to specify as 
many rows and columns as you want (to the limits of your screen).

To Create a Question with Multiple Response Controls

E If the form toolbox is not visible, from the Form window menus choose:

View
Toolbox

E Move the mouse over the desired question tool and hold down the left mouse button to 
display the tool well.

E Drag and release the mouse in the tool well to specify the number and arrangement of 
response controls.
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Figure 4-6
Specifying the arrangement of controls

The well expands as you drag, allowing you to specify as many rows and columns as 
you want.

E Click the mouse on the form to create the question.

Figure 4-7
Creating the question
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As you add each question, a variable or multiple response set is automatically created.

E To define variable properties, right-click on the question and select Variable Properties.

To Require a Response for a Question or Set

An occasion might arise when you want to create a question that a respondent must 
answer. You can set a property for the question to ensure that the respondent or data 
entry clerk will not be able to skip that question. For sets, you can require that the 
respondent select a certain number of responses.

To create a question that requires a response:

E Create your question or set.

E Right-click on the question or set container and select Properties.

E For a question, in the Properties window, set the Required property to True.

E For a set, in the Properties window, specify a number for the RequiredAnswerCount 
property.

Tips for Creating Questions with the Form Toolbox

The default properties of new questions depend on the properties of the tool used 
to create the question. To reduce the amount of time you spend customizing 
questions, specify tool properties before you create questions.

To add several questions of the same type, select the tool by double-clicking rather 
than single-clicking or hold down the Shift key as you drag and release the mouse 
in the well. The tool remains selected after you add a question, allowing you to 
repeatedly click on the form to create several questions of the same type.

To specify the type of variable created for the question, click on the form with the 
right (rather than left) mouse button when you create the question.

To specify the exact size and shape of the question, drag the mouse on the form 
rather than clicking.
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Default Tool Properties

You can customize the behavior of each tool by specifying the default properties 
applied to objects created with that tool.

For example, suppose you want all of the questions on your form to have a specific 
background color or border style. Rather than modify each question after you create it, 
set the appropriate property for your question tools before you create questions. This 
can save you a lot of time by reducing the need to modify questions after you create 
them.

Changes to default tool properties are applied to all objects subsequently added to 
the form with the tool. Tool properties are saved with the form, so you can specify 
different defaults for different forms. Newly created forms inherit tool defaults from 
the last open form.

Tip: To set the default font for all questions added to a form, click on the form 
background and set the Font property for the form in the Properties window. The 
specified font is applied to all questions and text subsequently added to the form.

To Set Default Tool Properties

You can use the Properties window to specify default properties for new questions and 
objects created with toolbox tools.
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Figure 4-8
Default properties for the option button questions

E In the toolbox, click on the desired tool.

E To display the Properties window, from the menus choose:

View
Properties

E Specify the desired properties in the right column of the Properties window.

The properties are subsequently applied to all objects created with the tool.
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Auto-Creating a Form

The Auto-create feature allows you to automatically create a form, maximized for 
entry in Table Entry view. To use Auto-create, you must have defined variables, either 
from an .sav file created in Builder or in another program from SPSS. You can use .sav 
files that already have forms. 

Figure 4-9
Auto-create dialog box

When you auto-create a form, the questions are created in the order in which the 
variables were created, which is listed in the Builder window as the file order. Auto-
creating a form creates a form that is maximized for efficient data entry in Table Entry 
view. Autotab is set to True so that after you enter an answer, you move automatically 
to the next question. Value labels appear instead of response items as you enter data. 
For example, if you have a question where the response item is yes, instead of yes you 
see the value label, or 1.

Tip: If a numeric text box question is not defined properly, it will default to 8. So if you 
enter one digit, Autotab won’t work because it is expecting eight digits. When defining 
numeric variables, make sure that the length is set properly so Autotab will work.
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To Auto-Create a Form

E From the Form menu choose:

Layout
   Auto Create Questions...

E Select either Create all questions as text boxes or Create questions based on default types.

Tip: Creating all questions as text boxes makes it easier to enter data in Table Entry view 
for those who prefer the keyboard to the mouse.

E If you want to edit the form, deselect Open in Table Entry Mode.

Note: If you open a file that contains only variables, the Auto-create dialog box opens 
automatically. If you do not want to auto-create a form, click No.

To Create a Question from an Existing Variable or Set

You can drag or paste an existing variable or multiple response set from the Builder 
window onto a form to create a question. This is the only method that allows you to 
create a question bound to an existing variable.

Figure 4-10
Dragging a variable onto a form
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E In the Builder window, from the menus choose:

View
Variables

E Select one or more variables or multiple response sets.

To select multiple variables, hold down the Shift key or Ctrl key as you click on the 
variables.

E Hold down the left mouse button while dragging the selected variables from the 
Builder window onto a form.

E Move the mouse to the desired position on the form and release the mouse button.

E To specify a response control type other than the default, drag and drop variables using 
the right mouse button rather than the left, and select the desired control type from the 
context menu.

Figure 4-11
Question created from an existing variable
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Tips for Creating Questions from Existing Variables

By default, the response control type for the question depends on the type of 
variable and whether or not response items or value labels are defined. 

To specify a control type other than the default, drag the variables onto the form 
with the right mouse button rather than the left. You are then prompted to select a 
control type. If you use this method to drag multiple variables, the program 
attempts to apply your selection to all variables.

The question text and response items specified for the variable are displayed in the 
question. (If question text and response items are not specified, the corresponding 
variable labels and value labels are substituted.)

All other question properties depend on the tool properties (as when creating 
questions using the toolbox). For example, to adjust the vertical space between 
questions or controls, adjust the Vertical Space property for the option button 
question tool before dragging the question onto the form.

Copying and pasting a variable using the Edit menu is the equivalent to dragging 
the variable onto the form.

When creating a question from a multiple response set, select the set itself in the 
Builder window—you don’t need to select the variables within the set unless you 
want each variable to also appear in a separate question.

Specifying the Response Control Type

By default, when you generate a question from an existing variable or multiple 
response set, the type of response control depends on the type of variable or set and 
whether or not response items or value labels are defined. 

To specify a control type other than the default, drag and drop the variable or set 
onto the form using the right mouse button, and select the desired control type from 
the context menu. If you use this method to drag multiple variables, the program 
attempts to apply your selection to all variables. You cannot create long text boxes 
using this method.
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Figure 4-12
Selecting the response control type

Creating Questions from Multiple Response Sets

By default, when you generate a question from an existing multiple response set, the 
type of response control depends on the variables composing the set and whether it is 
a multiple category set or a multiple dichotomy set. 

To specify a control type other than the default, drag and drop the multiple response 
set onto the form using the right mouse button, and select the desired control type from 
the context menu. If you use this method to drag multiple sets, the program attempts to 
apply your selection to all variables in all sets.

Tip: When creating a question from a multiple response set, select the set itself in the 
Builder window—you don’t need to select the variables within the set unless you want 
each variable to also appear in a separate question.

Questions and Variables

When you create questions using the toolbox, you also create variables (and multiple 
response sets, if needed) because you can’t have a question without a variable or set. 
In fact, you can think of a question as a representation of a variable or multiple 



67

Questions

response set on a form. For example, a question asking the respondent to rate overall 
satisfaction might be bound to a variable named SATISF.

Figure 4-13
Question representing a single variable

Questions that allow the user to choose more than one response represent a set of 
variables, referred to as a multiple response set. For example, a question such as 
Which stores do you shop in? might be bound to a set of variables named $shop, with 
a separate variable in the set for each type of shop.

Figure 4-14
Question representing a multiple response set

Understanding the Connection between Questions and Variables

Questions and variables are not the same thing in the program, but they are closely 
related. You can use the program without ever understanding this connection, but the 
program will make more sense if you do.
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A question is a representation of a variable on a form. When you create questions 
using the form toolbox, you also create variables; the question text and response items 
displayed in questions are actually stored in the variable bound to the question.

This makes it easy to keep your questions and forms up to date and also provides 
for multiple ways of doing things. You can edit question text and response choices 
directly on your form or in the Variable Properties window. Either way, the result is 
the same.

You can also have different questions on different forms that are tied to the same 
variable. The questions can look different (for example, one might be formatted as a 
group of option buttons and the other as a drop-down list), but they share the same 
question text and the same set of response choices because these attributes are stored 
in the variable.

To Define Variable or Set Properties

Note: You cannot view or edit the variables for long text boxes.

E To access the Variable Properties window from a question on a form, right-click on the 
question and select Variable Properties.

Figure 4-15
Accessing variable properties from a question

E To access variable properties from the Properties window when a question is selected, 
double-click the Variable property.
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E To access variable properties from the Builder window, from the menus choose:

View
Variables

E Then, right-click on a variable or multiple response set and select Variable/Set 

Properties. 

For more information on defining variable properties, see Chapter 7.

Variable Properties That Affect Questions

Questions share important properties with the variables (or multiple response sets) that 
they represent, including question text, response items, data type, and values. You can 
modify these properties in the Variable Properties window. Any changes to variable 
properties are reflected in all questions bound to that variable.

Figure 4-16
Question text displayed in the Variable Properties window



70

Chapter 4

Question text. Text to be displayed in questions is bound to the variable (for example, 
in Figure 4-16, How would you rate your overall satisfaction with this product? is 
bound to the variable SATISF). You can edit the question text on the form or in the 
Variable Properties window (General tab).

Figure 4-17
Response items specified for a variable

Response items. Enumerated responses that users can choose from are displayed as 
option button captions or items in a drop-down list or list box. You can edit response 
items directly on the question or in the Variable Properties window (Values tab).

Data format, variable values, and valid values. The type of data—and in some cases, the 
specific values—that a question can accept depends on the variable bound to the 
question. For example, if a question is bound to a numeric variable, you can’t enter yes 
(unless yes has been specified as a response item for the variable). Similarly, a 
Validation rule defined for a variable affects all questions bound to the variable.

See Chapter 8 for more information on how multiple response sets are represented 
in questions.
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Automatic Update of Question and Variable Properties

Changes to a variable are automatically reflected in all questions bound to that variable. 
This makes it easy to keep your forms up to date, even when you create several versions 
of a form.

For example, suppose you want to create several versions of a questionnaire, each 
with the same questions but with the sequence of questions changed to make sure the 
order in which questions are presented doesn’t bias the responses. To do this, you 
create one form and then make a copy. The result is two separate forms, each with a 
complete set of questions. You can rearrange questions on one form, and even change 
the appearance of one or more questions, without affecting the other.

However, both forms are still bound to the same underlying variables, so any 
changes made to a variable’s properties are automatically updated in all questions 
bound to that variable. (The same variable can be represented in several questions on 
several forms.)

For example, if you decide to change the wording of one of your questions, you need 
to make the change only once. This is because question text is a property of the 
variable. When you edit the question text for a variable, all questions bound to that 
variable are automatically updated. Similarly, if you change the type of variable or 
create a Validation rule for the variable, the change affects the behavior of every 
question bound to the variable.

Tip: If you have several questions on several forms bound to the same variable, you 
can’t change the question text or response items from one question without changing 
all other questions bound to that variable. However, you can use the clipboard to 
“clone” a question by copying the question and pasting it back to the same form you 
copied it from. The result is a separate question bound to a separate variable.

Why Share Properties?

Question text and response items are shared between questions and variables because 
they define the substance of a question, which you typically want to preserve across all 
forms that share that question. Properties that define the appearance, rather than the 
substance, of a question (for example, the font size or whether the question is formatted 
as a drop-down or list box) are not shared, so you can customize the appearance of each 
question on each form as needed.
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Copying and Pasting Questions

You can copy and paste questions between forms in the same file, between forms in 
different files, or from the Builder window to a form. Simply select the questions that 
you want to copy and then drag or use the Edit menu to paste them into the desired form.

When you copy a question, the variable or multiple response set bound to the 
question may or may not be pasted. The result depends on whether you paste to the 
same form, a different form in the same file, or a different file, and whether a variable 
or set of the same name already exists in the file.

To Copy Questions between Forms

You can copy questions from one form to another or make a copy of a question on the 
same form. The forms can be in the same file or in a different file.

E If you want to copy questions between forms in different files, open both files.

E On one form, select the questions that you want to copy. (To select multiple questions 
on a form, hold down the Shift key as you click with the mouse or drag the mouse to 
draw a rectangle around multiple objects.)

E From the Form window menus choose:

Edit
Copy

E On the form where you want to paste the questions, from the menus choose:

Edit
Paste

Alternatively, you can drag selected questions from one form to another. This method 
allows you to specify the exact position of questions on the target form.

Tip: You can “clone” a question by copying and pasting it back to the same form. The 
result is a separate question bound to a separate variable.
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To Paste Questions from the Builder Window to a Form

You can select questions in the Builder window and copy or drag them onto a form. 
The form can be in the same file as the original questions or a different file. If you want 
to copy a large number of questions, using the Builder window may be easier than 
copying questions directly between forms.

E If you want to copy questions from one file to another, open both files.

E From the Builder window menus choose:

View
Questions

E Select the questions that you want to copy. (You can select multiple questions using 
the Shift key; however, all of the questions you select must be on the same form.) 

E From the Builder window menus choose:

Edit
Copy

E On the form where you want to paste the questions, from the menus choose:

Edit
Paste

Alternatively, you can use the mouse to drag the selected questions from the Builder 
window onto the form.

To Move a Question from One Form to Another

You can move a question from one form to another by cutting and pasting using the 
Edit menu.

E If you want to move a question to a form in a different file, open both files.

E On the original form, select the questions that you want to move. (To select multiple 
questions on a form, hold down the Shift key as you click on questions with the mouse 
or drag the mouse to draw a rectangle around multiple objects.)
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E From the Form window menus choose:

Edit
Cut

E On the form where you want to paste the questions, from the menus choose:

Edit
Paste

When you use this method to move a question to a different file, the variable bound to 
the question is not removed from the original file.

How Questions and Variables Are Copied

When you copy a question, the variable or multiple response set bound to the question 
may or may not be pasted along with the question. The result depends on whether you 
paste to the same file or to a different file and whether a variable or set of the same 
name already exists in the file.

Pasting a question to the same form. If you paste a question into the same form you 
copied it from, a new variable is created for the question. The result is a new question 
with properties similar to the original question but bound to a separate, newly created 
variable. This is a quick way to create several questions (and variables) with similar 
properties.

Pasting a question to a different form in the same file. If you paste a question to a different 
form in the same file, only the question is pasted, since the variable already exists in 
the file. The result is a new question bound to the same variable as the original question 
(since the same variable can be represented on several forms).

Pasting a question to a different file. If you paste a question to a form in a different file, 
both the question and variable are pasted. If a variable with the same name already 
exists in the file, the pasted variable is renamed to avoid a conflict.

Rules associated with questions and variables. Skip & Fill rules are copied along with 
questions, and Validation rules are copied along with variables.
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Copying Questions from Question Libraries

The question libraries are a collection of files containing ready-to-use questions on 
topics such as general demographics, customer satisfaction, and customer preferences. 
The variables attached to the questions are defined, including value labels and response 
items. You can access the question libraries from the Edit menu. 

You can copy questions from the library into your form and use them as they are or 
customize each to your particular needs. By modifying the question text and response 
items, the questions in the libraries may serve as the starting point for almost any type 
of survey. 

For more information on how to use the question libraries, see Chapter 9.

Cutting and Deleting Questions

When you cut or delete a question from a form, the variable or multiple response set 
bound to the question is not cut from the data file. You can delete the variable or 
multiple response set in the Builder window.

Avoiding orphaned variables. Whenever you delete questions from a form, be aware that 
you may be leaving orphaned variables behind. For example, suppose you create a 
question with the toolbox, immediately realize you made a mistake, and then select and 
delete the question. Although the question has been deleted, the variable created with 
the question remains. Over time, your data file may become cluttered with unneeded 
variables.

To avoid this situation, use Undo (on the Edit menu), rather than Delete, to remove 
questions immediately after creating them. If you use Undo, the variable or multiple 
response set created along with the question is also removed.

To Remove a Question Using Undo

You can use Undo Create New Object(s) on the Edit menu, rather than Delete, to 
remove questions after creating them (for example, if you create a question and 
immediately realize you don’t want the question). When you use Undo, the variable 
created for the question is also removed. This method will avoid cluttering your file 
with orphaned variables.
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E After creating the question, from the Form window menus choose:

Edit
Undo Create New Object(s)

Figure 4-18
Using Undo Create New Object(s) to remove a newly created question

Multiple Undo. You can undo multiple actions by repeatedly selecting Undo Create New 
Object(s) on the Edit menu, essentially backing through your actions one step at a time. 
For example, if you create three questions one after another, you could select Undo 
three times to remove all three questions.

To Delete Questions and Variables in the Builder Window

E From the Builder window menus choose:

View
Questions

E Select one or more questions and press the Delete key. (To select multiple questions, 
hold down the Shift key or Ctrl key as you click with the mouse.)
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To delete the variable or multiple response set bound to the question:

E From the Builder window menus choose:

View
Variables

E Select the variables or multiple response sets and press the Delete key.

When you delete a variable or multiple response set, any questions still bound to the 
variable or set are also deleted. This is because a question cannot exist without the 
underlying variable or set.

Question Examples

This section provides examples of the different types of questions that you can create 
during a session, along with specific instructions for creating each type of question. 
The sample questions can also be found in the file Manual examples.sav, which is 
installed in the same directory as your software. You can copy and paste the sample 
questions onto your own forms and customize them as needed. 

Response Control Types 

Every question has one or more controls that allow the user to enter a response. A 
number of response control types are available, including:

Text boxes

Long text boxes

Option buttons

Check boxes

List boxes

Drop-down lists

Other response

A question can have one response control or many. In most cases, if a question has 
more than one response control, it represents a multiple response set rather than a 
single variable.
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Response controls may appear different in print than online; not all control types 
are appropriate for a printed form. See the descriptions of individual control types 
for details.

Text Boxes

Text box controls allow users to type a custom response. The length and format of the 
response depends on the variable bound to the question.

A text box control is not the same as a text annotation, which is text on a form that 
is not bound to any variable. You add text annotations to forms using the text tool.

Figure 4-19
Text box question

The value entered must either match the format of the variable bound to the question 
(specified in the Variable Properties window) or match a response item defined for the 
variable. For example, if the variable type is numeric, the user can enter any numeric 
value but cannot enter yes unless yes is specified as a response item for a specific value 
(for example, 1 = yes).

The display format for the typed value depends on the variable. Available formats 
include numeric, string, date, currency (dollar or custom), and scientific notation. If the 
variable type is string, any string is accepted (letters or numbers) unless it exceeds the 
maximum length (up to 255 characters). If you need to accommodate more characters, 
create a long text box control instead.

Tip: To format text boxes so they print as underlines on a printed form, change the 
Border Style property for the text box to Underline in the Properties window.

To Create a Text Box Question

E If the toolbox is not visible, from the Form window menus choose:

View
Toolbox
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E Click the text box question tool to select the tool. (Hold the mouse pointer over each 
tool for a description.)

E Click on the form to create the question.

Optionally, you can specify the size and position of the question by dragging the mouse 
on the form rather than using a simple click.

To edit the question text directly on the form, double-click on the text.

To modify variable properties, right-click on the question and select Variable 
Properties.

Tip: A text box is not the same as a text label, which is text that is not bound to any 
variable. You add text labels to forms using the text tool.

Long Text Boxes

Long text box controls allow users to enter open-ended responses. These differ from 
regular text box controls because the user can enter more than 255 string characters.

Figure 4-20
Long text box question

The value entered must be a string. Any string is accepted (letters or numbers) unless 
it exceeds the maximum length (up to 4,000 characters).

Long text boxes do not have a one-to-one correspondence with a variable, as other 
controls do. Data Entry Builder actually creates multiple variables to accommodate the 
responses for long text boxes. One variable acts as an index for the rest of the variables, 
which contain the response text. Each of these content variables holds 255 characters. 
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The name of the index variable has the format @nn, where nn is a sequential number 
(for example, @01). Each name of a content variable has the format @nniiii, where iiii 
is a number indicating the variable’s index (for example, @010001, @010002, and so 
on). Do not modify any of these variables.

To Create a Long Text Box Question

E If the toolbox is not visible, from the Form window menus choose:

View
Toolbox

E Click the long text box question tool to select the tool. (Hold the mouse pointer over 
each tool for a description.)

E Click on the form to create the question.

Optionally, you can specify the size and position of the question by dragging the mouse 
on the form rather than using a simple click.

To edit the question text directly on the form, double-click on the text.

Note: You cannot edit the variables for long text boxes. Do not try to modify the name 
or the properties for the variables, which always begin with the at sign (@).

Option Buttons

Option buttons offer users a choice between mutually exclusive options. In a group of 
option buttons, only one button can be selected. Because users can select only one 
response, option button groups always represent a single variable rather than a multiple 
response set.
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Figure 4-21
Option button question

Each option button represents one of the response items for the variable bound to the 
question (Variable Properties window, Values tab). You cannot remove an option 
button from a question without removing the corresponding response item from the 
variable. However, you can set the Visible property to False for an option button to 
suppress display of the button. For example, if the variable has the response item did 
not answer, you’ll probably want to suppress that item from a printed questionnaire.

Default selection versus no selection. When entering data, none of the buttons in an 
option button group is selected by default. However, once the user selects a button, the 
selection can be changed but not removed using standard keyboard controls. To restore 
the question to its initial state, select Delete Value from the Edit menu.

If you want one of the buttons in the group to be selected by default, set the default 
value for the variable bound to the question to match the value for the corresponding 
response item. (The default value and response items are specified in the General tab 
and Values tab, respectively, of the Variable Properties window.)

Tip: To create an asymmetric arrangement with five buttons in two columns, create a 
question with six buttons and delete one of the buttons.

To Create an Option Button Question

E If the toolbox is not visible, from the Form window menus choose:

View
Toolbox
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E Move the mouse pointer over the option button question tool and hold down the left 
mouse button to display the tool well.

E Drag and release the mouse in the tool well to indicate the number and arrangement of 
option buttons. The well expands as you drag, allowing you to specify as many rows 
and columns as needed.

E Click on the form to create the question.

To edit the question text or button captions directly on the form, double-click on 
the text.

To modify variable properties, right-click on the question and select Variable 
Properties.

To suppress the display of one of the buttons in the group, set the Visible property 
to False for the control in the Properties window.

Check Boxes (All That Apply)

Check boxes are controls that can be turned on or off and are useful for representing 
dichotomous (yes or no) questions. For example, a common use of check boxes is to 
represent the variables in a multiple dichotomy set—each check box represents a 
variable within the set and can be individually selected or deselected.

Figure 4-22
Check box question

Changing the default value. When entering data, check boxes are neither selected nor 
deselected by default (this indeterminate state is visually indicated in Entry view by a 
gray mark inside the check box). To change this, set the default value for the variable 
bound to the check box to the “unchecked” or “checked” value. (The default, checked, 
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and unchecked values are specified in the General tab and Values tab, respectively, of 
the Variable Properties window.) 

To Create a Check Box Question

E If the toolbox is not visible, from the Form window menus choose:

View
Toolbox

E Move the mouse pointer over the check box question tool and hold down the left mouse 
button to display the tool well.

E Drag and release the mouse in the tool well to indicate the number and arrangement of 
check boxes.

E Click on the form to create the question.

To edit the question text or caption directly on the form, double-click on the text.

To modify variable properties, right-click on the question and select Variable 
Properties.

To change the values stored in the variable when the check box is selected or 
deselected, modify the checked and unchecked values (Variable Properties, Values 
tab). You can also edit the default value for the variable to change the default state 
for the check box.

Drop-Down Lists

Drop-down lists allow the user to choose from a list of responses. The list is displayed 
only when the user clicks on the control, saving space on the form. The user must 
choose one of the options from the list—a custom value cannot be entered.

Because the drop-down list is displayed only when the control is selected, this type 
of control is not appropriate for a printed form. Use option buttons instead.
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Figure 4-23
Drop-down list

Items on the list correspond to response items for the variable bound to the question 
(Variable Properties, Values tab). You can specify the sequence of response items and 
suppress the display of individual response items in the List Items dialog box.

To Create a Drop-Down List

E If the toolbox is not visible, from the Form window menus choose:

View
Toolbox

E Click the drop-down list question tool to select the tool. (Hold the mouse pointer over 
each tool for a description.)

E Click on the form to create the question.

Optionally, you can specify the size and position of the question by dragging the mouse 
on the form rather than using a simple click.

To edit the question text directly on the form, double-click on the text.

To specify the items that appear in the drop-down list, select the drop-down control 
and double-click the List Items field in the Properties window.

To modify variable properties, right-click on the question and select Variable 
Properties.
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Single-Selection List Boxes

Single-selection list boxes display a list of responses from which the user can choose 
only one. List boxes occupy more space on forms than drop-down lists but may allow 
for faster entry of data because the user doesn’t need to select the control in order to 
view or select items from the list. If the list of items is too long to be completely visible, 
scroll bars are displayed.

Figure 4-24
List box

Items on the list correspond to response items for the variable bound to the question 
(Variable Properties, Values tab). You can specify the sequence of response items and 
suppress the display of individual response items in the List Items dialog box.

To Create a Single-Selection List Box Question

E If the toolbox is not visible, from the Form window menus choose:

View
Toolbox

E Click the single-selection list-box question tool to select the tool. (Hold the mouse 
pointer over each tool for a description.)

E Click on the form to create the question.

Optionally, you can specify the size and position of the question by dragging the mouse 
on the form rather than using a simple click.
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To edit the question text directly on the form, double-click on the text.

To modify properties for a question or control, right-click on the control and select 
Properties.

To specify the list items, select the list box control and double-click the List Items 
field in the Properties window.

To modify variable properties, right-click on the question and select Variable 
Properties.

To Specify the Responses in a List Box or Drop-Down List

List Items allows you to specify the items displayed in a drop-down list or list box.

Figure 4-25
List Items dialog box

E Create a drop-down or list box question.

E On the form, right-click on the drop-down or list box control and select Properties.

E In the Properties window, double-click in the List Items field.

E In the List Items dialog box, use the buttons and arrows to add, delete, and move 
individual items.
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E To hide a list item without removing it, deselect the Visible check box. 

Ordinal Scale with Endpoint Labels

You can use the option button question tool to create a button scale with endpoint 
labels.

Figure 4-26
Button scale with endpoint labels

The question represents a single variable. Each point on the scale represents a 
specified value for the variable.

The endpoint labels Highly unsatisfied and Highly satisfied are separate labels 
(added with the text tool).

Hide the caption for each button by resizing each button control so the caption is 
not visible.

Alternatively, you can use a scale button matrix for this type of question.

To Create an Ordinal Scale Question with Endpoint Labels

E Create an option button question with a single row of buttons.

E Double-click on the question text to edit the text. You can also edit the response items 
if desired.

E Select all button controls and use the Properties window to set the AutoSizeToFit 
property to False.

E Select each button control and resize the control so the caption is no longer visible.
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E Use the text tool to add the endpoint labels.

Figure 4-27
Resizing an option button control

Alternatively, you can use a scale button matrix for this type of question.

Scale Button Matrix

A scale button matrix is a set of questions that shares a common set of response items. 
The matrix provides a mechanism for aligning questions on the form and displaying 
shared response text in column labels. In addition, you can modify a scale button 
matrix to display a numeric scale rather than buttons in each row.

Figure 4-28
Scale button matrix

Figure 4-29
Matrix with numeric scale displayed

See Chapter 6 for instructions on creating a scale button matrix.
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Multiple Responses Coded As Dichotomies

When you want to receive a yes or no answer to a specific set of subquestions, you can 
use a multiple response set coded as dichotomies. A set coded as dichotomies is 
composed of the set and as many variables as needed to ask the subquestions.

Multiple dichotomy sets can be represented as check boxes, list boxes, text boxes, 
or drop-down lists.

Figure 4-30
Question with multiple responses coded as dichotomies

See Chapter 8 for instructions on creating multiple response questions.

Multiple Responses Coded As Categories

When you want to receive open-ended responses or responses selected from predefined 
categories, you can use a multiple response set coded as categories. A set coded as 
categories asks a question and provides a number of text boxes to collect the responses. 
Each text box represents a variable that is part of the set. You can also use single-
selection list boxes or drop-down list boxes to display predefined categories.

Figure 4-31
Question with multiple responses coded as categories

See Chapter 8 for instructions on creating multiple response questions.
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Questions with an “Other” Response

Sometimes you will want to ask a question for which you cannot list all of the possible 
responses. You can use the other response to give respondents the option of using a 
response not listed in the question. 

When you create a question with an other response, an additional variable bound to 
the question is created. The additional variable does not appear in the Variable list in 
Builder, although it does appear in Table Entry view and will appear when you open 
the file for analysis in software from SPSS Inc. The additional variable has an alias that 
you can use in rules. The alias is the name of the original question’s variable plus the 
letter o. For example, if you have a question tied to the variable shop and you add an 
other response to that question, the alias for the other response’s variable is shopo.

Figure 4-32
File in Table Entry view

Using the other response for option button and list box questions simplifies data 
analysis. You will have to run a frequency only on the additional variable, since the 
responses to the questions are stored in that variable.

You can create an other response in three ways:

Use the Other tool in the toolbox.

Right-click on an eligible question container and select Other Response.

Select an eligible question container and from the Edit menu, choose Other 
Response.
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You can add an other response to option button questions, check box sets, single-
selection list box questions, and drop-down list box questions. You cannot add an other 
response to a matrix, a text box question, or a text box set.

A question can have only one other response. You cannot copy and paste an other 
response from one question to another question. 

Figure 4-33
Option button question with an “other” response

Figure 4-34
Check box multiple response set with an “other” response

Figure 4-35
Single-selection list box with an “other” response
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Figure 4-36
Drop-down list box with an “other” response

To Create a Question with an “Other” Response

E Select an eligible question container (either an option button question, a check box set, 
a single-selection list box question, or a drop-down list box question).

E From the Form menu choose:

Edit
Other Response

Alternatively, you can use the Other tool from the toolbox or right-click on the question 
container and select Other Response from the context menu.
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5
Customizing Questions
and Controls

You can modify the size, position, appearance, and behavior of questions and other 
form objects using several methods:

Use the mouse to select, position, and resize questions and controls.

Use the Properties window to modify properties of questions and controls.

Use the Layout menu and to arrange, align, and group questions and controls. 

Use the toolbox to add question numbers to created questions.

Use the Properties window to change the properties of question numbers.

To Select Questions and Controls on Forms
Figure 5-1
Selecting a question with the mouse
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To select a question, click on the question border.

To select a control within a question, click directly on the control.

To select multiple objects, hold down the Shift key as you click on the objects.

To select all of the objects in a rectangular area, hold down the left mouse button 
and drag the mouse to draw a rectangle around the objects.

To edit text directly on the form, double-click on the text.

To select a form, click on the form background.

Primary selection. If you select multiple objects, the object that you select first is the 
primary selection. If you use the Layout menu or formatting toolbar to align objects, 
the objects are aligned relative to the primary selection.

If you select multiple objects by dragging a rectangle, the top-left object is the 
primary selection.

Figure 5-2
Drag the mouse to select all of the objects in a rectangular area
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To Modify Properties for a Form, Question, or Control
Figure 5-3
Properties window

E To display the Properties window, press Alt-Enter, or from the Form window menus 
choose:

View
Properties

E Select the form objects for which you want to specify properties.

E Specify the desired value for each property in the right column.

For some properties, you can choose from a list of choices. For others, you can double-
click to open a dialog box.

As a shortcut, you can also access properties by right-clicking on a form object and 
selecting Properties.

To set properties for multiple objects, hold down the Shift key as you select the 
objects on the form. Properties common to all selected objects are displayed, 
allowing you to modify them with a single gesture.
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Changes to properties are updated immediately on the form. You don’t need to 
close and reopen the Properties window for changes to be applied.

To Edit Text on a Form
Figure 5-4
Editing form text

E To edit text directly on the form, double-click on the text.

Press Enter to commit changes.

Press Esc to cancel changes and restore the original text.

Press Ctrl-Enter to insert a carriage return (so that text will wrap to the next line).

Before editing text, you may want to enlarge the text control by dragging the 
selection handles so that more text will be visible as you type.

To edit text in the Properties window, click on the Text or Caption property (as 
appropriate) and type the desired text.

Positioning and Aligning Questions and Controls

You can align and resize questions and controls using the mouse, the Properties 
window, the Layout menu, or the formatting toolbar.
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To Move a Question or Control
Figure 5-5
Moving a question

E Select the questions or controls that you want to move.

To select multiple objects, hold down the Shift key as you click on the objects.

E Hold down the left mouse button to drag the selected objects.

When you move or resize controls within a question, the question frame expands 
as needed.

When you move a question, controls within the question also move.

To specify the exact position of a question or control, modify the Top and Left 
properties in the Properties window.
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To Resize a Question or Control
Figure 5-6
Resizing a question

E Click on the question or control that you want to resize.

Selection handles appear around the selected object.

E Drag the selection handles on the sides and corners to resize the object.

E To resize all of the controls in a question with a single action, select the question along 
with all of its controls, and then drag the outer question border.

To specify the exact dimensions of an object, modify the Height and Width properties 
in the Properties window.

Tip: Text controls will automatically resize to fit their contents if the AutoSizeToFit 
property is set to True for the object. To quickly size a newly created object, double-
click on it, edit the text if necessary, and then click away from the object to deselect it. 
By default, AutoSizeToFit is always on unless you turn it off.
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To Align Questions and Controls Using the Properties Window

You can position form objects according to precise coordinates by modifying their Top, 
Left, Height, and Width properties. This can be particularly useful when you want to 
align multiple objects.

E To display the Properties window, from the Form window menus choose:

View
Properties

E Select the objects that you want to align.

If you select multiple objects, properties common to the selected objects are displayed.

E Edit the Top, Left, Height, and Width properties as needed.

To align selected objects vertically, specify a common value for the Left property.

To align objects horizontally, specify a common value for the Top property.

To make objects the same size, specify common values for Height and Width.

To Align Questions and Controls Using the Layout Menu

The Layout menu and formatting toolbar offer a number of features to quickly align or 
arrange objects on a form. The primary selection object acts as an anchor, and all other 
selected objects are aligned to it based on the chosen position.



100

Chapter 5

Figure 5-7
Aligning objects with the Layout menu

E In the Form window, select the objects that you want to align.

E From the Form window menus choose:

Layout
Align

You can align objects relative to their sides, middles, tops, bottoms, or centers.

Tip: If the results are not as you expected, choose Undo Align from the Edit menu to 
reverse the action. For example, depending on the position of the primary selection, 
objects may be partially or entirely stacked on top of one another.
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To Align Questions and Controls to the Grid

E To turn on Snap to Grid, from the Form window menus choose:

Layout
Snap to Grid

All objects subsequently added to the form are aligned to the nearest grid point. 
However, Snap to Grid does not affect existing form objects.

E To align existing form objects to the nearest grid point, select the objects and from the 
menus choose:

Layout
Align

Align to Grid

Figure 5-8
Aligning questions and controls to the grid

Tip: Even when Snap to Grid is on, entering values for an object’s Top and Left 
properties allows you to place an object exactly where you want it.
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To Layer Questions and Controls on a Form

When questions and controls overlap on a form, you can use the Layout menu to 
control which object is on top of which.

E Select the objects you want to layer.

E From the Form window menus choose:

Layout
Layer

Bring to Front (or Send to Back)

Figure 5-9
Sending an object to the back

Tip: Text and pictures can be either “inside” of questions or on top of them, depending 
on how they are created. If you click the text or picture tool within an existing question, 
the text or picture becomes part of the question. If you want text to be on top of the 
question, create the text outside of the question and then drag the text to overlap the 
question. (If the text disappears behind the question, immediately use Bring to Front to 
bring it to the top.)
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Grouping Questions
Figure 5-10
Grouped questions

Grouping questions allows you to move, number, and display questions as a block. For 
example, you may place all of your demographic questions into a group. Grouping 
questions allows you to easily move the group to another section of the form. 
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Figure 5-11
Properties of a group

The group container has the same properties as a question container, such as 
background and border color. You can set the group container properties and you can 
also select and set the properties of individual questions within the group. 

When you group questions, they show up in the tab order of your form as a group. 
You can number them individually or as part of the group. 

For more information about tab order, see Chapter 10. 

To Create a Group

E Select the question containers of the questions that you want in the group.

E From the Form window menus choose:

Layout
Group
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Note: You can group multiple response sets only by selecting the multiple response sets 
and using the Group menu item.

Alternatively, you can group questions by dragging and dropping a question into 
another question’s container.

Or you can use the toolbox to create a question inside of another question’s 
container.

If you use the toolbox with questions of the same type, you must right-click inside 
of the question container and from the context menu choose Create New Question. If 
you simply click your mouse, you will not automatically get a new question. Instead, 
you will get additional response items added to your existing question.

You can create a group of questions within a group. For example, you might have a 
group of questions containing personal information, and then within that group, you 
might have a group of several questions that represent an address.

To Ungroup Questions

E Select the group container.

E From the Form window menus choose:

Layout
Ungroup

If you want to remove only certain questions from a group, you must ungroup the entire 
group and then regroup the questions that you want in the group.

Adding Responses to Existing Questions

You can add response choices to an option button or multiple response question by 
using the form toolbox to add response controls or by copying and pasting response 
controls between questions using the clipboard. You can add response choices to a list 
box or drop-down list question by adding items in the List Items dialog box.
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Figure 5-12
Response control added to a question

When you add an additional option button to a question, a corresponding response 
item is added to the variable bound to the question.

When you add an additional subquestion (with response control) to a multiple 
response question, a corresponding variable is added to the multiple response set 
bound to the question.

You can also add subquestions to a multiple response question by dragging one or more 
variables from the Builder window onto the question.

To Add Response Controls to Questions Using the Toolbox

You can add additional response controls to option button and multiple response 
questions using the toolbox. New controls must match the type of existing controls. For 
example, you can’t add check boxes to an option button question.

E If the toolbox is not visible, from the Form window menus choose:

View
Toolbox

E Click the question tool for the desired type of response control (option button, check 
box, and so forth).
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Optionally, you can drag and release the mouse in the tool well to specify the number 
of controls that you want to add.

E Move the mouse pointer over an existing option button or multiple response question 
of the same type as the selected tool.

The question is highlighted to indicate that it is receptive to the tool.

E Click inside of the question to add the control.

Figure 5-13
Adding a response control to an existing question

Tip: To avoid adding new controls on top of existing controls, click near the bottom or 
side of the question (on or near the border). The question border expands to make room 
for the new controls.

To Copy and Paste Response Controls

You can copy and paste response controls between option button and multiple response 
questions. The question type must match the control being pasted. For example, you 
can’t paste a check box control into an option button question.

E Select the controls that you want to copy.



108

Chapter 5

E From the Form window menus choose:

Edit
Copy

E Select the question to which you want to paste controls, and from the menu choose:

Edit
Paste

The question that you paste to can be on the same form or a different form. You can 
even copy and paste to the same question to quickly add an additional response control.

Pasting text. You can copy static text (created with the text tool) and paste it into any 
question. The text becomes part of the question. 

Pasting entire questions. You can also copy and paste entire questions as a shortcut for 
creating new questions. For more information, see Chapter 4.

To Add Variables to Multiple Response Questions

E From the Builder window menus choose:

View
Variables

E Select one or more variables. (To select multiple variables, hold down the Shift key or 
the Ctrl key as you click on the variables.)

E Hold down the left mouse button to drag selected variables from the Builder window 
over the question.

The question is highlighted to indicate that it is receptive to the variables.

E Release the mouse button to add the variables. 

For each variable, a new subquestion (with a response control) is added to the question.

Tip: To avoid creating new controls on top of existing controls, drop the variable near 
the bottom or side of the question (on or near the border). The question border expands 
to make room for the new controls.
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To Add or Remove Responses in a List Box or Drop-Down List

E On the form, right-click on the list box or drop-down list that you want to modify and 
select Properties.

E In the Properties window, double-click in the List Items field.

Figure 5-14
List Items dialog box

E In the List Items dialog box, use the buttons and arrows to add, delete, and move 
individual items.

E To hide a list item without removing it, deselect the Visible check box.

Adding Responses by Modifying Variable or Set Properties

You can add response choices to single response questions by adding response items 
to the variable bound to the question. Similarly, you can add response choices 
(subquestions) to multiple response questions by adding variables to the multiple 
response set bound to the question. In either case, all questions bound to the variable 
or set are automatically updated.

For example, if you have a multiple dichotomy set represented as check boxes, 
adding a variable to the set creates a new check box in the question.
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Understanding the Connection between Questions and Variables 

Remember that questions and variables are not the same thing in the program, but they 
are closely related. You can use the program without ever understanding this 
connection, but the many different methods for adding and removing responses from 
questions and variables will make more sense to you if you do.

A question is a representation of a variable on a form, and the question text and 
response items displayed in questions are actually stored in the variable bound to the 
question.

This makes it easy to keep your questions and forms up to date and provides 
multiple ways of doing things. You can edit question text and response choices directly 
on your form or in the Variable Properties window. Either way, the result is the same. 
Similarly, if you want to remove one of the buttons in an option button question, you 
can select and delete the button right on the form, or you can delete the corresponding 
response item in the Variable Properties window. The result is the same, so use 
whichever method is convenient for you.

To Add Response Choices by Modifying Variable Properties

You can add option buttons to an option button question or add new items to a list box 
or drop-down list question by adding response items to the variable bound to the 
question.

E On the form, right-click on the question and select Variable Properties.

E In the Variable Properties window, click the Values tab.

E Enter new items in the Response Item column.



111

Customizing Questions and Controls

Figure 5-15
Response items displayed in the Variable Properties window

For each new response item, a corresponding option button or list item is added to the 
question. All questions bound to the variable are automatically updated. For more 
information about modifying variable properties, see Chapter 7.

To Add Subquestions by Modifying Set Properties

You can add response controls to an existing multiple response question by adding 
variables to the set bound to the question.

E Right-click on the multiple response question and select Variable Properties.

E In Set Properties window, click the Members tab.

E Click Insert New Variable to add a new variable, or click the check box of an existing 
variable that you want to add to the set.
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Figure 5-16
Set members displayed in the Set Properties window

For each variable added to the set, a corresponding response control is added to the 
question. All questions bound to the set are automatically updated.

For more information about modifying set properties, see Chapter 8.

To Remove Response Controls from a Question

E Click on the response control that you want to remove.

E Press Delete (or choose Cut from the Edit menu).

If you delete an option button, the corresponding response item is deleted from the 
variable bound to the question.

If you delete a subquestion (along with response control) from a multiple response 
question, the corresponding variable is removed from the set. However, the 
variable is not deleted from the file (the variable still exists but is no longer 
included in the set).
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Alternatively, if you delete response items from a variable or delete variables from 
a set, the corresponding response controls or subquestions are deleted from 
questions bound to the variable or set.

Tip: To hide a response control without removing it from the variable or multiple 
response set, use the Properties window to set the Visible property to False for the 
control.

To Change the Response Control Type for a Question

You cannot change the response control type for an existing question—for example, 
you cannot change a drop-down list into a group of option buttons. However, you can 
create a new question based on the same variable or multiple response set as the 
original question but with a different control type.

Figure 5-17
Dragging a variable onto a form
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E From the Builder window menus choose:

View
Variables

E Select the variable or multiple response set bound to the original question.

E Hold down the right mouse button to drag the selected variable or set from the Builder 
window onto a form.

E Move the mouse to the desired position on the form and release the mouse button.

E Select the desired response control type from the context menu.

The new question shares the same variable or set as the original question.

E Delete the original question if desired.

Customizing the Appearance of Questions and Controls

You use the Properties window to modify the appearance of questions and controls. 
You can:

Change the font, size, and color of the text.

Apply custom styles, such as flat, raised, or sunken.

Change the border style, color, and width.

Change the position and alignment of text within controls.

To Change the Font for Form Text

You can specify the font, size, and style for form text in the Fonts dialog box.

E In the Form window, click on the text you want to modify.

E From the menus choose:

View
Properties
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E In the Properties window, double-click the Font field.

Figure 5-18
Fonts dialog box

E In the Fonts dialog box, select the desired font, size, and style.

E To change the text color, use the Font Color property.

Notice that the Fonts property is available only when you select objects that contain 
text.

To Set the Default Font for a Form

You can specify the default font for text on a form using the Properties window. The 
font applies to text subsequently added to the form; it does not apply to existing objects. 
Setting the font before you begin can save a lot of time.

E In the Form window, click on the form background to select the form.

E From the menus choose:

View
Properties
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E In the Properties window, double-click the Font field.

E In the Fonts dialog box, select the desired font, size, and style.

To Apply a Custom Style to a Question

You can apply a flat, raised, or sunken style to a question using the Special Effect 
property.

E Select the questions or controls that you want to modify.

E From the menus choose:

View
Properties

E In the Properties window, edit the Special Effect property.

Note: For option buttons, the Special Effect property choices are flat, sunken, and 
square.  

To Change the Color or Border Style for Questions or Controls

You can specify the color and appearance of questions and controls using the Back 
Color and Back Style properties.

E Select the objects you want to modify.

E From the menus choose:

View
Properties

E In the Properties window, modify the Back Color and Back Style properties.

The background color setting is ignored when Back Style is transparent.

The Border Color and Border Style properties specify the appearance of the 
question border.

The Font Color property specifies the color of text.
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To make text boxes print as underlines on a printed form, set the Border Style to 
Underline for the text box.

To Specify the Caption Position for a Check Box or an Option Button

You can specify whether the caption for a check box or an option button control is 
positioned to the left or right of the button using the Caption Position property.

Figure 5-19
Left-aligned captions

E Select the check boxes or option buttons that you want to modify.

E From the menus choose:

View
Properties

E In the Properties window, edit the Caption Position property.

Tip: Changing the caption position may not produce expected results when the 
AutoSizetoFit property is on for a control. For best results, turn this property off in the 
Properties window.

To Specify the Alignment of Text within a Control

You can specify the horizontal alignment (justification) of text within a control by 
using the Horizontal Alignment property. For option button and check box controls, 
you can also specify the vertical alignment of the caption relative to the control.
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Figure 5-20
Left-, center-, and right-aligned text

E Select the object that you want to modify.

E From the menus choose:

View
Properties

E In the Properties window, edit the Horizontal Alignment or Vertical Alignment 
property.

Tip: Changing the alignment of text may not produce expected results when the 
AutoSizeToFit property is on for a control. For best results, turn this property off in the 
Properties window.

To Disable a Question or Control

You can disable questions and controls by setting the Enabled property to False. When 
a control is disabled, it cannot receive the focus in Entry mode. This is useful if you 
want a question to be visible on the form but don’t want the data in the question to be 
modified.

E Select the controls that you want to disable (or enable).

E From the menus choose:

View
Properties

E In the Properties window, set the Enabled property to False (or True).
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To Hide a Question or Control

You can hide a question or control by setting its Visible property to False. The control 
is no longer visible in Form Entry view. This is especially useful if you want to 
suppress the display of a response control in a question without removing the 
corresponding response item or variable.

E Select the controls that you want to hide (or unhide).

E From the menus choose:

View
Properties

E In the Properties window, set the Visible property to False (or True).

Setting Visible to False hides the object only in Form Entry view; the object is still 
visible in Design view.

To Specify Status Bar Text for a Question

When a question has the focus, you can specify the text to be displayed in the status 
bar using the Status Bar Text property. The specified text is displayed whenever the 
user clicks on the question in Entry mode. For multiple response questions, you can 
specify different status bar text for each subquestion.

E Select the question.

E From the menus choose:

View
Properties

E In the Properties window, specify the desired text for the Status Bar Text property.
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Setting Default Tool Properties before You Create Questions

Tool properties allow you to specify the default properties of questions before you 
create them. For example, suppose you want to use a specific font in all of your 
questions. Rather than modify each question after you create it, set the Font property 
for your question tools before you create questions. This saves time because you avoid 
modifying questions after creating them.

Figure 5-21
Properties for the option button question tool

E In the toolbox, click on the desired tool.

E To display the Properties window, from the menus choose:

View
Properties

E Specify the properties for the tool in the right column of the Properties window.
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The properties are applied to all objects subsequently added to the form with the tool. 
Tool properties are saved with the form, so you can specify different defaults for 
different forms. Newly created forms inherit tool defaults from the last open form.

Question Numbering 

Builder includes a feature that allows you to number your questions, subquestions, 
matrices, and text annotations. Question numbers appear in a separate control. You can 
set properties for that control, but you cannot edit the text of the control. 

If you are creating a new form, it is easy to use automatic question numbering. You 
simply set the form’s AutoNumber property to True. Every question you create is 
numbered and the numbers change to reflect actions, such as deleting a question. 

Figure 5-22
Applying question numbers to multiple questions

When you have an existing form of unnumbered questions, you can select individual 
questions and use the Question Number tool from the toolbox to add question numbers. 
Or you can select many questions at once and use the Layout menu’s Numbering 
submenu to add question numbers. You can select questions in any order since the 
order of question numbers is controlled by the tab order of the form.
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Question numbering in Builder is dynamic, which means that the numbers 
automatically renumber when any of the following happens:

There is a change in the tab order of a numbered question, subquestion, or static 
text.

You add a new question number using the toolbox or the menu.

You delete a question number.

You create a new question on a form whose AutoNumber property is set to True.

You delete, cut, or paste a question, subquestion, or static text containing a number.

Note: If you change the order of questions on your form, you must change the tab order 
of the questions in order to have the questions automatically renumber to reflect your 
changes.

For more information about tab order, see Chapter 10.

To Number Existing Questions

To add numbers to several questions at once:

E Select the questions that you want to number.

E From the Form menu choose:

Layout
Numbering

Add Question Number

Alternatively, you can use the Question Number tool in the toolbox or you can set the 
questions’ Number property to True.

Modifying the Appearance of Numbers

There are several ways to modify the appearance of question numbers. 
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By changing the form’s properties, you can:

Change the delimiter, which is the symbol that appears after the number. 
Delimiters include the period, comma, semicolon, colon, dash, or slash.

Change the number of levels shown.

Change the style of numbering.

Change the starting number for the form. This is helpful in multi-form surveys. For 
example, if the first question on Form3 is the hundredth question in the survey, you 
would set Form3’s NumberStartAt property to 100.

By changing a question’s properties, you can:

Add or delete the question number by changing the Number property.

Change the location of the question number.

Mark a question as a new start for numbering. For example, you have a form with 
three sections. In each section, you want to restart the question numbering at 1. You 
would select the first question in each section and set the NumberRestart property 
for each to True.

Figure 5-23
Question control properties
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Numbers have many of the same properties as other controls—background colors, 
border styles, font, height, special effect, and alignment. You can change the properties 
of an individual number or multiple numbers at once or change the defaults for the 
number tool. 

Text Annotations and Question Numbering

You can add question numbers to text annotations. For example, you may have a form 
divided into sections, which are titled with text annotations. You can number the text 
annotations using the Question Number tool in the toolbox. 

Figure 5-24
Adding question numbers to text annotations

When you add a question number to a text annotation, you create a group consisting of 
a question number control and the text annotation. You may delete the question number 
by ungrouping the group or by deleting the question number.
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Your numbered text annotation appears in the tab order as a group. If you want to 
move your numbered text annotation, you must change its position in the tab order to 
update the question number.

For more information about tab order, see Chapter 10.

Example: Numbering Option Buttons 

You can give question numbers to questions, subquestions, matrices, and text 
annotations. However, you cannot automatically number option button responses 
because they are not subquestions. There is a way to number option button responses 
using text annotations.

E Set your form’s AutoNumber property to True.

E Create a text annotation in front of each option button response.

E When you create the text annotation, it is much bigger than the option button response 
and overlaps it. Use your mouse to size the text annotation to a reasonable size.

Figure 5-25
Option button responses with text annotations
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E Using the Question Number tool, add a question number to each of the text 
annotations.

E Select each text annotation and in the Property window, delete the word Text in the 
Text property field.

Figure 5-26
Numbered option button responses
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Number Aliases 
Figure 5-27
Question with a number alias

You may have instructions on a form that ask a user to skip to a certain question. If your 
form is using automatic question numbering, you can create a number alias for a 
question number and paste that alias into the instructions. Then, if the question number 
changes, the alias will automatically change to reflect the new question number.

The following rules apply to aliases:

You can create and paste aliases only from the Layout menu’s Numbering 
submenu.

If you delete the question number used in the alias, the alias is also deleted. 
However, you can delete an alias without affecting the question number that the 
alias referred to.

You cannot paste aliases between forms unless you also paste the question the alias 
refers to.
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To Use Number Aliases

E Select the number control you would like to use in the alias.

E From the Form menu choose:

Layout
Numbering

Create Number Alias

E Select the item that you would like to have as the alias (this will usually be a text 
annotation).

E From the Form menu choose:

Layout
Numbering

Paste Number Alias
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6
Creating Scale Button Matrices

A scale button matrix is a set of questions that share a common set of response items. 
The matrix provides a mechanism for aligning questions on the form and displaying 
shared response text in column labels. Each row is a separate question representing a 
separate variable, and each column holds one possible response. For example, a  
scale button matrix would represent three questions, each with five response items.

Figure 6-1
Scale button matrix

Figure 6-2
Matrix with numeric scale displayed

Tip: Matrix questions are not multiple response questions. Multiple response questions 
are questions that can have more than one response (for example, Which of the 
following magazines do you read?). By contrast, each row in a matrix is a separate 
question that can have one and only one response.

3 5×
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Creating a Matrix

You can create a matrix with the form toolbox or by dragging existing variables from 
the Builder window onto a form.

To Create a Matrix with the Form Toolbox

E If the form toolbox is not visible, from the Form window menus choose:

View
Toolbox

E Move the mouse pointer over the scale button matrix tool and hold down the left mouse 
button to display the tool well.

E Drag and release the mouse in the tool well to specify the number of rows and columns 
in the matrix.

E Click on the form to create the matrix.

A variable is automatically created for each question (row). By default, all variables 
share a common set of response items.

Figure 6-3
Newly created matrix in Design view

Drag the separator bars between row and column marker buttons to make rows and 
columns wider (or narrower). Marker buttons are visible in Design view only; they 
are never visible when entering data.

The row labels display the question text for each variable. You can edit text in the 
matrix by double-clicking on the text.
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The column labels display response items. By default, when you edit the response 
items in the column header, the response items are updated for all variables 
represented in the matrix.

Use the text tool to add text or instructions above the matrix (for example, Please 
rate the importance of the following characteristics). If you want the text to appear 
within the matrix, edit the corner header.

Figure 6-4
Modified matrix in Design view

To Create a Matrix from Existing Variables

You can drag two or more variables from the Builder window onto a form to create a 
question matrix.

E From the Builder window menus choose:

View
Variables

E Select two or more variables.

E Hold down the right mouse button while dragging the selected variables from the 
Builder window onto a form.
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E Move the mouse pointer to the desired position on the form and release the mouse 
button.

When you drag and drop variables using the right mouse button, you are prompted to 
specify the type of question you want to create.

E Select Scale button matrix from the context menu.

The number of columns depends on the number of response items or value labels 
defined for the variables. The column heads are derived from the response items or 
value labels defined for the first variable. If the first variable has no response items or 
value labels, two columns are created by default. For more information on creating 
questions from existing variables, see Chapter 4.

To Display a Numeric Scale in a Matrix
Figure 6-5
Matrix with numeric scale displayed

You can modify a scale button matrix to display a numeric scale rather than buttons in 
each row.

E Create a scale button matrix with the desired number of rows and columns using the 
form toolbox (or by dragging variables from the Builder window).

E To display caption text rather than buttons in each cell, select the button cells and use 
the Properties window to set the ButtonStyle property to Caption text for each cell. 

To select multiple cells, hold down the Shift key as you click, or drag a rectangle with 
the mouse.
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E Edit the default caption text for each cell by double-clicking on the column labels. By 
default, when you edit the column labels, all rows are automatically updated (change 
ResponseItem1 to 1, ResponseItem2 to 2, and so forth).

Figure 6-6
Selecting cells by dragging the mouse

Figure 6-7
Editing the column labels

To enter the endpoint labels in the first and last columns (for example, Important and 
Not Important), you must first break the link between the column labels and the 
captions in each cell.



134

Chapter 6

E Select the entire matrix by clicking on the lower border, and use the Properties window 
to set the ResponseTextUpdate property to False for the matrix.

With ResponseTextUpdate set to False, you can edit the column labels without 
updating all rows.

E Edit the labels in the first and last columns, and delete the text in the labels for the 
middle columns.

Modifying Matrices

You can use the Matrix submenu (available on the Edit menu) and the Properties 
window to modify matrices in a number of ways. You can:

Hide (or display) row and column marker buttons.

Insert or remove rows and columns.

Display buttons or response item text in cells.

Customize cell borders.

Update responses in all rows using the Fill Responses option.

You can also modify a matrix indirectly by modifying the variables bound to the 
matrix. For general information on modifying question and variable properties, see 
Chapter 5 and Chapter 7.

To Select Cells in a Matrix

You can select cells in a matrix using any of the following methods:

E To select the entire matrix, click on the lower border.

E To select individual cells within the matrix, click on them with the mouse. To select 
multiple cells, hold down the Shift key as you click.

E To select rows or columns of cells, click on the row and column marker buttons.

E To select all of the cells in the matrix, click on the selector button in the upper left 
corner.
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E To select all of the cells in a rectangular area, drag a rectangle with the mouse. (You 
must start dragging the rectangle outside of the matrix to use this method.)

Figure 6-8
Selecting cells by dragging the mouse

E To select a question, row, column, the entire matrix, or all cells using the menus 
choose:

Edit
Matrix

Select

To Insert a Row or Column in a Matrix

E In the matrix, select a row, column, or cell to indicate where you want to insert a row 
or column.

E From the Form window menus choose:

Edit
    Matrix
      Insert

    Row (Column)

New rows are inserted above the selected row. New columns are inserted to the left of 
the selected column.

When you insert rows, a new variable is created for each row. 
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When you insert columns, a corresponding response item is added to all variables 
bound to the matrix.

Alternatively, you can add rows by dragging variables from the Builder window 
and dropping them onto the matrix or add columns by adding response items to one 
or more of the variables represented in the matrix.

For more information on modifying variable properties, see Chapter 7.

To Delete a Row or Column from a Matrix

E In the matrix, select the row or column that you want to delete.

E From the Form window menus choose:

Edit
Matrix

Delete
 Row (Column)

Alternatively, you can delete rows by deleting the corresponding variable in the Builder 
window or delete columns by removing the corresponding response item from all 
variables represented in the matrix.

To Reorder Rows or Columns

E In the matrix, select the rows or columns that you want to move.

E From the Form window menus choose:

Edit
Matrix

Move
 Up (Down, Left, or Right)

Alternatively, you can move a row or column using the mouse. Select the row or 
column and then click on the selected row or column button and drag.

The top row of cells and the first column of cells (row and column labels) cannot be 
moved. 
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To Display Caption Text in Matrix Cells
Figure 6-9
Matrix with caption text displayed

You can use display caption text rather than buttons in matrix cells by setting the 
ButtonStyle property to Caption text. This is especially useful if you want to display a 
numeric scale rather than buttons in each row.

E Select the cells that you want to modify.

E From the menus choose:

View
Properties

E In the Properties window, edit the ButtonStyle property.

Tip: The ButtonStyle property is available only when cells containing buttons are 
selected (not row and column label cells).

To Edit Response Items in a Matrix

The variables created for a scale button matrix share a common set of response items, 
displayed in the column labels at the top of the matrix.

E To edit column labels in the matrix, double-click on the text.
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By default, when you edit the column labels, all variables bound to the matrix are also 
updated. If you prefer that changes made in the column labels not be propagated 
throughout to the matrix, modify the ResponseTextUpdate property as follows:

E Right-click on the lower matrix border to select the matrix, and select Properties from 
the context menu.

E In the Properties window, set the ResponseTextUpdate property to False.

Tip: To display response item text (rather than buttons) in all rows, select the cells and 
change the ButtonStyle property to Caption text.

To Update Response Items for All Rows

E To force all response items for all variables in the matrix to match the column labels, 
including empty cells, select the matrix.

E From the menus choose:

Edit
Matrix

Fill Responses

To Hide Row and Column Marker Buttons

E To hide (or display) row and column marker buttons when in Design view, from the 
menus choose:

Edit
Matrix

Row and Column Markers

E Select this item again to restore the original setting.

Note: Whether or not row and column markers are displayed in Design view, they are 
never visible when entering data.
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To Display Borders in a Matrix

You can specify border style and color using the BorderStyle and BorderColor 
properties.

E Select the cells that you want to modify.

E From the menus choose:

View
Properties

In the Properties window, edit the properties for the left, right, top and bottom borders 
(LeftBorderStyle, LeftBorderColor, RightBorderStyle, RightBorderColor, and so forth).
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7
Creating and Defining Variables

Your data—the responses to your questions—are stored in variables. Every question 
on a form is bound to at least one variable. In fact, you can think of a question as a 
representation of a variable on a form. For example, the question “How old are you?” 
might be bound to a variable named age. Questions that allow multiple responses are 
bound to a named set of variables called a multiple response set, with each 
subquestion bound to one of the variables in the set.

While every question on a form must be bound to a variable or a multiple response 
set, the reverse is not true—not every variable must be represented by a question. You 
can have variables in your files that do not appear on any form. Such variables can be 
filled in automatically using Skip & Fill rules or can be set to a default value (specified 
in the Variable Properties window, General tab).

Figure 7-1
Variables displayed in the Builder window
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In the Builder window, use the View menu or the toolbar to display the variables in 
your file. Each variable has a name, label, and data format. In addition, variables have 
properties, such as question text and response items, that apply to questions bound to 
the variable. (This is important because variables and questions are closely related—
you can think of a question as a representation of a variable on a form.)

If you view your data in Table Entry view, each variable is a column of data that 
measures a particular characteristic, and each row is a case.

Figure 7-2
Data displayed in Table Entry view 

Understanding the Connection between Questions 
and Variables

Questions and variables are not the same thing in the program, but they are closely 
related. You can use the program without ever understanding this connection, but it will 
make more sense if you do.

A question is a representation of a variable on a form. When you create questions 
using the form toolbox, you also create variables; the question text and response items 
displayed in questions are actually stored in the variable bound to the question.

This makes it easy to keep your questions and forms up to date and also provides 
for multiple ways of doing things in the program. You can edit question text and 
response choices directly on your form or in the Variable Properties window. Either 
way, the result is the same. Similarly, if you want to remove one of the buttons in an 
option button question, you can select and delete the button right on the form, or you 
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can delete the corresponding response item in the Variable Properties window. The 
result is the same, so use whichever method is convenient for you.

Creating Variables

You can create questions and variables using the form toolbox, or you can create 
variables using the Insert menu in the Builder window.

If you add questions to a new form using the toolbox, variables and multiple 
response sets are created for each question automatically. 

If you prefer to define your variables before you create questions, use the Insert 
menu in the Builder window to add variables to your file. You can later drag them 
onto a form to generate questions bound to those variables.

Regardless of how your variables are initially created, the methods for defining their 
properties are the same.

Tip: Copying and pasting variables in the Builder window is an easy way to create 
several variables with similar properties. However, it may be easier to create a complete 
question and copy the question rather than copying just the variable.

To Create Questions and Variables Using the Form Toolbox

E In the Form window, from the menus choose:

View
Toolbox

E In the toolbox, click on the desired question tool to select the tool.

Optionally, you can drag the mouse in the tool well as you select the tool to specify the 
number and arrangement of controls (for example, a row or column of buttons).

E Click on the form to create the question.

As you add each question, a variable or multiple response set is automatically created.

E To define variable properties, right-click on the question and select Variable Properties.

See Chapter 4 for more information on creating questions.
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To Insert a New Variable in the Builder Window

E In the Builder window, from the menus choose:

Insert
Variable…

Figure 7-3
Inserting a variable in the Builder window

E In the Variable Properties window, enter a variable name.

E Specify other variable properties as needed.

To Define Properties for a Variable or Multiple Response Set

Note: You cannot view or edit the variables for long text boxes.

E In the Builder window, from the menus choose:

View
Variables

E Right-click on a variable or set and select Variable/Set Properties.
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In the Variable Properties window, specify the variable name and label, question text, 
data type, response items, and valid and missing values as appropriate.

E To access variable properties from a question on a form, right-click on the question and 
select Variable Properties.

Tip: Changes made in the Variable Properties window are applied immediately—you 
don’t need to close the window after making changes. You can edit multiple variables 
by selecting them one after another in the Builder window without closing the Variable 
Properties window in between each selection.

General Variable Properties
Figure 7-4
Variable Properties window

Variable name and label. Variable names can be 64 bytes long. You can also enter a 
descriptive variable label that can be up to 255 characters. The descriptive labels are 
displayed in statistical output when you run analyses.
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Question text. Text is displayed in questions bound to the variables. For example, if you 
have a variable named age, you might specify “What is your age?” By default, the 
question text is identical to the variable label, but you can deselect the link if desired. 
You can edit question text in the Variable Properties window or by editing the question 
text directly on a form.

Alias. This is a JScript-compliant name used to reference the variable in rules or scripts. 
By default, the alias is the same as the variable name, but if the variable name fails to 
comply with scripting-language conventions, you are prompted to specify an 
alternative. The alias must start with a letter, must contain only numbers, letters, and 
underscores (no special characters), and must be unique within the file.

Default value. Value provided to the variable by default. If the variable is bound to a 
check box or option button question, this value determines the default state of the check 
box or option button. For example, if you want the check box to be unchecked by 
default, set the default to the unchecked value for the variable (Variable Properties, 
Values tab). 

Entry Type. Determines how a variable will appear and behave in Double Entry mode. 
By default, it is set to Double Enter, which means that the variable will be double 
entered. Edit allows a user to edit the variable in Double Entry mode. A user cannot 
access a Protected variable in any entry mode. Only a rule can fill a Protected variable.

Comments. Comments offer additional information about the variable. Comments are 
generally used for “internal” documentation (as distinct from variable labels, which are 
typically displayed in statistical output).

Variable Names

The following rules apply to variable names: 

The name must begin with a letter. The remaining characters can be any letter, any 
digit, a period, or the symbols @, #, _, or $. 

Variable names can’t end with a period.

To avoid conflict with variables automatically created by some procedures, do not 
give variables names that end with an underscore.

The length of the name can’t exceed 64 bytes. 

Blanks and special characters (for example, !, ?, ’, and *) can’t be used. 
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The following reserved keywords can’t be used as variable names:

Variable Format

The Format tab specifies the display format or data type for the variable. Available 
formats include numeric, comma, dot, scientific notation, date/time, dollar, custom 
currency, and string (letters, numbers, and punctuation). The specific options available 
in the dialog box depend on the format that you select. For example, some formats 
allow you to specify the width and number of decimals; for others, you simply select a 
format from a scrolling list of examples.

Figure 7-5
Variable Properties: Format tab

Non-numeric data. The default format for newly created variables is numeric (unless the 
variable is created for a text box question, in which case the default format is string). 
Numeric variables accept only numbers; if you want to enter non-numeric data, you’ll 
need to use a different format. 

ALL NE EQ TO LE
LT BY OR GT AND
NOT GE WITH
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However, it is a good idea to use numeric codes even for non-numeric categorical 
data because numbers are easier to analyze. Specify value labels and response items to 
describe what the codes mean (for example, codes of 1 and 2 for yes and no).

String and long string variables. If you specify the format as string, you can enter letters, 
numbers, and punctuation. Numbers are treated as characters rather than values. 
Standard string variables are no more than 8 characters in length. If you specify a 
longer length—up to 255 characters—the variable is considered a long string variable. 
Value labels, response items, missing values, and Validation rules are not available for 
long string variables.

Custom currency. Applies the custom currency format defined in File Properties 
(Builder window, File menu). See Chapter 13 for more information on specifying a 
custom currency format.

Input versus Display Formats

Depending on the format, the value that you see displayed on a form may differ from 
the actual value as entered and stored internally. Here are some general guidelines: 

For numeric, comma, and dot formats, you can enter values with any number of 
decimal positions (up to 16). Values are rounded to the number of decimals 
specified in variable properties for display purposes, but the complete value is 
stored internally. 

For string variables, all values are right-padded to the maximum width. For a string 
variable with a width of 6, a value of 'No' is stored internally as 'No    ' and is not 
equivalent to '  No  '.

For date formats, you can enter data using slashes, dashes, spaces, commas, or 
periods as delimiters between day, month, and year values, and you can enter 
numbers, three-letter abbreviations, or complete names for month values. Dates 
of the formats dd/mm/yy and mm/dd/yy are displayed with slashes for delimiters 
and numbers for the month. Dates of the format dd-mmm-yy are displayed with 
periods as delimiters. Internally, dates are stored as the number of seconds from 
October 14, 1582.

For time formats (actually a type of date format), you can enter data using colons, 
periods, or spaces as delimiters between hours, minutes, and seconds. Times are 
displayed with colons as delimiters. Internally, times are stored as the number of 
seconds.
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Variable Level

The Level tab specifies whether the non-text variable's level of measurement is scale 
(numeric data on an interval or ratio scale), ordinal, or nominal. Measurement 
specification is relevant if you use SPSS to analyze your data.

Figure 7-6
Variable Properties: Level tab

Level of Measurement (SPSS). If the variable is a non-text variable, there are three 
options for the level of measurement:

Scale. Data values are numeric values on an interval or ratio scale (for example, age 
or income).

Ordinal. Data values represent categories with some intrinsic order (for example, 
low, medium, high; strongly agree, agree, disagree, strongly disagree). Ordinal 
variables are numeric values that represent distinct categories (for example, 1 = low, 
2 = medium, 3 = high).
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Nominal. Data values represent categories with no intrinsic order (for example, job 
category or company division). Nominal variables are numeric values that 
represent distinct categories (for example, 1 = Male, 2 = Female).

Variable Values

The Values tab specifies descriptive value labels and response items. You can specify 
value labels for most variable types, including string variables, but not long string 
variables (string variables with a length greater than 8 characters). Value labels are 
particularly useful if your data file uses numeric codes to represent non-numeric 
categories (for example, codes of 1 and 2 for yes and no). Value labels can be up to 60 
characters long.

Value labels are not available for long string variables (those with a length greater 
than 8 characters).

Figure 7-7
Variable Properties: Values tab

Response items. Response items are displayed in questions bound to the variable. For 
example, if you create an option button question from the variable, each option button 
represents one of the response items. You can edit response items in the Variable 
Properties window or by modifying questions directly on a form.
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Checked and unchecked values. Mapping values are used when a variable is 
represented as a check box question. For example, when the check box is selected, the 
value of the variable is set to the checked value.

Tip: When you add or remove response items, the corresponding changes are made in 
all questions bound to the variable. For example, in the case of an option button 
question, buttons are added or removed from the question as needed. This ensures that 
your questions are up to date (but may cause questions to overlap on the form as they 
expand to accommodate additional response items).

Coding Responses

Responses can be coded as numbers or strings in the data file. For example, yes/no 
responses can be entered as yes and no, y and n, or using numeric codes (for example, 
1 and 2 for yes and no). It is a good idea to use numeric codes whenever possible 
because numbers are easier to analyze in most statistical software programs. Specify 
value labels and response items to describe what the codes mean.

If you create questions using the toolbox, numeric codes are often mapped for you. 
For example, if you create a question with an option button group, each option button 
is automatically mapped to a specific value, and a default value label and response item 
are created. All you have to do is customize the text for each value label/response item.

Missing Values

The Missing Values tab allows you to define data values as user-missing. It is often 
useful to know why information is missing. For example, you might want to distinguish 
between data missing because a respondent refused to answer and data missing 
because the question didn’t apply to that respondent.
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Figure 7-8
Variable Properties: Missing Values tab

You can enter up to three discrete (individual) missing values, a range of missing 
values, or a range plus one discrete value. For example, you can specify three 
values to indicate not applicable, don’t know, and no response. (Click the Values 
tab in the Variable Properties window to specify descriptive value labels for 
discrete missing values.)

Ranges can be specified for numeric variables only.

Missing values for string variables. For short string variables, you can specify a space 
as a discreet missing value so that “empty” string variables are treated as missing. 
Simply click in the edit field and press the space bar. A single space is sufficient; the 
value is automatically padded to the defined width of the string variable (up to 8 
characters). You cannot define missing values for long string variables with a width 
greater than 8 characters.

Data values specified as user-missing are flagged for special treatment and are 
excluded from most calculations in statistical software programs.
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User-Missing Values versus System-Missing Values

User-missing values are not the same as the system-missing (or default) value. The 
system-missing value simply indicates that no value has been specified for a variable 
for a particular case. User-missing values are values explicitly entered to indicate the 
reason that data are missing.

All variables normally default to the system-missing value for new cases (since a 
variable cannot be empty for a case). However, you can change this behavior by 
specifying a different value as the default (Variable Properties window, General tab).

Valid Values

The Valid Values tab specifies conditions that restrict the values of the variable to 
labeled values, missing values, values within a specified range, or whole numbers. If 
the user enters a value that fails to meet these conditions, the value is not accepted and 
the user is prompted to enter a different value.

Valid values options are not mutually exclusive. For example, you can specify that 
labeled values, response items, and missing values are all valid responses.

Figure 7-9
Variable Properties: Valid Values tab
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Tip: Specifications made in Valid Values create a simple Validation rule for the variable. 
You can also create Validation rules in the Rule Wizard, which offers additional options 
not available in Valid Values. For example, the Rule Wizard allows you to create a rule 
that displays a custom message when an invalid value is entered.

To Copy Variables and Multiple Response Sets

You can use the Builder window to copy and paste variables and sets. If you open 
multiple files, each file has its own Builder window, allowing you to copy and paste 
objects between them.

E In the Builder window with the variables that you want to copy, from the menus 
choose:

View
Variables

E Either select one or more variables or sets and hold down the left mouse button to drag 
selected variables from one Builder window to the other, or from the menus choose:

Edit
Copy

E In the Builder window in which you want to paste the variables, from the menus 
choose:

View
Variables

E And then choose:

Edit
Paste

Tip: You can “clone” a variable or set by copying it and pasting it back into the same 
file.
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Tips for Copying Variables and Multiple Response Sets

You can use the Builder window to copy and paste variables. If you open multiple 
files, each file has its own Builder window, allowing you to copy and paste objects 
between them.

When you copy a variable, all of its properties are copied, including any Validation 
rules bound to the variable. If you paste a variable into a file where a variable of 
the same name already exists, the pasted variable is renamed to avoid a conflict 
(since two variables cannot have the same name).

You can “clone” a variable or set by copying it and pasting it back into the same 
file. The new variable or set has similar properties to the original but is renamed to 
avoid a naming conflict. 

If you copy a multiple response set, all of the member variables are copied along 
with the set.

If the variable or set you want to copy is already bound to a question, you may save 
time by copying the complete question rather than just the variable. When you copy 
a question, the variable or set bound to the question is also copied.

You can paste a variable or multiple response set onto a form to create a question 
based on the variable.

To Copy Properties of a Variable or Set

You can copy and paste properties from one variable or multiple response set to 
another. This is an easy way to assign the properties of one variable or set to several 
others, essentially using the variable as a template.

E If necessary, from the Builder window menus choose:

View
Variables

E Select the variable whose properties you want to copy and from the menus choose:

Edit
Copy Properties
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E Select one or more target variables to which you want to paste properties, and from the 
menus choose:

Edit
Paste Properties…

E Select the properties that you want to apply to the target variable.

Figure 7-10
Paste Properties dialog box

Tip: If you open multiple files, each file has its own Builder window, allowing you to 
copy and paste properties between them.

Copying Multiple Response Sets

You can copy and paste multiple response sets as well as variables. When you copy a 
set, all of the variables within the set are also copied and renamed if necessary to avoid 
conflicts with existing variables. See Chapter 8 for more information on multiple 
response sets.

Reordering Variables

Variables are added to your file in the order in which you create them. While the order 
of variables has no effect on the order of questions on your form—you can rearrange 
your forms as much as you want regardless of the variable order—you may find it 
convenient to reorder variables to match the order of a form or questionnaire or to 
facilitate your later analysis of the data. 

You can reorder variables by opening the file in SPSS (release 7.5 or later), or a 
similar program from SPSS Inc.
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To Reorder Variables in Another Program

It is recommended that you make a backup copy before making significant 
modifications to any file.

E Open the file that you want to modify in SPSS (release 7.5 or later).

E In the Data Editor, select the column for the variable that you want to move and from 
the menus choose:

Edit
Cut

E Click on the column to the right of where you want to insert the variable and from the 
menus choose:

Data
Insert Variable

E Select the newly inserted (still empty) column.

E From the menus choose:

Edit
Paste

E Save the file.

To confirm the results, open the file in Builder.
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8
Multiple Response Questions 
and Sets

Sometimes you want to ask a question that may require more than one response. You 
might want to know which magazines people read, which products they buy on a 
regular basis, or which employee benefit services they have used in the past month. 
You can use multiple response questions to obtain more than one answer. 

Multiple response questions represent multiple response sets. A multiple response 
set is a named set of variables that can be analyzed as a group and represented on the 
form as a multiple response question. 

Multiple response sets can be coded as dichotomies or as categories. In a set coded 
as dichotomies, each possible choice represents a single variable, and each variable 
has one distinct value that means yes, count this response. Typically, that value is the 
checked value for a check box. In a set coded as categories, each possible response 
represents a variable whose value can be any of the legal responses to the question. 
Those legal responses might be represented in a set of identical list boxes, and the 
respondent chooses once from each. There does not have to be a list box for each 
possible choice—just enough to accommodate the maximum number of choices the 
respondent is expected to make.

Dichotomies are most useful when you have a manageable list of alternative 
responses. They are generally preferred for data analysis because you can analyze the 
underlying variables apart from the set and recombine them into different sets. Sets 
coded as categories are preferable when you have a large number of choices from 
which you expect respondents to select just a few—such as their favorite three 
television shows from a list of a hundred. They also allow you to later select top 
choices apart from lower choices.

For information on creating questions and defining variables, see Chapter 4 and 
Chapter 7.
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Multiple Response Questions Representing Sets Coded 
As Dichotomies

Multiple response questions allow you to ask a question and receive more than one 
answer. The answers are stored in separate variables. In effect, each option in a 
multiple response question is a subquestion. 

For example, consider the question Which of the following products do you own? 
with check boxes for four different products. The respondent can select all of the check 
boxes that apply.

Figure 8-1
Multiple response question represented with check boxes

The multiple response question, which represents a multiple response set, is composed 
of four subquestions and four separate variables.

The respondent is in effect answering yes or no to each of the subquestions. Each 
product listed in the example question functions as a subquestion of the main question, 
which represents a multiple response set coded as dichotomies. The yes or no answer 
for each product is stored in the underlying variable that is part of the set.

Variable Subquestions

Fax Do you own a fax machine?
Copier Do you own a copier?
Computer Do you own a computer?
Lprinter Do you own a laser printer?
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Multiple Response Sets Coded As Dichotomies

When you want to receive a yes or no answer to a specific set of subquestions, you can 
use a multiple response set coded as dichotomies. A set coded as dichotomies is 
composed of the set and as many variables are needed to ask the subquestions. 

Figure 8-2
Multiple response set coded as dichotomies

The following controls are appropriate for representing multiple response sets coded 
as dichotomies:

Check boxes

Single-selection list boxes

Text boxes

Drop-down lists

To Create a Multiple Response Question Representing a Set Coded 
As Dichotomies 

E If the toolbox is not visible, from the Form window menus choose:

View
Toolbox

E Move the mouse pointer over the check box question tool and hold down the left mouse 
button to display the check box well. (You can also use single-selection list boxes, text 
boxes, or drop-down lists.)
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E Drag and release the mouse in the check box well to select as many check boxes as 
you need.

E Click on the form to create the question. (If you have chosen list boxes, text boxes, or 
drop-down lists, use the right mouse button to create the question and select 
Dichotomies - numeric or Dichotomies - string.) 

When you create the multiple response question, the multiple response set is also 
created.

E To define the multiple response set, right-click on the question and select 
Variable Properties.

E To define the component variables, right-click on the question and select Variable 

Properties. You can use Copy Properties and Paste Properties on the Edit menu of the 
Builder window to apply the same properties to multiple response variables.

Multiple Response Questions Representing Sets Coded 
As Categories

A multiple response question that represents a set coded as categories collects 
responses in text boxes, drop-down lists, or single-selection list boxes. For example, 
you could use three text boxes to receive the responses and ask the question In order 
of frequency, please list the three stores you use for purchasing high-tech equipment.

Figure 8-3
Multiple response question represented with text boxes
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The respondent is able to type in the required responses, and each response is stored in its 
own variable. In this example, each of the responses represents a different store, which, 
when analyzed together, represent a multiple response set coded as categories. Note that 
string variables in a multiple response set are limited to eight characters and that string 
variables are case sensitive, so that Techshop and TechShop are different values. For that 
reason, you may prefer to use numeric variables or short alphabetic codes and have users 
select responses from a set of list boxes or enter codes from a list that you provide. 

Multiple Response Sets Coded As Categories

When you want to receive open-ended responses or a limited number of responses 
selected from predefined categories, you can use a multiple response set coded as 
categories. A set coded as categories asks a question and provides a number of text 
boxes to collect the responses. Each text box represents a variable that is part of the set. 
You can also use single-selection list boxes or drop-down list boxes to display 
predefined categories. 

Figure 8-4
Multiple response set coded as categories

Variable Subquestions

Shop1 Which store do you most often use for purchasing 
high-tech equipment?

Shop2 Which store do you second most often use for purchasing 
high-tech equipment?

Shop3 Which store do you third most often use for purchasing 
high-tech equipment?
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To Create a Multiple Response Question Representing a Set Coded 
As Categories 

E Move the mouse pointer over the text box question tool and hold down the left mouse 
button to display the text box well. (You can also use single-selection list boxes or 
drop-down lists.)

E Drag and release the mouse in the tool well to specify the number and arrangement of 
objects.

E Right-click on the form and select either Categories - string or Categories - numeric to 
create the question.

When you create the multiple response question, the multiple response set is also 
created.

E To define the multiple response set, right-click on the question and select Variable 
Properties. 

E To define the component variables, right-click on the question and select Variable 

Properties. You can use Copy Properties and Paste Properties on the Edit menu of the 
Builder window to apply the same properties to multiple variables.

Creating Multiple Response Sets

When you create multiple response questions using the form toolbox, sets are created 
automatically. However, you can define sets that do not have questions representing 
them. Create and define your set in the Builder window and then create the question 
representing it by dragging the set onto the form.
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To Insert a Multiple Response Set

E From the Builder window menus choose:

Insert
Multiple Response Set

Dichotomies... (Categories...)

E In the Set Properties window, under the General tab, give the set a name and optionally 
a label and question text. Under the Members tab, check the variables that you want to 
include in the set. 

E Alternatively, click Insert New Variable once for each new variable that you want to 
include in the set and return to the Builder window to select and define properties for 
the individual variables you created. You can use Copy Properties and Paste Properties 
on the Edit menu of the Builder window to apply the same properties to multiple 
variables.

There is a limit of 200 sets within a file.

To Create a Multiple Response Question from an Existing Set 

E From the Builder window menus choose:

View
Variables

E Select a set.

E Click the right mouse button and drag the set onto a form.

E From the context menu, select the type of question that you want to represent your 
multiple response set.
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Deleting Multiple Response Sets

Deleting a multiple response set deletes the variable and any questions that represent 
the set. The member variables still exist. For example, if you have a multiple response 
set question with the set variable $service and the member variables atm, teller, online, 
phone, and loan, when you delete $service, the other variables are not deleted. If you 
don’t want to use the member variables in your file, you must delete them separately.

Whenever you delete a variable or set, you also delete any questions or rules that are 
tied to the variable or set.

To Delete a Multiple Response Set

E From the Builder window menus choose:

View
Variables

E Select the set that you want to delete.

E From the Builder window menus choose:

Edit
Delete

Changing Multiple Response Set Types

If you want to change the type of multiple response set, you must delete it and define 
a new one using the same set of variables. If you want to analyze the same variables in 
different types of sets, you can define a new set without deleting the original one. 

Multiple Response Set Properties

Properties control several characteristics of sets, including:

Set name

Set alias

Set label

Set question text
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Comment field

Counted value (dichotomies only)

Set membership

Figure 8-5
Multiple response set properties

To Change Multiple Response Set Properties

E From the Builder window menus choose:

View
Variables

E Right-click on the multiple response set and choose Variable/Set Properties.

E Change the properties.

Changes are applied as they are made. 
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Multiple Response Set General Properties
Figure 8-6
Multiple response set general properties

Name. All set names must start with a $, which is provided preceding the name entry 
field. You do not have to type the $. Set names may not exceed 8 characters, including 
the $.

Alias. An alias is the alternative name for the set. Because JScript, which is used in the 
creation of rules, does not allow names to start with a $, you must create an alias for 
use in scripting and rules. The alias must start with a letter, must contain only numbers, 
letters, and underscores, and must be a name not used elsewhere in the file.

Label. The set label allows you to create a description of the set that will appear in 
statistical and graphical output when you run analyses on your data. 

Question text. Question text is displayed on the form. By default, the question text and 
set label are linked.

Link with set label. When checked, the question text and set label are identical, and 
changes to one are automatically made to the other. You may want to unlink the 
question text and set label for the purpose of having succinct, readable output in your 
data analysis. For example, if the question text is Which forms of transportation have 
you used in the last month?, you may want to unlink your set label and question text 
and use “transportation” for your set label.
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Counted value for dichotomies. This specifies the value of interest for analysis. The 
counted value normally equals the checked value or the value that represents an answer 
of yes. The counted value is essential for the analysis of dichotomous sets.

Comments. This allows you to store comments regarding the set.

Multiple Response Set Members Properties
Figure 8-7
Multiple response set members properties

The Members tab allows you to add and remove variables from your set. A set must include 
at least two variables. There is a limit of 100 variables within a set and 4000 variables across 
all sets. Your set must contain variables of the same type. For example, you are not able to 
add a string variable to a set containing numeric variables. If a member’s type changes later 
in the design process, the variable is automatically removed from the set. 

When you add a variable to a set, it is checked for type consistency with the other 
variables. In the interest of good design, in a multiple categories set, the value labels 
should be consistent across variables. In a multiple dichotomies set, the variables’ 
checked/unchecked property should be consistent, and the variable labels should be 
consistent. You can have inconsistent labels and checked/unchecked properties within 
your sets, but they can cause problems during analysis.

You can use the up and down buttons to reorder set members. You can also click on 
a variable and drag it to a position within the list of members.
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Question Libraries

The question libraries are a collection of files containing ready-to-use questions on 
topics, such as general demographics, customer satisfaction, and customer 
preferences. The variables attached to the questions are defined, including value 
labels and response items. You can use the questions in your files. You can also add 
files of your own to the question libraries.

Using the Question Libraries
Figure 9-1
Question Library window
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You can access the question libraries from the Edit menu. The Question Library 
window displays the contents of the question libraries in levels. At the top level is the 
folder. The QuestLib folder contains all of the question libraries files (.qlb) that 
accompany the software. Clicking on a plus sign displays the next level. You can 
browse through files, forms, and questions.

The Question Library window contains a toolbar, which will allow you to perform 
several tasks. Hold the mouse pointer over a tool to display the ToolTip that briefly 
describes what the tool does. The toolbar allows you to:

Add a folder to the question libraries.

Search through text in the question libraries.

Add questions or forms to your file.

Display Help.

Open and close the Sample View window.

If you want to view a question or form, you can do so in the Sample View window. To 
open the Sample View window, double-click a form or question or click the Show 
Sample button on the toolbar. Once the Sample View window is open, you can click on 
a form or a question to display it in the window.

Figure 9-2
Question in the Sample View window
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To Add a Question to Your Form

To open the question libraries:

E From the menus choose:

Edit
Question Library

To add a question to the current form in the current file:

E In the Question Library window, click the question that you want to add.

E Click the Add To button on the toolbar.

When you add the question to your form, Builder creates a variable for your question. 
You can edit the text of the question, the variable label, and any other variable 
properties. For example, you might want to specify missing values for the variable.

You can also add an entire form to your file by using the Add To button. When a 
form is added to your file, variables are created for all of the questions on the form. 
You can edit the questions or variables on your newly added form.

If you have more then one file open or have a multiform file, you can use context menus 
to add the question to a form other than the current form.

E In the Question Library window, right-click the question that you want to add to your 
form.

E From the context menu, select Add To.

E Select the appropriate file.

Searching for a Question in the Question Libraries

You can search through the text of the question libraries to locate an appropriate 
question. For example, if you are looking for a question on product recommendations, 
you could search for the word recommend. You will see all of the questions containing 
the word recommend in the Find Results tab in the Question Library window. You can 



174

Chapter 9

add questions to your file from that tab, just as you can from the All Files tab. Click the 
All Files tab to return to the question libraries folders.

Figure 9-3
Results displayed in the Find Results tab

To Search in the Question Libraries

E Click the Find button on the toolbar.

E Specify the words that you want to search for.

E Click OK.
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Adding Files to the Question Libraries

You can add your own files to the question libraries. This allows you to preserve 
questions for use in later files. Following are some general tips for creating files that 
lend themselves well to the question libraries.

Make sure that all variable labels, values, and response items are fully and clearly 
defined.

Rename your questions so that they have clearly understandable names. For 
example, if the default name for a question is Question1, renaming your question 
to Satisfaction will give you an idea of the question’s content.

Group questions together on forms according to their purpose and then name the 
form accordingly. This will make it easier to find the type of question you need.

By default, question library files are installed in the QuestLib subfolder, located 
under the same directory as your program software. Save all of your question 
library files in the QuestLib folder so that they will automatically appear when you 
open the Question Library window. If you decide to add the file to a different 
folder, you will have to add the folder to the Question Library window.

Once you have added your file to the question libraries, you will have to refresh the 
view in the Question Library window.

To Add a File to the Question Libraries

E Open the file that you want to add to the question libraries.

E From the Builder window menus choose:

File
Add to Question Library…

E In the Save In drop-down list, browse to the folder in which you want to save the file.

E In the File Name text box, enter a filename. Select Question Library Files (.qlb) from the 
Save as Type drop-down list.

E In the Question Library window, right-click on the QuestLib folder and select Refresh 

from the context menu.
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By default, question library files are installed in the QuestLib subfolder, located under 
the same directory as your program software. Files in the QuestLib subfolder 
automatically appear in the Question Library window. If you saved your new question 
library file to a folder other than QuestLib, you will have to add the folder so that it will 
appear automatically when you open the Question Library window.

To add a folder to the Question Library window:

E Right-click inside the Question Library window.

E From the context menu, select Add Folder.

Note: When you view your new folder in the Question Library window, you will see 
only the question library files (.qlb). If there are additional files in the new folder that 
you would like to use in the Question Library window, you will have to open them and 
add them as above. You will also have to refresh the view in the Question Library 
window by right-clicking in the window and selecting Refresh from the context menu.
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Forms

A form is the device you use to collect and view your data. The form holds the 
questions and response controls used to gather the data. The form is saved as part of 
your file when you save your file. There is no need to save only the form.

Figure 10-1
Form window and toolbox

Before you begin to design your form, you should consider who will use the form, 
what they will use it for, and how they will use it. Answering the following questions 
will allow you to develop the form(s) that will best suit the needs of your users:

Who will use the form? What is their level of expertise?

Will they use it on paper or within the data entry program? 

If you want to use a paper form, will someone then enter the data online?
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When Do You Need Separate Versions of a Form?

The program allows you to create forms for both printed questionnaires and online data 
entry via an entry form or a spreadsheet. You can often use the same form for both 
printing and online data entry. However, the program allows you to create alternate 
versions of forms, linked to the same set of variables. You may want to use two 
different forms for a number of reasons.

Figure 10-2
Online form and printed form
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Your online form might display instructions for the interview that you don’t want 
to appear on a printed form. Or, a printed form might require more instructions that 
are unnecessary online. For example, rules can automate Skip & Fill patterns in an 
online form, but you would need to include written skip instructions on a printed 
form.

You want to hide questions or responses on a printed form. For example, you don’t 
want to have a Didn’t respond option on a printed form.

Some control types, such as drop-down lists, do not work well in print. 

You may want your printed form to differ in appearance from your online form.

You want to create several forms with the same questions but in different order. For 
example, you want to control the possibility that question order biases responses.

You want to split all of your questions across several forms to make entry easier.

You want to send different groups of respondents different copies of a survey.

To Make a Copy of a Form

E From the Builder window menus choose:

View
Forms

E Select the form you want to copy.

E From the Builder window menus choose:

Edit
Copy

E From the Builder window menus choose:

Edit
Paste

If you copy and paste a form to the same file, the result is two separate forms bound to 
a common set of variables. You can customize the arrangement and appearance of 
questions on each form as needed. However, if you edit question text or response items 
or make other changes to your variables, both forms are updated.

If you copy and paste a form from one file into another file, the variables on the form 
are also copied into the other file. Changes made to a form in one file are not made to 
the form in the other file.
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To Create a Form for Table Entry
Figure 10-3
Form in Table Entry view

If you don’t want to spend time formatting the appearance or arrangements of 
questions on your form, use the Auto-create feature, which allows you to automatically 
create a form, maximized for entry in Table Entry view. To use Auto-create, you must 
have defined variables, either from an .sav file created in Builder or in another program 
from SPSS. You can use .sav files that already have forms. 

E From the Form menu choose:

Layout
   Auto Create Questions...

E Select either Create all questions as text boxes or Create questions based on default types.

Tip: Creating all questions as text boxes makes it easier to enter data in Table Entry 
view, since your hands do not have to leave the keyboard to use the mouse.

E If you want to edit the form, deselect Open in Table Entry Mode.

Designing a Form for an Interview 

The following are suggestions for adapting a form for use in an interview:

Use text annotations to incorporate the script into the form. You can also use text 
annotation objects to provide additional instructions to the interviewer.
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Make sure that AutoTab is selected to speed the entry process.

Create Validation and Skip & Fill rules to speed entry.

You can use multiple forms to display only one question at a time.

Size the form to fit your screen. Consider the type of computer and the monitor size 
used in the interview. Forms for use on laptop computers should be sized to 
accommodate the screen resolution.

Include responses such as Refused to answer and Didn’t know (which would be 
suppressed in a printed form).

Designing a Form for Printing

The following are guidelines for designing a form for printing:

Choose a font that is large enough to read.

For questions that require a written response, size the entry area to allow enough 
space for handwriting and make sure that the space is long enough to accommodate 
responses of reasonable length.

Design the form to include plenty of white space so that the form does not appear 
to be cluttered.

Use lines to break the form into sections. 

Set the margins and page size large enough to accommodate your form when you 
print the form.

Add instructions and graphics to aid the respondent.

Hide response items such as Refused to answer that you may have included on your 
online form. You can hide a response without removing it by setting the Visible 
property to False for the response control.

Use the Layout menu or toolbar to ensure the neatness of the arrangement.

Use Print Preview and View Page Breaks to ensure that questions are not split 
across pages.

Consider which controls you use because some controls (such as a drop-down list) 
will not work on a printed form.

Provide directions for skip patterns, and filling out and returning the form.

Remember, people are likely to fill out a form only if it is clear and easy to use.

Print the form in Form Entry view, either before you enter cases or before you enter 
data into a new case.
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Customizing Forms

This section describes how to specify form properties, set the page size, add headers 
and footers to a printed form, and add text labels, lines, rectangles, and pictures.

For information on creating questions, see Chapter 4.

For information on selecting, modifying, and aligning questions and other objects 
on forms, see Chapter 5.

For information on question numbering, see Chapter 5.

To Insert a New Form

When you start a session, a blank form is automatically displayed; you don’t need to 
insert a new form unless you want multiple forms in your file.

E To list the forms already in your file, from the Builder window menus choose:

View
Forms

E To insert a new form in the Builder window, from the menus choose:

Insert
Form

E To insert a form in the Form window, from the menus choose:

File
New Form

E To specify the form name, default font, and other form properties, right-click on the 
form’s background and select Properties.

E Use the form toolbox to add questions and other objects to the form.

See Chapter 4 and Chapter 5 for more information on creating and customizing 
questions.
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To Specify Form Properties

You can use the Properties window to specify the form name, window style, and the 
text displayed in the Form window title bar.

E In the Form window, right-click on the form’s background and select Properties.

E Enter a form name. 

E Enter the title bar text and press Enter.

E To restrict the size of the Form window so that it cannot be resized in Entry view, 
change the window style to Fixed.

E If you want your questions numbered automatically, change the AutoNumber property 
to True.

For more information on question numbering, see Chapter 5.

To Copy a Form

To copy a form within the same file:

E From the Builder window menus choose:

View
Forms

E Select the form you want to copy.

E From the Builder window menus choose:

Edit
Copy

E From the Builder window menus choose:

Edit
Paste
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To copy a form between files:

E Select the form you want to copy.

E Drag and drop it into the other file’s Builder window.

If you copy and paste a form to the same file, the result is two separate forms bound to 
a common set of variables. You can customize the arrangement and appearance of 
questions on each form as needed. However, if you edit question text or response items 
or make other changes to your variables, both forms are updated.

If you copy and paste a form from one file into another file, the variables on the form 
are also copied into the other file. Changes made to a form in one file are not made to 
the form in the other file.

Using Find and Replace in the Form Window

In the Form window, you can search through your form’s questions, variables, and 
properties to locate text phrases. You can also replace text in your form’s questions, 
variables, and properties. You can search through only one form at a time. If you want 
to search through another form, you must open that form. If you want to search through 
your entire file, use the Builder window. If you want to search through your data, 
search in Form Entry or Table Entry view.

To Find and Replace in a Form

E From the Form window menus choose:

Edit
Replace...

E Specify the text to search for.

E Specify the replacement text.

E Click OK.

E To search through another form, open that form.
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Spell Checking Text in the Form Window

In the Form window, you can check the spelling of your form’s questions and text 
labels. If a word is misspelled, the spell checking tool suggests alternatives, which you 
can select to replace the spelling error. You can check the spelling in only one form at 
a time.

To Spell Check Text in a Form

E From the Form window menus choose:

Edit
Spell Check

The Check Spelling dialog box appears if there are any spelling errors. For details 
about using it, click Help in the dialog box.

Page Size and Window Size

Page size refers to the size of the page when the form is printed. The form size is not 
restricted by the page or window size; forms can be as many pages long (or wide) as 
you want. To ensure that questions don’t split across pages, you can display page 
breaks when designing the form by choosing the Page Breaks option in the View menu. 

Window size refers to the size of the Form window. By default, users can resize the 
Form window at will by dragging the sides and corners; you can change this by setting 
the window style to Fixed in the Properties window.

Tip: When designing a form for online use, always consider the user’s display size. This 
is especially important if laptop computers will be used for entering data, since laptops 
typically have smaller displays than desktop computers. 
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To Set the Page Size for a Form

E From the Form window menus choose:

File
Page Setup...

E Specify the desired page size and margin width.

E Select either the narrow or the wide orientation (portrait or landscape).

To View Page Breaks

To ensure that questions don’t split across pages, you can display page breaks when 
designing the form.

E From the Form window menus choose:

View
Page Breaks

Page breaks are displayed as dashed lines whenever the form is open in Design view.

Headers and Footers

You can add custom headers and footers to a printed form. For example, you can use 
headers to add contact information or to insert instructions that are necessary only on 
a printed form, such as where to send the form after it is completed. Headers and 
footers also allow you to include pertinent reference information, such as the date, 
filename, or identification codes. 

To Add Headers and Footers to a Form

E From the Form window menus choose:

View
Headers/Footers…
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Figure 10-4
Header/Footer Settings dialog box

E In the Header/Footer Settings dialog box, enter the text that you want to appear in the 
header or footer.

E Use the buttons in the dialog box to add the date, time, page numbers, or filenames.

E Use the buttons to change the font or justification of your headers and footers.

E Choose Print Preview on the File menu to see how your headers and footers will look 
on the printed page.
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To Add Text Labels to a Form

Use the text tool to add text that is not bound to any variable. This can be useful for 
comments, directions, or codes.

Figure 10-5
Text added to a question

E If the form toolbox is not visible, from the menus choose:

View
Toolbox

E In the form toolbox, click on the text tool.

E Click on the form to add the text.

E Double-click on the text to edit the text.

Before editing the text, you may want to make the text label larger by dragging the 
selection handles so you can see more text as you type.

If you insert text within an existing question, the text becomes part of the question. 
If you move or delete the question, the text goes with it.

If you want text to overlap a question but not be part of the question, create the text 
on the form (away from the question), and then drag the text over the question. 

If necessary, you can move the text on top of the question. From the menus choose:

Layout
Layer

Bring to Front
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To Draw Lines and Rectangles on a Form

You can improve the appearance and usability of forms by drawing lines and 
rectangles.

E Select the line or rectangle tool from the toolbox.

E Draw the line or rectangle on the form.

E To specify the color, thickness, and other properties, right-click on the line or rectangle 
and select Properties.

In the Properties window, use ArrowStyle to create lines with arrows on the ends to 
illustrate skip patterns on printed questionnaires.

You can use rectangles to group questions together or to create a background 
shadow. 

Use the Bring to Front and Send to Back commands to adjust the appearance of 
rectangles used for background shadows.

To Add a Picture to a Form
Figure 10-6
Form with picture
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E If the form toolbox is not visible, from the menus choose:

View
Toolbox

E In the form toolbox, click on the picture tool.

E Click on the form where you want the picture to appear.

E Right-click on the empty picture object and select Properties.

E In the Properties window, double-click Picture.

Figure 10-7
Load Picture dialog box

E In the Load Picture dialog box, browse for or enter the name of the picture file you 
want to open. You can open bitmaps (.bmp), Windows metafiles (.wmf), icons (.ico), 
.gif files, and .jpg files.
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Adding Questions to Forms

You can add questions to your form using the form toolbox or by dragging variables 
from the Builder window onto the form.

For information on creating questions, see Chapter 4.

For information on selecting, modifying, and aligning questions and other objects 
on forms, see Chapter 5.

Creating a Form from an Existing Data File

You can generate a form from an existing data file by opening the file in the Builder 
window and dragging the variables from the Builder window onto the form. See 
Chapter 4 for more information.

Tab Order

Tab order specifies the sequence in which users can move through questions on the 
form by pressing Tab (or Shift-Tab) in Form Entry or Table Entry view. You can also 
specify the tab order for subquestions with a multiple response question, or specify the 
sequence in which arrow keys cycle through buttons in an option button question. By 
default, the tab order corresponds to the order in which your questions are created.

Tab order is extremely important in question numbering. The tab order is the 
sequence used to determine question numbering. If you change the order of the 
questions on your form, you will have to change the tab order to ensure that navigation 
is preserved and also that the question numbers reflect the correct order of the 
questions. For more information on question numbering, see Chapter 4.
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To Specify the Tab Order for a Form

Tab order specifies the sequence in which users can move through questions on the 
form by pressing Tab (or Shift-Tab) in Form Entry or Table Entry view.

Figure 10-8
Tab Order dialog box

E From the menus choose:

Layout
Tab Order and Numbering…

E Select questions with the mouse and use the arrow buttons to move them up or down 
in the tab order, or drag them up or down with the mouse.

To specify the tab order for subquestions within a multiple response question, 
double-click the question (or click the plus sign [+] icon).

To specify the sequence in which arrow buttons cycle through buttons within an 
option button question, double-click the question.

The question number appears in front of the question name. When you change the tab 
order of your questions, the question numbers change automatically.
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Rules

Rules increase the integrity of your data and help make the data entry process more 
efficient. Rules enable you to:

Catch invalid values as they are entered.

Check for illogical relationships between variables.

Fill in values for questions based on previously entered values.

Skip questions that are not applicable for particular cases.

Generate reports of invalid or inappropriate values.

Check and clean existing data files.

A rule remains inactive until it is triggered by an event that affects the variable or 
question involved with the rule or until you select a menu option that uses the rules to 
check the data. A rule attached to the variable PRODUCT, for example, might activate 
when an incorrect value is entered for that variable.

You can use rules to verify values and cases as they are entered or to check an 
entire file at once. You can also use rules to clean and verify existing data files created 
with data analysis software from SPSS Inc. Checking values as they are entered 
enables you to catch and fix incorrect values immediately, minimizing the chances of 
invalid data getting into your file. Using rules to check an entire file at once allows 
you to clean data files previously created with such data analysis software. Rules 
allow you to easily change and correct any invalid responses.

Three types of rules are available: Validation, Checking, and Skip & Fill. Each 
type of rule is responsible for different aspects of improving the data entry process, is 
triggered by different events, and results in different actions when violated.
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Rules and JScript

Rules are scripts—sets of JScript commands that help you automate your data entry 
tasks—written in the JScript programming language and saved in your file. JScript is 
Microsoft’s version of the JavaScript scripting language and is an interpreted, object-
based scripting language. 

You can create rules effortlessly using the Rule Wizard—you do not have to know 
JScript or any other programming language in order to create powerful rules with the 
Rule Wizard. If you are familiar with the JScript programming language, you can 
create rules by entering the necessary JScript commands directly into the Rule Scripts 
window. You can also use JScript and the Rule Scripts window to edit and extend the 
functionality of rules created with the Rule Wizard. See the online JScript help for 
more information on using JScript.

Creating Rules

Rules can be created by using the Rule Wizard or by selecting the New Rule option from 
the Scripts menu in the Rule Scripts window and directly entering the JScript 
commands. Unless you’re an experienced JScript user, however, you will probably 
want to begin by creating your rules with the Rule Wizard. Once you are familiar with 
the JScript code that is created for you by the Wizard, you should be able to edit 
existing rules to fit your needs. See Chapter 12 for information on creating rules 
without the Rule Wizard.
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Rule Wizard
Figure 11-1
Rule Wizard 

The Rule Wizard makes it easy to create Validation, Checking, and Skip & Fill rules 
by guiding you through each step of the process. After you complete the steps 
necessary to create a rule and click the Finish button, your new rule is added to the 
survey file. Be aware that when you use the Rule Wizard to create a rule, you are 
actually creating a JScript script—the Wizard creates the script for you.

You cannot use the Rule Wizard to edit scripts. Once a rule is created, you must 
use the Rule Scripts window to revise it. If you are not familiar with the JScript 
language and are uncomfortable with editing a script, it is best to simply delete the 
rule and recreate it using the Wizard.
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To View a Rule Script in the Rule Wizard
Figure 11-2
Rule Wizard pencil icon

When you use the Rule Wizard to create a rule, you are actually creating a script—the 
Wizard writes the JScript code for you. You can view the rule script that is being 
created by clicking the pencil icon. However, you cannot edit the script here. To edit a 
script, you must complete the rule and open the script in the Rule Scripts window.

Validation Rules

Validation rules:

Help ensure data integrity by requiring data to conform to criteria that you select 
during rule creation. 

Are attached to variables and are given the same name (by the software) as the 
variable.

Are triggered whenever they encounter an invalid value for a given variable. For 
example, if you define the valid values for AGE as 18 through 90, a Validation rule 
will display an alert when you try to enter 150. 

You can set Validation rules to verify values during data entry or to check an existing 
data file. If you set the rules to activate during data entry, an alert is given as soon as an 
invalid value is entered. When you want to check an existing data file, use Check File 
on the Rules menu in the Builder or Form windows. This produces a report of all the 
rules violated, sorted either by case or by rule.

Tip: In some cases, you do not even need a Validation rule. The variable type can also 
determine values that are invalid. For example, the software will not let you enter non-
numeric characters into a numeric field.



197

Rules

Validation Rule Specifications

There are three main elements in a Validation rule: 

Variables. The variable(s) to which the rule will be assigned. If you are using the Rule 
Wizard and you select more than one variable, the Wizard will create a separate rule 
for each variable. The scripts of these rules are identical, with the exception of the 
variable name. 

A variable can have only one Validation rule attached it. Variables that already 
have Validation rules assigned to them are not shown in the Rule Wizard variable 
list.

Alert. The type of alert that is given for invalid entries. 

Valid value criteria. The criteria that determine which values are accepted as valid. 
Values outside of these criteria will be flagged as they are entered or during case and 
file checking. You can choose to restrict valid values to any or all of the following: 
values that are labeled or have response items, user-missing values, system-missing 
values, a range of values (enter the lower and upper bounds), or whole numbers. 

Your new Validation rule will be identified by the variable to which it is attached. For 
example, if you create a new rule for the variable SALES, the new rule is listed in the 
Builder rules list as SALES. 

Tip: In some cases, you do not even need a Validation rule. The variable type can also 
determine values that are invalid. For example, the system will not let you enter a string 
variable into a numeric field.

To Create a Validation Rule with the Rule Wizard

E From the Builder or Form window menus choose:

Rules
Rule Wizard…

E Select Validates a single variable (Validation).



198

Chapter 11

Figure 11-3
Rule Wizard--Assigning a Validation rule to a variable 

E Select the variable(s) to which the new rule will be applied by clicking the check box 
to the left of the variable. You can create many rules with the same criteria at once by 
selecting more than one variable.

E Select the type of notification that will warn you of invalid entries. If you select Custom 
alert message, you must enter the message text.
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Figure 11-4
Rule Wizard--Determining valid values in a Validation rule

E Select the criteria that determine which values are valid. 

E Click Finish to create the rule.

Tips 
Click the pencil icon to view the rule script.

Use Rule Options to determine how and when Validation rules activate.
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Creating Validation Rules with the Variable Properties Settings

A Validation rule is automatically created when you set the acceptable values for a 
variable using the Valid Values tab of the Variable Properties window. The result is the 
same as when you create a Validation rule with the Rule Wizard, except that you are 
not able to select the type of notification for invalid entries. A sound (the default 
notification) is used.

Figure 11-5
Variable Properties--Valid Values tab

Variables that already have Validation rules assigned to them are not shown in the 
Rule Wizard variable list. If you try to create a Validation rule with the Wizard and 
can’t see the variable you’re looking for, you may have already created one by 
setting the Valid Values. If you want to revise the rule and are familiar with JScript, 
use the Rule Scripts window. Otherwise, delete the rule and create a new one using 
the Wizard. 
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Validation Rule Example

The following example shows you how to create a Validation rule that checks to see if 
a respondent’s age is within an acceptable range. You can find the variable used, 
BIRTH, in the Customer Satisfaction Survey, which was installed with the program. 

To create the rule:

E From the menus choose:

Rules
Rule Wizard…

E In the Rule Wizard - Start dialog box, click Validates a single variable (Validation). 

E Click Next.

E In the Rule Wizard - Validation Rule Assignment dialog box, click BIRTH, which 
selects the variable for the rule.

E Click Standard Alert Message.

E Click Next.

Now that you have selected the rule type and the variable to which the rule applies, the 
final step is to specify the criteria for the rule. Given that this is a business-oriented 
survey, you can assume that your respondents should fall within the ages of 18 to 75. 
You will create the rule so that it will trigger if someone claims to be younger than 18 
or older than 75.

E In the Rule Wizard - Variable Validation dialog box, type 1925 for the Lower bound 
and type 1982 for the Upper bound.

E Click Finish. 
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Example: Validation Rule Script

You can view the Validation rule you created by clicking the Rules icon in the Builder 
window and then double-clicking on the rule named BIRTH.

For more complex rules, see Chapter 12.

function BIRTH_Validate(thisVar)    // Generated by wizard

{

if (thisVar.IsNotValid())
{

RuleViolation(1)

}

}

Checking Rules 

Checking rules:

Ensure data integrity by examining the relationships between variables. 

Are attached to neither variables nor questions. You name Checking rules when 
you create them.

Identify logical inconsistencies in combinations of variables by comparing data 
with conditional (if-then) statements (such as, if sales are greater than $5,000). For 
example, a government tax agency might use a Checking rule that compares 
INCOME against AGE to flag tax returns for auditing purposes. It is unlikely that 
a 16-year-old would have a personal income of $100,000; a Checking rule would 
trigger an alert for such a case.

You can use Checking rules to check values as data are entered or to check an existing 
data file. If you set the rules to activate during data entry, an error message displays 
whenever a case with an invalid combination of values is committed. When you want to 
check an existing data file, use Check File on the Rules menu in the Builder or Form 
windows. This produces a report of all the rules violated, sorted either by case or by rule.



203

Rules

Checking Rule Specifications

Checking rules are built on conditional if-then expressions, which consist of one or 
more relations. Relations are short mathematical or logical statements that can be 
evaluated as true or false (X<10 is a relation, for example). Checking rules work such 
that if the value entered for a given variable meets the conditions in the conditional 
expression, then a specified action will take place. Defining the relations in the if 
expression and the resulting action in the then section are the two main steps in creating 
a Checking rule.

Figure 11-6
Checking rules--Specifying relations in the Rule Wizard

Specifying relations (if). A relation includes a variable from your file, a comparison 
operator, and a value or variable to which the first variable is compared. The 
comparison operator can be a logical operator, such as less than, or a method such as 
IsValid. In the Rule Wizard, you can add relations by clicking the And and Or buttons; 
you can also right-click in the window to delete, group, or ungroup relations.

For more information on building relations, see “Tips on Using Operators in the Rule 
Wizard (Checking and Skip & Fill Rules)” on p. 216.
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Figure 11-7
Checking rules--Specifying actions in the Rule Wizard

Specifying actions (then). You can choose to make cases that meet the conditions 
invalid or valid; you can also choose a standard or custom alert.

The Rule Wizard window displays the JScript code as it is being built. You cannot 
edit the script here. To revise a script, you must complete it and open it in the Rule 
Scripts window.

To Create a Checking Rule with the Rule Wizard

E From the Builder or Form window menus choose:

Rules
Rule Wizard…

E Select Checks a logical relationship between variables (Checking) and enter the name of 
the rule.
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Figure 11-8
Rule Wizard--Creating a Checking rule

E Create an expression that determines when the rule will activate: select a variable, a 
comparison operator, and a value or variable to which the first variable will be 
compared.

E Select Valid or Invalid to determine the status of cases that meet the conditions you just 
specified. 

E Select the type of notification that will occur when an invalid case is found.

E Click Finish to create the rule.

Click And or Or to expand the if expression with additional relations.

Right-click in the expression box to delete, group, ungroup, or negate expressions.

Click the pencil icon to view the rule script.

Use Rule Options to determine how and when Checking rules are activated.
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Checking Rule Example

The following example shows you how to create a Checking rule that checks for a 
logical relationship between age and education level. You can reasonably infer that it 
is unlikely that someone under age 22 has completed post-graduate work. You can find 
the variables used, BIRTH and EDUC, in the Customer Satisfaction Survey, which was 
installed with the program. 

E From the Builder or Form window menus choose:

Rules
Rule Wizard…

E In the Rule Wizard - Start dialog box, select Checks a logical relationship between 

variables (Checking) and type MyRule for the name of the rule.

E Click Next.

E In the Rule Wizard - Checking Rule dialog box, select BIRTH from the Variables list.

E In the Operator List, select <=.

E In the Value box, type 1978.

E Click the And button.

As you create the expression, you will see it appear in the Expression box in the middle 
of the dialog box. When you clicked the And button, you added two ampersands (the 
logical connector) and empty parentheses to accomodate the second expression. Now 
you will create the second condition of the statement.

E Select EDUC from the Variables list.

E In the Operator list, select IsLabeled.

E In the Value box, select Post Graduate.
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You have created a condition that checks to see if the value in the BIRTH variable is 
less than or equal to 1978 and if the value in the variable EDUC is labeled Post 
Graduate. This is the if condition of your rule. The next step is to create the then 
condition.

E Click Valid.

E Click Custom alert.

E In the Custom alert box, type This is unlikely. Double-check, please.

E Click Finish.

If your condition is met, your case is valid, but an alert is issued. If you wanted to make 
a stricter rule, you would make the case invalid. In this case, you do not have to be so 
strict since it is not impossible for someone under age 22 to have a post-graduate 
degree; it is simply unlikely.

Example: Checking Rule Script

You can view the Checking rule you created by clicking the Rules icon in the Builder 
window and then double-clicking on the rule named MyRule.

For more complex rules, see Chapter 12.

function MyRule_Check()    // Generated by wizard

{

if (!(Vars.BIRTH.Value <= 1978) && (Vars.EDUC.IsLabeled("Post Graduate")))

{

 RuleViolation("This is unlikely. Double-check, please.")

}

}
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Skip & Fill Rules

Skip & Fill rules:

Speed data entry by skipping questions and filling in data based on previous 
responses. 

Are attached to questions and are given the same name (by the software) as the 
question. 

Enable you to skip and fill in values for variables that are not applicable or 
necessary for a particular case. For example, if you are entering data for a male 
respondent, a Skip & Fill rule enables you to skip a section of questions intended 
only for females. The rule activates as soon as the value male is entered for the 
question Gender. This same rule could set all of the female-only questions to not 
applicable for this particular case.

Using Skip & Fill rules, you can:

Jump to a question on a form. You can navigate though a data entry form by 
skipping questions that are not applicable for a given case. You can also jump to a 
question on a different form.

Fill in or change a value. Values are automatically filled in so that you don’t have 
to enter them manually. You can even fill in variables that are on your survey. 

Change properties of questions and controls. For example, you can hide or show 
individual questions and change the properties of controls, such as font size and 
style and foreground and background colors.

Commit the current case.

Move to the next case.

Create a new case.

Skip & Fill Rule Specifications

Like Checking rules, Skip & Fill rules are built on conditional (if-then-else) 
expressions, which consist of one or more relations. Relations are short mathematical 
or logical statements that can be evaluated as true or false (X<10 is a relation, for 
example). Skip & Fill rules work such that if the value entered for a given question 
meets the conditions in the expression, then a specified action takes place, else (if the 
expression is false) a different action occurs. When building a Skip & Fill rule, you 
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must select the question to which the new rule will be attached and then define the 
expression (if) and the resulting actions (then-else) for the rule.

A question can have only one Skip & Fill rule attached it. Questions that already 
have Skip & Fill rules assigned to them are not shown in the Rule Wizard question 
list.

Figure 11-9
Skip & Fill rules--Specifying relations in the Rule Wizard

Specifying relations (if). This includes a variable from your file, a comparison operator, 
and a value or variable to which the first variable is compared. The comparison 
operator can be a logical operator, such as less than, or a method such as IsValid. In the 
Rule Wizard, you can add relations by clicking the And and Or buttons. You can also 
right-click in the window to delete, group, or ungroup relations.

See “Tips on Using Operators in the Rule Wizard (Checking and Skip & Fill 
Rules)” on p. 216 for more information on building relations.

Specifying actions (then-else). You can set skip and fill actions for values that meet the 
conditions in the expression (then) and for those that do not (else). Skip options include 
skipping to another question or form; fill options enable you to fill in values for other 
variables.

Your new Skip & Fill rule will be identified by the question to which it is attached. 
For example, if you create a new rule for the question Incom_97 on Form1, the new 
rule is listed in the Builder rules list as Form1_Question1.

The Rule Wizard window displays the JScript code as it is being built. You cannot 
edit the script here. To revise a script, you must complete it and open it in the Rule 
Scripts window.
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To Create a Skip & Fill Rule with the Rule Wizard

E From the Builder or Form window menus choose:

Rules
Rule Wizard…

E Select Sets values of variables, and skips to questions (Skip & Fill).

Figure 11-10
Rule Wizard--Assigning a Skip & Fill rule to a question

E Select each question to which the new rule will be applied by clicking the check box 
to the left of the question. You can create many rules with the same criteria at once by 
selecting more than one question.
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Figure 11-11
Rule Wizard--Building a Skip & Fill rule

E Create an expression that determines when the rule will activate: select a variable, a 
comparison operator, and a value or variable to which the first variable is compared.

E In the then section, click Skip to a Question to determine the question and form the 
system will skip to if the expression is true.

See “To Specify Skip Options in the Rule Wizard” on p. 213 for more information.
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Figure 11-12
Rule Wizard--Specifying fill options 

E In the then section, click Fill Values to select the variables and the values that will be 
filled in if the expression is true.

E Set Skip & Fill options for instances when the expression is false by clicking Skip to a 

Question and/or Fill Values in the else section.

E Click Finish to create the rule.

Tips
Click And or Or to expand the If section with additional relations.

Right-click in the expression box to delete, group, ungroup, or negate expressions.

Click the pencil icon to view the rule script.

Use Rule Options to determine when Skip & Fill rules activate.
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To Specify Skip Options in the Rule Wizard

When you click Skip to a Question in the Then or Else sections of the Rule Wizard, the 
default action is to go to the next question on the current form. 

Figure 11-13
Skip & Fill--Specifying Skip To options

To go to a different question or form:

E Select Skip to question.

E If you want to skip to a question on the current form, select the question from the 
question drop-down list. The question list contains all of the questions from the 
selected form, as well as <First Question> and <Next Question> options.
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Figure 11-14
Skip & Fill--Specifying a particular question

E If you want to skip to a question on a different form, select the form from the form 
drop-down list, and then select the question from the question list.

E If Go to next case is selected, the skip and fill actions are performed, and the software 
automatically moves to the next case. 

Tip: To move automatically to the beginning of the current form for a new case, select 
<First Question> from the question list and check the Go to next case check box.

Skip & Fill Rule Example

The following example shows you how to create a Skip & Fill rule that will take a 
respondent who answers no to question six (Did this product fail to operate?) to 
question nine and fill in the questions in between with Not Applicable.

Note: If you wish to work through this example yourself in the Customer Satisfaction 
Survey that was shipped with the product, you must go to the Builder window and 
delete Online_Question6 and Web_Question6.

E From the Builder or Form window menus choose:

Rules
Rule Wizard…

E Select Sets values of variables, and skips to questions (Skip & Fill).
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E In the Rule Wizard - Skip & Fill Assignments dialog box, click the check box in front 
of Question6.

E Click Next.

E In the Rule Wizard - Skip & Fill Rule dialog box, select FAIL from the Variables list.

E Select IsLabeled from the Operators list.

E Select No from the Values list.

As you create the expression, you will see it appear in the Expression box. You have 
created an if statement that checks to see if the answer to Question6 is no. Now, you 
will create the then statement.

E Click Fill Values.

E In the Fill when Expression is True dialog box, type 99 for the variables CONTFAIL 
and PROBMEET.

E Click Continue.

You have created half of the then statement. If the answer to Question6 is no, the 
software will fill in 99, which is code for not applicable as defined in the Variable 
Values tab of the Variable Properties window, for the variables CONTFAIL and 
PROBMEET. You will now create the second half of the then statement, which will skip 
to Question9.

E In the Rule Wizard - Skip & Fill Rule dialog box, click Skip to a Question.

E In the Skip when Expression is True dialog box, click Skip to question and select 
Question9 from the list.

E Click Continue.

E Click Finish.
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Example: Skip & Fill Rule Script

You can view the Skip & Fill rule you created by clicking the Rules icon in the Builder 
window and then double-clicking on the rule named Online_Question6.

For more complex rules, see the Chapter 12.

function Online_Question6_SkipFill(thisRespObj, thisVar)    // Generated by wizard

{

if ((Vars.FAIL.IsLabeled("No")))

{

Vars.CONTFAIL.Value=99

Vars.PROBMEET.Value=99

Forms.Online.Question9.SetFocus()

}

else

{

// by default focus will go to the next question

}

}

Tips on Using Operators in the Rule Wizard (Checking and Skip & Fill Rules)

Correctly specifying relations in a conditional expression (such as if AGE is less than 
21) is integral to creating Checking and Skip & Fill rules. Relations contain 
comparison operators, which consist of logical operators and object methods. If you 
are unfamiliar with JScript, the logical operators may appear differently from what you 
expect. For example, the JScript operator for equal to is == rather than the single 
equals sign used in mathematical expressions (=). Different comparison options are 
available depending on which operator you choose.
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Logical operators. Six logical operators are available: != (not equal), < (less than), <= 
(less than or equal to), == (equal to), > (greater than), and >= (greater than or equal to). 
Once you choose an operator, you must select a value or variable to complete the 
relation. You can select a variable or a value from their respective drop-down lists or 
enter a value or arithmetic expression.

IsLabeled. Tests a value by checking it against one of its value labels. When using this 
operator, you must select a value label from the drop-down list. For example, the 
relation if (Vars.EDUC.IsLabeled("High school")) tests to see whether the value of 
EDUC is labeled “high school.”

Any, NotAny. Any tests whether a value is among a list of values that you enter; NotAny 
does the opposite, testing whether a value is not among the list of values that you enter. 
You must separate each value on the list with a comma. For example, the relation if 
(Any(Vars.REGION.Value,1,3,4)) is testing to see whether the value of REGION is 
equal to 1, 3, or 4.

IsMissing, IsValid, IsNotValid. These operators test whether a variable’s value is, 
respectively, missing, valid, or not valid. (Valid values are set in the Valid Values tab of 
the Variable Properties window.)

Range. Tests whether a value is in a range of numbers that you enter. For example, the 
relation if (Range(Vars.EDUC.Value,3,6)) is testing to see whether the value of EDUC 
is between 3 and 6.

To Add Relations in the Rule Wizard (Checking and Skip & Fill Rules)

When you are creating Checking or Skip & Fill rules with the Rule Wizard, you can 
click And or Or to add a relation to your if statement. The Wizard inserts the necessary 
JScript operator to your expression in the expression window—&& for And, || for Or.

To Modify Relations in the Rule Wizard Expression Window (Checking and 
Skip & Fill Rules)

You can use the Rule Wizard expression window to modify relations in Checking and 
Skip & Fill rules. You can right-click to group, separate, negate, and remove relations. 
Grouping relations can change the meaning of an expression. For example, the 
expression X==1 AND Y==1 OR Z==1 is different from X==1 AND (Y==1 OR 
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Z==1). In the former, the rule will be activated if X and Y equal 1, or if Z equals 1; in 
the latter, the rule will be activate only if X equals 1 and either Y or Z equals 1.

Figure 11-15
Checking and Skip & Fill rules--Using the Rule Wizard expression window

Remove Relation deletes the selected relation(s). 

Group Relations adds parentheses around selected relations.

Separate Relations removes the outermost parentheses from selected relations.

Negate Relation inserts a ! (Not) operator in front of the selected relation(s). If the 
relation is already negated, this removes the ! operator.

To use any of the relations commands:

E In the Rule Wizard expression window, use the mouse to select one or more relations.

E Right-click and choose the necessary relations command from the menu.
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To Edit a Rule Created with the Rule Wizard

You cannot use the Rule Wizard to edit rules. Once a rule is created, you must use 
the Rule Scripts window to revise it. If you are not familiar with the JScript language 
and are uncomfortable with editing a rule script, it is best to simply delete the rule 
and create a new one using the Wizard. For information on editing rule scripts, see 
Chapter 12. 

To Delete a Rule

To ensure that you delete the correct rule, remember that:

Validation rules are named for the variables to which they are attached.

Skip & Fill rules are named for the questions to which they are attached.

You name Checking rules when you create them.

Figure 11-16
Rules in the Builder window

E To display rules in the Builder window, from the menus choose:

View
Rules
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E Select a rule and press the Delete key.

Alternatively, you can delete a rule by selecting Delete on the Edit menu in the Builder 
window or Delete Script on the Scripts menu in the Rule Scripts window.

When a variable is deleted, any Validation rules associated with it are deleted as 
well. Similarly, when a question is deleted, any Skip & Fill rules associated with it 
are also deleted.

If you delete any object that is referenced within a rule, the rule is no longer valid. 
You must edit or remove the reference.

Rule Options

Rule Options control when rules activate and how they operate.

Figure 11-17
Rules Options dialog box

Validation and Checking Rule Properties. Determine when Validation and Checking 
rules take action.

Data are checked automatically. If selected, Validation rules check values as they 
are entered, and Checking rules check data when a case is committed (Auto Check: 
On displays in the entry form status bar). If this option is not selected, Validation 
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and Checking rules are not applied until Check Case or Check File is selected from 
the Rules menu. 

Data are checked when filled by a rule. If selected, values filled in by a Skip & Fill 
rule are automatically checked by a Validation rule.

Allow an override for new entries. Determines whether you can override an invalid 
value warning from a Validation rule. If this option is selected, the Override Error 
tool and command on the Form window’s Rules menu are enabled. Choosing 
Override Error allows you to move off of a field after a Validation error. If this 
option is unchecked, Override Error is disabled, and you cannot move to another 
question until a valid value is entered.

Allow new cases with Checking rule violations to be saved. Determines whether you 
can move to the next case after attempting to commit a new case that has violated 
a Checking rule. If this option is selected and you attempt to commit a new case 
with a checking error, an alert displays, and you are given the option to go to the 
checking report to view the errors or to ignore the errors and continue to the next 
case. If you go to the checking report but do not correct the checking error, the alert 
will display again.

Skip & Fill Rule Properties. Determine when Skip & Fill rules are activated.

Test Skip & Fill rules. You will generally turn these off when making changes to an 
existing data file (since, presumably, all of the values have been entered into the 
file). If When a question loses focus is selected, the rules will activate anytime you 
move away from a question, whether it is with the keyboard or mouse. If Upon 
tabbing from a field is selected, the rules will activate only when you move away 
from a question by using the Tab or Enter keys.

To Set Rule Options

E From the Builder or Form window menus choose:

Rules
Rule Options…

E Select the settings you want.

E Click OK.
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To Check Data Automatically (Validation and Checking Rules)

You can use Validation and Checking rules to check data as they are entered.

E From the Builder or Form window menus choose:

Rules
Rule Options…

E Select Data are checked automatically.

With automatic checking enabled:

Validation rules will activate immediately after an invalid value is entered.

Checking rules will activate immediately after a case with an invalid combination 
of values is committed. 

An error message will display the incorrect value(s) and the Validation or Checking 
rule that was violated.

Copying and Pasting Rules

You can:

Directly copy Checking rules from one file to another. 

Copy Validation and Skip & Fill rules from one file to another by copying the 
variables (for Validation) or questions (for Skip & Fill) associated with those rules.

Create many Validation or Skip & Fill rules at once by selecting more than one 
variable or question in the Rule Wizard.

Reuse the same rule script code for multiple rules by creating a procedure and 
calling it from many different rules. 
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To Copy and Paste a Checking Rule

To copy and paste a Checking rule:

E If the Checking rule you want to copy is in a different file, open both files. 

Each file has its own Builder window, allowing you to copy and paste elements 
between them.

E Use the View menu or the toolbar to display the rules in each Builder window.

E Select one or more Checking rules and hold down the left mouse button to drag 
selected rules from one Builder window to the other. Or, from the Builder window 
menus choose:

Edit
Copy

E In the Builder window where you want to paste the rule, from the menus choose:

Edit
Paste

Alternatively, you can use Ctrl+C to copy the rule and then Ctrl+V to paste it. You can 
also drag a Checking rule from one Builder window to another.
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12
Rule Scripts

Rule scripts are short sets of JScript statements. When you create a rule with the Rule 
Wizard, you are actually creating a rule script—the Wizard writes the JScript syntax 
for you. Rule scripts are powerful; you can use them to:

Manipulate questions and controls. For example, you can write scripts to hide or 
show questions and response controls (for example, text boxes, option buttons, 
etc.). You can also change the visual properties (font family, size, and style or 
foreground and background colors) of controls.

Compute numbers and dates on the fly. You might compute an overall customer 
satisfaction measure by averaging the responses to five different survey questions.

Move the focus to different cases, questions, and forms. You can write a Skip & 
Fill script that will move you to another case, question, or form based on the 
response to a previous question.

Evaluate and modify variables. You can check whether values are valid, coded as 
system- or user-missing, or equal to a particular value label.
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The following is an example of a Validation rule script that checks the variable 
PRODUCT for valid values:

Figure 12-1
Example rule script

Refer to the online JScript Help for more information on using JScript. If you do not 
have the JScript Help installed, run the install program and select Custom Install; then 
select JScript Help Reference. 

Creating Rule Scripts

You can create rule scripts using the Rule Scripts editor. You can also edit existing 
scripts, such as the scripts included with this software and any scripts you have created 
with the Rule Wizard. You must be familiar with JScript in order to customize or create 
complex rule scripts.

If you are unfamiliar with JScript or with programming in general, you may want to 
create rules in the Rule Wizard and then open them in the Script window. When you 
think you understand how a particular rule works, try replacing part of it and see what 
happens. Editing existing rules is a good way to learn how JScript works.
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To Create a Rule Script

E From the Builder or Form window menus choose:

Rules
Rule Scripts

E From the Rule Scripts window menus choose:

Scripts
New Rule…

E Or, from the Builder window menus choose:

Insert
Rule…

Figure 12-2
Creating a new rule script—Selecting the type of rule

E Select Validation, Checking, or Skip & Fill.

E Select the appropriate variable (for a Validation rule) or question (for a Skip & Fill 
rule), or enter the rule name (for a Checking rule).

E Click OK.

The Rule Scripts editor will display a template script. The editor will not allow you 
to edit or delete the first line (beginning with the JScript keyword function) or the 
outermost set of brackets, as these parts of the script are required by JScript.
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Figure 12-3
Rule script template

E Complete the script by entering the necessary JScript commands.

E To automatically save the script and check it for syntax errors, close the Rule Scripts 
editor or use the drop-down list to move to another script.

To Edit an Existing Rule Script

You can modify existing rule scripts using the Rule Scripts editor. The editor works as 
a basic word processor in that you can add, cut, copy, and paste text with relative ease. 
You can also paste rule script code using the Objects, Functions/Methods/Constants, 
Procedures, Operators, and Statements windows. 

It is important to note that once a rule is created, the only way to revise it is by using 
the script editor—you cannot use the Rule Wizard to edit scripts. If you are not 
familiar with the JScript language and are uncomfortable with editing a script, it is 
best to simply delete the rule and recreate it using the Wizard.

To edit a rule script:

E In the Builder window, double-click on a rule.

E Edit the script.

The Rule Scripts editor will not allow you to edit or delete the first line or the outermost 
set of brackets, as these parts of the script are required by JScript.
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Alternatively, 

E From the Builder or Form window menus choose:

Rules
Rule Scripts

E By default, the script for the first rule is displayed. Choose the script you want to edit 
from the drop-down list on the toolbar.

Rule Scripts Window
Figure 12-4
Rule Scripts window

Scripts. Use the Scripts menu to create a new rule or procedure, check rule script 
syntax, and print and delete scripts.

Edit. Use the Edit menu to cut, copy, and paste text, find and replace text strings, and 
change the default display font.

View. Use the View menu to move to another rule, view the Objects, 
Functions/Methods/Constants, Procedures, Operators, and Statements windows, and 
change the toolbar and status bar display options.

Help. Use the Help menu to access online Help for the many features available in this 
product.
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How Scripts Work

Rule scripts are written in JScript. JScript is Microsoft’s version of the JavaScript 
scripting language and is an interpreted, object-based scripting language. Rule scripts 
work through OLE automation to manipulate objects using properties and methods. 
Each object class has specific properties and methods associated with it. For example, 
questions are a class of objects in this product. You can use the SetFocus method to 
navigate from one question to another (as in a Skip & Fill rule) or manipulate the 
Visible property to hide a question that is being skipped.

Objects, Properties, and Methods

Objects, properties, and methods are central to creating and editing rule scripts.

Objects. Objects are the elements that make up your file, including the file itself. 
Classes of objects that can be used in rule scripts include files (referred to as 
DataEntryDoc in scripts), forms, questions, controls, form objects, and variables. 
Objects are manipulated using properties and methods. 

Properties. Like real-world objects, objects have features and uses. In JScript 
programming terminology, the features are referred to as properties. Properties set or 
return attributes of objects, such as the color or cell width.

Methods. Methods are the uses of objects. They perform actions on objects, such as 
moving the question focus. For example, you can use the IsValid method to check if a 
particular variable value is valid and then use the Value property to change the value. 

Press Ctrl-O any time you are working in the script editor to display the Objects 
window, which displays object classes and the properties and methods associated with 
each.

See the online Help for more information on individual objects, properties, and 
methods.

Object Property (feature) Method (use)

Computer (real-world) speed, amount of memory word processing, spreadsheets
Question (this software) BackColor, Visible Move, SetFocus
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Objects Window

To build usable scripts, you need two things: proper syntax and logical, correct 
relations. You can use the Objects window to create proper syntax. 

The Objects window displays all object classes and the methods and properties 
associated with each. You can also access help on individual properties and methods 
and paste selected properties and methods into your script. 

To view the Objects window:

E From the Builder or Form window menus choose:

Rules
Rule Scripts

E From the Rule Scripts window menus choose:

View
Objects 

Figure 12-5
Objects window demonstrates the object hierarchy
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Objects are hierarchical in nature. Clicking on a plus sign in the Objects window 
displays the next level of the hierarchy. In writing a rule script, the full name of an 
object, property, or method includes all of the objects that come above it in the object 
hierarchy.

The general convention is ObjectClass.ObjectName(s).PropertyOrMethod. For 
example, if you wanted to access the Enabled Property of the question named Gender, 
the proper name to use is Forms.Form1.Gender.Enabled. 

Any object must have a unique name within its immediate container (that is, the 
object directly above it in the hierarchy). For example, the question Gender cannot 
have two option buttons named OptionButton1, but the questions Gender and Age can 
both have option buttons with that name. Form2 cannot have two questions named 
Income, but Form1 and Form2 can both have questions named Income. 

You can use the Objects window to help determine the full name of an object, 
property, or method. You can also use the Objects window to paste the full name 
directly into your rule script.

To use the Objects window to create proper syntax:

E Open the Objects window.

E Navigate through the objects on the left side of the screen by clicking on the plus signs 
or by using the drop-down list of objects in the upper left corner.

E Double-click on a property or method on the right of the window to paste it into the 
Rule Scripts editor.

E You can also paste a property or method by selecting it and clicking the pen icon or 
pressing the space bar. 

Tip: With the Objects window active, hold the mouse pointer over a property or method 
on the right side of the screen to see a brief description of it. 

RuleViolation Method in Validation and Checking Rules

If you are writing a Validation and Checking rule, you must include the RuleViolation 
method. This method is used to display alerts and write results to checking reports. 
RuleViolation takes a single argument, the results of which differ depending upon 
whether you are checking data as they are entered or checking an entire file at once 
(batch checking).
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The following is an example of a Validation rule that uses the RuleViolation method:

function EDUC_Validate(thisVar)
{
    if (thisVar.IsNotValid())
    {
        RuleViolation("Invalid value. Please reenter.")
    }
}

See Chapter 15 for more information.

ClearViolation Method in Validation and Checking Rules

You can use the ClearViolation method turns off a violation set by RuleViolation 
within a rule. It turns off any alerts that would otherwise be issued at data entry time 
and can also be used to write a message to the checking log. Only one message is 
written to the checking log per rule per case. ClearViolation has the following 
arguments:

Argument Checking during data entry Batch checking

0 The system beep sounds.
A standard alert is written to the 
checking file and displayed in the 
Checking Report window.

1

A standard alert is given: 
“<ruletype> <rulename> violated.” 
Example: “Checking rule INC_AGE 
violated.”

A standard alert is written to the 
checking file and displayed in the 
Checking Report window.

“string” 
(custom alert)

The custom alert is displayed. 
Example: “Invalid value. 
Please reenter.”

The custom alert message is written to 
the checking file and displayed in the 
Checking Report window.

Argument Batch checking

0
A standard alert is written to the 
checking file and displayed in the 
Check Case window.

“string” 
(custom alert)

The custom alert message is written 
to the checking file and displayed in 
the Check Case window.
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Note: While you must include the RuleViolation method in Validation and Checking 
rules, using the ClearViolation method is optional. You can use the ClearViolation 
method to ensure that the warnings are written only to the checking log, which makes 
for uninterrupted data entry.

Rule Script Components

In addition to objects, properties, and methods, rule scripts involve the following 
components:

Event. Events activate rules and are triggered by actions in the software. The three 
events available for use in rules scripting are Check, SkipFill, and Validate, which 
correspond to the three types of rules. Check and Validate events, for example, are 
triggered when you select the Check Case command; a SkipFill event is generated 
when the value of a variable is changed. The event is referenced in the first line of each 
rule. For example, a Validation rule attached to the variable AGE would begin with 
function AGE_Validate (all rules and procedures begin with the JScript keyword 
function).

Argument. Arguments are pieces of information that are passed to a function. They 
generally appear within parentheses, as in the date function TimeDays(9).

Predicate (optional). An if-then statement that evaluates to true or false. A predicate 
will generally contain an arithmetic or logical expression—for example, if 
(Vars.AGE.Value < 21).

Action. Actions change properties of controls, assign values to variables, and apply 
methods to controls. For example, the following action sets the font of a form text 
object to Courier: Forms.Form1.Text1.Font.Name = "Courier".

Functions/Methods/Constants Window

The Functions/Methods/Constants window displays all of the functions, methods, and 
constants available within JScript, as well as functions that are specific to data analysis 
software from SPSS Inc. The entries are listed in alphabetical order. You can use this 
window to paste selected functions, properties, and methods right into your script.
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Figure 12-6
Rule Scripts—Functions/Methods/Constants window (with description displayed)

 

To view the Functions/Methods/Constants window:

E From the Builder or Form window menus choose:

Rules
Rule Scripts

E From the Rule Scripts window menus choose:

View
Functions/Methods/Constants 

With the Rule Scripts window active, you can also press Ctrl-M to bring up the 
Functions/Methods/Constants window.

E Double-click on a function, method, or constant to paste it into the Rule Scripts editor. 
You can also paste an item by selecting it and pressing the space bar.

E A question mark (?) is pasted wherever an argument must be filled in for a given 
function or method. For example, the date function DateMoyr is pasted into the script 
editor as DateMoyr (?, ?) because it requires two arguments.
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Tip: With the Functions/Methods/Constants window active, hold the mouse pointer 
over a function, method, or constant to see its description.

See the online JScript Help for more information on using JScript statements.

Operators Window

The Operators window displays the JScript mathematical and logical operators 
available for use in rule scripts.

Figure 12-7
Rule Scripts—Operators window (with operator description displayed)

 

To view the Operators window:

E From the Builder or Form window menus choose:

Rules
Rule Scripts

E From the Rule Scripts window menus choose:

View
Operators 
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With the Rule Scripts window active, you can also press Ctrl-R to bring up the 
Operators window.

E Double-click on an operator to paste it into the Rule Scripts editor. You can also paste 
an operator by selecting it and pressing the space bar.

Tip: With the Operators window active, hold the mouse pointer over an operator to see 
its description.

See the online JScript Help for more information on using JScript statements.

Statements Window

The Statements window displays JScript operational statements (also called reserved 
keywords) that can be used in rule scripts, such as break, for, and continue.

Figure 12-8
Rule Scripts—Statements window (with description displayed)

 

To view the Statements window:

E From the Builder or Form menus choose:

Rules
Rule Scripts

E From the Rule Scripts window menus choose:

View
Statements 

With the Rule Scripts window active, you can also press Ctrl-S to bring up the 
Statements window.
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E Double-click on a statement to paste it into the Rule Scripts editor. You can also paste 
a statement by selecting it and pressing the space bar.

Tip: With the Statements window active, hold the mouse pointer over a statement to see 
its description.

See the online JScript Help for more information on using JScript statements.

Example: Creating a Skip & Fill Rule Using the Rule Script Editor

In this example, a Skip & Fill rule is created and attached to the first question, named 
Product1, on Form1. The rule skips to the first question on Form2 if the response to 
Product1 is “Fax Machine.” This type of rule would be applicable in instances where 
the rest of the questions on Form1 pertain only to respondents who have purchased fax 
machines.

E At the New Rule dialog box, select Skip & Fill and choose the question 
Form1_Product1 from the drop-down list.

E Click OK. 

The Rule Scripts editor will display a template script that includes the JScript keyword 
function, the full name of the question to which the rule is attached (Form1_Product1), 
the event that triggers the rule (SkipFill), the arguments required for a SkipFill event 
(thisRespObj, thisVar), and the opening and closing brackets required by JScript. The 
editor will not allow you to edit the JScript code before the first bracket or after the last 
bracket.

function Form1_Product1_SkipFill(thisRespObj, thisVar)
{
}

E Add a predicate statement (an if statement) that checks whether the response (the value 
of the variable PRODUCT) is labeled “Fax Machine.” You can use the Objects 
window to paste the method (Vars.PRODUCT.IsLabeled(?)). Replace the question 
mark with the required argument (“Fax Machine”).

if (Vars.PRODUCT.IsLabeled("Fax Machine"))
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E Add the then part of the statement in brackets. If the if statement is true, this statement 
will be executed. In this case, the focus will be set to the first question on Form2.

{
        Forms.Form2.Question1.SetFocus()
    }

E Closing the Rule Scripts editor or using the drop-down list to move to another script 
will automatically save the script and check it for syntax errors.

The resulting script looks like this:

Figure 12-9
Creating a rule script

Procedures

Procedures are similar to rule scripts in that they are sets of JScript commands. 
Procedures are meant to be called from rule scripts and are useful for reusing the same 
batch of JScript code for many rules. For example, you might want to change the 
background color and text of any question that is skipped due to a Skip & Fill rule. 
Rather than insert the necessary JScript commands into every Skip & Fill rule, you can 
save the commands as a procedure and call that procedure from each rule.
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To Create a Procedure

E From the Builder window menus choose:

Insert
Procedure…

E Enter the name of the new procedure and click OK.

E The script editor will display a template procedure. Finish the procedure by entering 
the necessary JScript commands.

E Or, from the Rule Scripts window menu choose:

Scripts
New Procedure…

Procedures Window

The Procedures window displays all of the procedures you have created for the current 
file.

Figure 12-10
Rule Scripts—Procedures window

 

To view the Procedures window:

E From the Builder or Form window menus choose:

Rules
Rule Scripts

E From the Rule Scripts window menus choose:

View
Procedures 
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With the Rule Scripts window active, you can also press Ctrl-U to bring up the 
Procedures window.

E Double-click on a procedure to paste it into the Rule Scripts editor. You can also paste 
a procedure by selecting it and pressing the space bar.

Example: Procedure

The following procedure returns the current date.

function todaydat()
{
   x = new Date()
   str = new String()
   y = x.getMonth()
   y = y + 1 
   str = y+"/"+x.getDate()+"/"+x.getYear()
   return str
}

This script calls the procedure from a Checking rule.

function orderdat_Check()
{   
    // rule compares order date to current date    
    // if less than today's date, display alert
    // call procedure to get today's date
    Vars.TODAY.Value=todaydat()
    if (Vars.ORDERDAT.Value < Vars.TODAY.Value)
    {
        RuleViolation("Invalid. Order date must be greater than or equal to current date.")
    }
}
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To Debug a Rule Script or Procedure

A script or procedure is automatically checked for syntax when it loses focus (you open 
another script or close the script window).

You can also debug rule scripts and procedures by checking the JScript syntax in 
the Rule Scripts editor.

E In the Rule Scripts editor, select the script or procedure that you want to debug.

E From the Rule Scripts window menus choose:

Scripts
Check Syntax

You can debug all of your scripts and procedures at once. From the Rule Scripts 
window menus choose:

Scripts
Check Syntax for All Scripts

The script editor will display an alert for each syntax error that is found.

To Delete a Rule Script or Procedure

E In the Rule Scripts editor, open the script or procedure that you want to delete.

E From the Rule Scripts window menus choose:

Scripts
Delete Script

You can also delete rule scripts and procedures from the Builder window by selecting 
one and pressing the Delete key.

To Print a Rule Script or Procedure

E In the Rule Scripts editor, open the script or procedure you want to print.

E From the Rule Scripts window menus choose:

Scripts
Print...



243

Rule Scripts

Rule Script Examples

The following examples illustrate many of the tasks you can accomplish with rule 
scripts. You can copy these examples from the online Help windows and customize 
them for your own files. See the online Help for more script examples.

Example: Moving to Another Form on a Survey with 
Multiple Forms

Check a value and move to another form. If you have a survey with more than one form, 
you must use a Skip & Fill rule to move from one form to another. This rule script 
checks the validity of AGE and, if the value is valid, moves you from the last question 
on Form1 to the first question on Form2. GetFirstResponseGlyph() is a method that 
returns the name of the first question, in terms of entry order, on a form.

function Form1_Question5_SkipFill(thisRespObj, thisVar)
{
    if (Vars.AGE.IsValid())
    {
        Forms.Form2.GetFirstResponseGlyph().SetFocus()
    }
}
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Figure 12-11
Moving from one form to another

Move without checking. You can also skip to the next form without first checking the 
validity of the response.

function Form1_Question5_SkipFill(thisRespObj, thisVar)
{

Forms.Form2.GetFirstResponseGlyph().SetFocus()
}

Move directly to a particular question. You can go directly to any question on the next 
form.

Forms.Form2.Question4.SetFocus()
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Example: Moving to a New Case on a Different Form

Move to the first question, next case. This rule script moves you from the last question 
on Form3 to the first question on Form1 for the next case.

function Form3_Question7_SkipFill(thisRespObj, thisVar)
{

Forms.Form1.Question1.SetFocus()
NextCase()

}

Example: Modifying the Visible Property of a Question

Modify the Visible property. Questions have a Visible property that can be set to true or 
false. This property is useful for making invisible any questions that are not applicable 
for a respondent based on his or her previous responses. The following script checks 
the value of the question Gender—if the response is male, the script skips two 
questions pertaining to pregnancy and turns them invisible. 

function Form1_Gender_SkipFill(thisRespObj, thisVar)
{
    if ((Vars.GENDER.IsLabeled("Male")))
    {

Forms.Form1.Pregnan1.Visible = false
Forms.Form1.Pregnan2.Visible = false
Forms.Form1.Workstat.SetFocus()

     }
}

Disable a question. You can also hide an inapplicable question by disabling it.

Forms.Form1.Pregnan1.Enabled=false.
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Example: Computing the Value of a Variable with a Rule Script

Compute the value of a variable. You can use rule scripts to compute new variable values 
as data are being entered or checked. The following example checks the validity of 
responses on a customer satisfaction survey. This Checking rule computes an overall 
customer satisfaction rating by taking the average of three different responses and then 
comparing the average to another question that asks, “Were you satisfied with our 
service?” If the satisfaction rating is high—in this case, an average of 8 or more on a 
scale of 1 to 10—but the answer to the final satisfaction question is negative, a 
checking error is generated.

function checkavg_Check()
{
  Vars.SAT_AVG.Value=Sum(Vars.SATRATE1.Value,Vars.SATRATE2.Value)/2
  if ((Vars.SAT_AVG.Value >= 8) && (Vars.SATFINAL.IsLabeled("No")))
    {
        RuleViolation("Customer satisfaction average does not match response. Please check case. ")
     }
}

Example: Setting Other Properties with a Rule Script

The following are examples of how you can use rule scripts to modify the properties of 
questions, response controls, and text objects. 

Change the back color of a question.
Forms.Form1.Question1.BackColor=Color.Blue 

Change the text of a question. 
Forms.Form1.Question2.QuestionText1.Text = "Enter your last name."

Change the font of the question text. 
Forms.Form1.Question2.QuestionText1.Font = "Courier"

Change the caption of an option button.
Forms.Form1.Question2.OptionButton1.Caption="College degree"
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Managing Data Files

This program is designed to be used in conjunction with statistical software programs 
from SPSS Inc.

You can read your data files in and out of recent versions of SPSS programs at 
will, including SPSS-format data files (version 7.5 or later). All of your forms, 
questions, variables, and rules are preserved when you read files in and out of 
these newer programs.

In Builder, you can open SPSS data files (*.sav) saved in earlier versions of SPSS 
for Windows, as well as files from SPSS for Macintosh or UNIX. However, you 
cannot read a data file back into one of these earlier programs without removing 
your forms, questions, and rules. (Use Export Data on the File menu to export your 
data in a format that can be read by SPSS for Windows version 6.1.3 through 7.1.)

If you want to open a spreadsheet, ASCII, tab-delimited text, database, or 
SPSS/PC+ file, open the file in SPSS, save the data in SPSS format, and then open 
it in Builder.

Files saved in Builder release 2.0 are not readable in earlier releases.

Files in Builder and Station

Builder. When you start Builder, the software opens a new file with a blank form. You 
begin creating a survey or you can open an existing file using the File menu.

Station. When you start Station, the initial dialog box allows you to choose between 
opening a local file or a master file. The master files are stored on the network server. 
To open a local file, double-click More Files under Open a Data File.
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Figure 13-1
Data Entry Station dialog box

Exporting Data

Forms, questions, and rules are not preserved in the exported data file.

To Export Data for Analysis in an Older Version of SPSS

You can read data files into and out of recent versions of SPSS programs at will, 
including SPSS-format data files (version 7.5 or later). If you want to analyze your data 
in an earlier version of SPSS, you can export only your data (cases and variables) into 
a data file that can be read by SPSS version 6.1.3 through 7.1.

E From the menus choose:

File
Export Data…

E In the Save Copy As dialog box, click the Save as Type drop-down list.
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E Select the .sav file format to save the data in a format that can be read by SPSS 6.1.3 
through 7.1.

Forms, questions, and rules are not saved in the exported data file, since these elements 
are not recognized by earlier versions of SPSS.

Opening a File Modified in Another Program

You can read data files in and out of recent versions of SPSS programs at will, 
including SPSS-format data files (version 7.5 or later). You can use Builder to open a 
file that has been modified in one of these programs. You will be warned that the file 
has been modified outside of Builder, and you will be asked if you would like to see 
the modification log. A modification log lists the changes that were made to the file. If 
a variable was deleted from the file, any object bound to the variable is also deleted. 

If you open a survey and receive this warning, call your survey administrator if you 
are in doubt about how to proceed. You can also refer to the modification log for 
information about what was deleted. 

It is always a good idea to make a backup copy of a file before opening it in another 
program. If some essential variable is accidentally deleted, you will be able to retain 
all of your data.

Tips for Managing Data Files

A file is composed of two main parts: your form(s) and your data. If you find that you 
have created a form that meets your data collection needs but you want the data stored 
in different files, you can create copies of the file. For example, if you have a file that 
you want to use to collect your data but you want the data kept in separate files 
according to month, you can make as many copies of the file as you need and then 
collect each month’s data with a different file. 
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To Make a Copy of a File
Figure 13-2
Copying a file in the Windows Explorer

E Open the Windows Explorer.

E Search through the directories until you find the file that you want to copy.

E From the menus choose:

Edit
Copy

Edit
Paste

E Change the name of your copied file.
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To Save a File without Cases

If you forget to make a copy of your file before entering data, you can save a copy of 
your file and then delete the data from the file that you want to reuse. It is a good idea 
to make a backup copy of your file before you delete your data.

E Open the file.

E From the Builder window menus choose:

File
Save As…

E Save the file under a different name.

E Switch to Table Entry view.

E From the Form window menus choose:

Edit
Select All

E From the Form window menus choose:

Edit
Delete

If you want to merge the files at a later time, you can use the ADDFILES utility.

File Properties

File properties allow you to access information about your survey and to change certain 
settings, including:

Automatic saving

Automatic backing up

Entry options

Currency formats

Date formats
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Figure 13-3
File Properties dialog box

To Change File Properties

E From the Builder window menus choose:

File
File Properties

E Click the tab(s) for the properties that you want to change.

E Change the properties to the desired values.
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General Properties
Figure 13-4
General tab

Always create a backup copy. Creates a backup copy whenever you open a file. The 
backup copy is not updated as you add data to your file. The copy is given the same 
name as your file, with a .bak extension. If for some reason you want the original data 
back, you can open the .bak file. Backups are stored in the current directory and remain 
there until removed or overwritten.

Automatic backup. Automatically saves a copy of your file at a specified interval. For 
example, if you enter three new cases and change the name of your file, a copy of your 
file containing the new cases and with the new name will be saved at the specified time 
interval. When you close the program, the autosave file will be removed. The autosave 
file appears in your directory only if the program terminated abnormally.

Save file when moving from Design to Entry. Saves the file automatically when you 
switch from Design to Entry view. 

New cases can be entered. Controls whether you can insert or append new cases to your 
file. Deselect this option to suppress the addition of new cases (for example, if you 
want to preserve your file and ensure that no data will be added).
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Existing cases can be deleted. Controls whether a case can be deleted during entry 
mode. Deselect this option to prevent the deletion of cases.

Initial form. The initial form is the form first opened when the file is opened for an entry 
session. You can specify which form you want to act as the initial form. 

Currency Formats
Figure 13-5
Currency tab

You can define up to five custom currency display formats that can include special 
prefix and suffix characters and special treatment for negative values.

The five custom currency format names are CCA, CCB, CCC, CCD, and CCE. You 
cannot change the name of a currency format. 

To define a custom currency format:

E From the Builder window menus choose:

File
File Properties
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E Click the Currency tab.

E Select one of the currency formats from the list (CCA, CCB, CCC, CCD, or CCE).

E Enter the prefix, suffix, and decimal indicator values.

Date Formats
Figure 13-6
Dates tab

Set Century Range for 2-Digit Years. Defines the range of years for date-format variables 
entered and/or displayed with a two-digit year (for example, 10/28/86, 29-OCT-87). 
The automatic range setting is based on the current year, beginning 69 years prior to 
and ending 30 years after the current year (adding the current year makes a total range 
of 100 years). For a custom range, the ending year is automatically determined based 
on the value you enter for the beginning year.
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Entering Data

You can enter data in Form Entry view or Table Entry view.

Form Entry view. You enter the data by selecting or typing in the controls provided on 
the form. The form collects the data and stores it in your file. You can use the 
keyboard, mouse, or Navigation toolbar to move through the controls on your form. 
You can print your data while in Form Entry view, but the controls of your form are 
printed for each case.

Table Entry view. You enter the data into a table that resembles a spreadsheet, with each 
column representing a question and each row representing a case. In Table Entry view, 
you enter and move through data in essentially the same way as in Form Entry view, 
only the appearance and speed of entry differ. Printing from Table Entry view gives 
you a spreadsheet-like view of your data. Table Entry view allows you to view and 
print multiple cases.
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To Enter Data in Form Entry View
Figure 14-1
Form in Form Entry view

E From the Form window menus choose:

View
Form Entry 

E Enter data into the response controls by typing or clicking on option buttons or list box 
selections.

E Press the Tab key to move between questions or to move from the last question to a 
new case.

E Press the arrow keys to move between option buttons or to move within a drop-down 
list.

E Use the space bar to select check boxes.

E Use the space bar or the mouse to deselect a selected check box.
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E Use Shift-Tab to move back to the previous question.

E Use the checking facility to examine your data for errors.

To Enter Data in Table Entry View
Figure 14-2
Form in Table Entry view

E From the Form window menus choose:

View
Table Entry

E Enter the data into the cells and press the space bar; then, use the arrow keys to look 
through the options, and use the Enter key to enter information.

E Click on a cell to select the cell. Click on the row number to select the entire case.

E Drag the separator bar to make columns wider.

E Press Tab or the arrow keys to move between cells.

E Use the checking facility to examine your data for errors.
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Tip: If you accidentally hide a column in Table Entry view by resizing it so that it 
disappears, you can double-click on the column separation bar to make the column 
reappear.

To Enter Values in Table Entry View

You can enter the value of a response item in Table Entry view, instead of selecting the 
response item in the cell. 

E From the Form window menus choose:

View
Table Entry

E From the Form window menus choose:

Data
Display Response Items

E Make sure that Display Response Items does not have a check mark by it.

E Enter data by using the values for response items. 

To Turn on AutoTab

In Table Entry view, AutoTab automatically moves you to the next question after a 
specified number of characters have been entered. AutoTab works on text box cells.

E From the Form window menus choose:

View
Table Entry 

E From the Form window menus choose:

Data
AutoTab
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To Use the Navigation Toolbar
Figure 14-3
Navigation toolbar

E Use the Arrow tools to move through your cases or to add a new case.

E Use the First Case and Last Case buttons to go to the first or last case.

E Enter a number into the box to go to a specific case number.

E Use the Next Case with Error button to go to the next case with an error.

E Use the Override Error tool to override an error if the rules of your file allow it.

E If you are entering data into a master file, you can use the Send Case button to send a 
case to the network server.

E Use Toolbars on the View menu to hide and display the Navigation toolbar.

Overriding Errors

There may be instances where you receive a rule violation error and need to override 
the error. For example, you may have entered the respondent’s answer to a question, or 
you may have to commit the case before it is complete. Depending on the design of 
your file, you may be able to override the error and move on to the next question or 
case. For more information on checking and rules, see Chapter 15.
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Keyboard Shortcuts for Entering Data

Using Cut, Copy, and Paste
You can use Cut, Copy, and Paste on the Edit menu to enter data into your file. You can 
cut, copy, or paste from Form Entry view or from Table Entry view. Cut removes the 
selected value from your file and copies the value to the clipboard. Copy copies the 
selected value to the clipboard. Paste copies the contents of the clipboard, in whole or 
part depending on the situation, to the variable bound to the selected question. You can 
cut, copy, and paste data both inside and outside of your file. You can copy:

A single value.

A case.

The previous case or one of its values.

A value from an outside source, including text or binary interchange format (BIF), 
which is the format used in spreadsheets. If you have selected more than one 
spreadsheet cell, only the first value is copied into your question’s variable.

Tab Move to the next question.
Enter Move to the next question.
Shift-Tab Move to the previous question.
Arrow keys Move through the option buttons.
Ctrl-T Switch to Table Entry view.
Ctrl-E Switch to Form Entry view.
F8 Copy the value from the previous case.
Shift-F8 Copy all values from the previous case.
Space bar Select check boxes.
Page Up Move to first question on prior page.
Page Down Move to first question on next page.

Alt-Home Move to the first question on this page. If you have text selected for 
editing, move to the first character in the selected text.

Alt-End Move to the last question on this page. If you have text selected for 
editing, move to the last character in the selected text.

Ctrl-Page Up Move to the current question on the previous case.

Ctrl-Page Down Move to the current question on the next case. If there is no next case, 
the current case is committed and a new case is created.

Ctrl-Alt-Page Up Move to the first question on the first case.
Ctrl-Alt-Page Down Move to the last question on the last case.
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To Copy and Paste Values

E Select the text that you want to copy.

E From the Form window menus choose:

Edit
Copy

E Click in the area where you want the text to appear.

E From the Form window menus choose:

Edit
Paste

To Cut a Value

E Select the value that you want to cut.

E From the Form window menus choose:

Edit
Cut

To Copy and Paste a Case

You can copy and paste cases in either Form Entry view or Table Entry view. The 
method of selecting a case differs in the two views. Copying and pasting cases is faster 
in Table Entry view.

Table Entry View

E Select the case that you want to copy.

E From the Form window menus choose:

Edit
Copy
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E Select the case you want to paste into. You can paste into a blank case or a case with 
values.

E From the Form window menus choose:

Edit
Paste

Form Entry View

E Display the case that you want to copy.

E From the Form window menus choose:

Edit
Select Case

E From the Form window menus choose:

Edit
Copy

E Display the case you want to paste into. You can paste into a blank case or a case with 
values.

E From the Form window menus choose:

Edit
Paste

To Paste Data from the Previous Case

E Select the question in the current case you want to copy the value into.

E From the Form window menus choose:

Edit
Copy Value from Previous Case

If you want to copy all values into the current case, you can press Shift-F8. 
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To Insert a Case between Existing Cases

E Select any question in the case before which you want the new case to appear.

E From the Form window menus choose:

Data
Insert Case

Before Current (After Current, At End)

To Delete a Case 

E From the Form window menus choose:

Edit
Delete Case

Deleting a case leaves you on the case immediately preceding the case that was just 
deleted.

Tip: You can also delete cases in Table Entry view. This is especially useful for deleting 
a range of cases or deleting all cases.

Committing versus Saving Cases

Committing a case validates the case and enters it into memory. You can actively 
commit a case by using the Commit Case command on the Data menu, by using the 
Navigation toolbar, or by pressing the Tab key on the last question in a case. Cases are 
also committed when you move from one case to another, save your data, open a 
different file, add a new case, or trigger a Skip & Fill rule.

Even when you have committed a case, you must still save your data file. Saving 
records more information than just your data, including information such as window 
size and location. You must save your file before you exit the session. There is no undo 
for committing a case. For more information, see Chapter 15.
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To Commit a Case Manually

E From the Form window menus choose:

Data
Commit Case

E The case is now validated and entered into memory.

E You will need to save the file upon exiting. It is also a good idea to save your file 
regularly to protect against data loss.

Continuing Where You Left Off

If, for some reason, you need to stop entering data and continue at a later time, your 
best option is to finish entering the data for your current case, save your file, and exit 
the program. However, if it is necessary for you to stop in the middle of a case, you 
may be able to commit the case, save what you have already entered, exit the program, 
and, at a later time, continue where you left off.

Whether you are able to do this depends on the rules specified for your file. If there 
are rules in your file that prohibit you from continuing to the next case until you have 
entered data in the current case, you will have to finish entering the data for the current 
case. For example, a Checking rule may be defined that prevents an incomplete case 
from being committed.

For a file without rules requiring answers to all questions, you can commit your 
incomplete case and save your file. When you open your file next time, your 
incomplete case is the current case. You can tab to where you left off and resume 
entering data.
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Using Find and Replace
Figure 14-4
Find and Replace dialog box

Find and Replace finds all instances of a response stored within your file’s variables 
and changes them. You can use Find and Replace to locate a string, a number value, or 
a date. The search continues through your file and wraps around to the beginning. 

When searching for a number, the search is not case-sensitive, and a match is made 
only for the entire value. For example, if you enter 30,000 while searching a question 
that represents a variable for wages, a match happens only for that exact number. 
Numbers such as 130,000 would not match.

A string search could consist of letters, numbers, and punctuation or only letters. For 
example, a search for John in a name box and JL-1002-88-2321 in a driver’s license 
number box are both string searches. You have the option of case-sensitive string 
searches.

When searching for dates, you have multiple options for the format of the date. For 
example, the program will accept 5/30/97 or 5-30-97 or May 30, 97. Date searches are 
not case-sensitive.

You can also search for blanks and system-missing data.
Find and Replace can be a useful tool for fixing typing or low-level entry errors. For 

instance, if you entered abbreviations for “Drive” and “Street” in addresses and then 
had to put in the full words, you could use Find and Replace to complete the task 
quickly.
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To Find and Replace a Value

E Select the field in which you want to locate the item. 

E From the Form window menus choose:

Edit
Replace…

E Enter the value that you want to find and the value that will replace it.

Printing in Form Entry View

Printing your data in Form Entry view prints the form controls as well as data. Only the 
current case is printed in Form Entry view. If you want to print all of your cases, you 
can print the file from Table Entry view. 

Page Setup allows you to specify several properties of the printed form, such as the 
paper size and source, the orientation of the page, and the margins.

To Print a Form

E Switch to Form Entry view.

E To preview your form, from the Form window menus choose:

File
Print Preview

E To print your form, from the Form window menus choose:

File
Print…

Tips
If you want to use the form as a printed questionnaire, you can either print from the 
Form Entry view before you enter cases or add a new case and then print the empty 
case.

In cases where a default value has been changed or Skip & Fill rules have been 
activated, a case may not print out blank.
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To Print All Cases in Table Entry View

E From the Form window menus choose:

View
Table Entry

E From the Form window menus choose:

File
Print…

To Specify Page Size and Orientation

E From the Form window menus choose:

File
Print…

E In the Print dialog box, specify page size and orientation.
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Checking Data 

Use the Rules menu to check your data for rule violations. The rules are created and 
saved by the survey designer. You can check a single case or an entire file. Checking 
by case allows you to examine a case quickly and correct it easily at any time during 
the entry process. Checking an entire file gives you a detailed report of all of the rule 
violations in the file. If you need to find and correct a rule violation, check by case. If 
you need a detailed report of the state of all of your data, check by file.

To Check a File

E From the Form window menu choose:

Rules
Check File

E Select either By Cases or By Rules.

E To correct errors, display the case with the error.

E Tab to the question with the error and correct it.

Tips

If you want to easily view and correct rule violations, select the report by cases. If 
you are interested in evaluating the effectiveness of your rules, select the report 
by rules.

You can open an existing data file and check it for errors.
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Checking Report by Case
Figure 15-1
Checking report by case

The first two lines of the report list the name of the file and the date and time the report 
was run. The report then lists the case number for each case with rule violations. The 
name of the violated rule is listed on a separate line below the case number.

If you want to view a case listed in the report or make changes to it, you can open 
the case in your form and make your changes. The changes are reflected in the report 
when you run a new Checking report. 

Checking Report by Rule
Figure 15-2
Checking report by rule
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The first two lines of the report list the name of the file and the date and time the report 
was run. The report then lists the name of each rule that was violated. Below the rule 
name is a list of all of the cases that violate the rule.

To Save the Checking Report

You can save a Checking report for later use or for administrative purposes. Reports 
are saved in rich text format (.rtf).

E From the Checking Report window menus choose:

File
Save

To Check a Case
Figure 15-3
Checking Report window for a single case

E From the Form window menus choose:

Rules
Check Case

E If you want to keep a record of the errors you find, the most efficient way is to run a 
Checking report by case. However, you can copy the rule violations in the Checking Report 
window by selecting the text and pressing Ctrl-C and then pasting it into a text file. 

E Click Next Case with Error to see the report for the next case containing rule violations.
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Minimizing Errors with 
Double Entry and Compare Versions

If you have data that require accurate entry, you can use Checking and Validation rules 
to uncover many errors. However, rules cannot uncover all errors. Typos, incorrect 
data, and skipped cases can still escape detection. The Double Entry and Compare 
Versions facilities can give you another way to verify the accuracy of your data.

With Double Entry, you specify which variables you want to have verified. After 
a user enters data into the file, a second user opens the file in Double Entry mode and 
enters just the variables specified as double entry variables. When differences are 
found, the user is immediately notified and is able to correct the discrepancy on the 
spot.

With Compare Versions, you can compare two versions (entered by different 
people) of the same file to minimize the possibility of errors. One file acts as the 
verification file and the other file is compared against the verification file. The files 
are checked for case, variable, and value consistency. Discrepancies are recorded in 
the comparison log file, which you can use to correct the data.

Designing a File for Double Entry

When you create your form and define your variables, you can specify which 
variables you want to have double entered by setting the Entry property of the 
variable.
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Figure 16-1
Variable Properties dialog box

There are three possible designations for the Double Entry property:

Double Enter. Allows the entry of a second value when in Double Entry mode. This is 
the default.

Edit. Allows anyone to change the values of variables during normal entry or double 
entry. 

Protected. Prevents any entry for variables in all entry modes. Protected variables can 
only be filled by rules (for example, an ID field that is incremented with each new 
case).

You cannot set the Entry property via a rule.

You can open your existing .sav files and all the variables are ready for double entry. 
You can change the Double Entry state for variables you don’t want to have double 
entered. If the file already has data in it, you can double enter that data.

Tip: Double Entry is not appropriate for long, open-ended text questions.
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Double Entering Data

After the initial data entry is complete, you can double enter the file in either Form or 
Table Entry view. You access the Double Entry mode via the Data menu. In Double 
Entry mode, you are moved automatically between the variables whose Entry 
properties are set to Double Entry. 

Figure 16-2
Double Entry dialog box

When a difference in the data is found, you must select the correct response from the 
Double Entry dialog box. Any rules attached to the variable will fire after the 
correction.

To Double Enter a File

To double enter the data in a file:

E Create a file with variables designated for double entry.

E Have someone enter data into the file.

E When the initial entry is completed, ask another user to open the file in either Form or 
Table Entry view.

E From the Form menu choose:

Data
   Double Entry

E Enter data into the file.
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E When differences occur, select the correct response from the Double Entry dialog box.

E Or, click Cancel to enter a different response.

Using Compare Versions

At the beginning of the entry process, you should create two copies of the file and have 
two different people enter the data into the files. When the data entry is complete, open 
the file whose data you want to save permanently. This is the active file, which you can 
edit to correct any discrepancies found by the comparison. You can use Compare 
Versions only in Form Entry or Table Entry view.

Figure 16-3
Compare Entry Files dialog box

Verification file. Specify the name of the file you want to compare to the active file.

Match cases by Case ID variable. This ensures that cases are matched when comparing 
files. If you don’t have a case ID, your file is compared sequentially. If files do not have 
an equal number of cases, the comparison stops when the shorter file has run out of 
cases. You can use the case ID variable to compare a subset of the cases. For example, 
if you specify a case ID variable, you can have someone randomly enter 20 selected 
cases to compare with a file of 1000 cases.
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Sort active file by Case ID variable. Sorting is required for a comparison keyed by the 
case ID variable. This option indicates whether a copy of the active file is sorted on the 
case ID for comparison. If you select this option, the active file is permanently sorted. 
If you do not, a temporary copy of the file is sorted for the comparison. If current case 
order is not important to you, select this option—it is faster and uses less disk space. 
The file is not sorted if a case ID variable is not specified. 

To Compare Versions

E Create two copies of the file without cases.

E Have someone enter the data into one of the files.

E Have someone else enter the data into the other file.

E Open the file that you want to use as the active file.

E Switch to Table Entry or Form Entry view.

E From the Builder window menus choose:

File
Compare Versions…

E Enter the name of the file that you want to use as the verification file.

E If you have a case ID and you want to use it in the comparison, select Match cases by 

Case ID variable.

E If you are using a case ID variable and you don’t mind the file being permanently 
sorted by the case ID variable, select Sort active file by Case ID variable.

E When the comparison is complete, check the comparison log for the differences in your data.

E For each difference, decide which entry is correct. If the active file is correct, do 
nothing. If the verification file is correct, edit the active file to match the verification file.
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Using the Comparison Log
Figure 16-4
Compare Files log

The comparison log shows you the warnings and errors that were generated as a result 
of the file comparison. You can save and print the comparison log. Following are the 
basic types of mismatches and errors:

Variable mismatch. Reports variables missing from the verification file, variables 
missing from the active file, and whether there are no common variables to 
compare.

Value mismatch. Reports by case with the case identified by the case number within 
an active file. If the case ID is specified, it is used instead of the case number.

Case mismatch. If the key variable is used, reports whether cases are missing in a 
file. The report stops when it runs out of cases in either file.

For each difference, decide which entry is correct. If the active file is correct, do 
nothing. If the verification file is correct, edit the active file to match the verification file.
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Merging Data Files 
with ADDFILES

ADDFILES is a stand-alone utility that allows you to merge data from several files. 
ADDFILES reads a text file of commands and uses the parameters as a guide to 
concatenate the files. Cases are added one after the other. The files are added in the 
order in which they are given in the commands. You could use ADDFILES in the 
following instances:

You create five copies of a file and have five different clerks entering data into the 
files. At the end of the study, the five files are returned to you. You can use 
ADDFILES to combine the five files into one new file.

You have five copies of a file and five different clerks entering data into the files. 
At the end of each day, each clerk saves the file under a new name and gives it to 
you. You can merge the files into one new file with ADDFILES each day. If the 
clerks use the same new filename each day, you can use the same syntax file every 
time you run ADDFILES.

You can use ADDFILES to do spot analysis on the data entered. You can get copies 
of the data files from your clerk and use ADDFILES to combine the files into a new 
file for analysis.

Run ADDFILES at the DOS prompt. Running ADDFILES requires a plain text file of 
ADDFILES commands, which is named as a command line argument. ADDFILES 
produces a log file; everything in the log file except the commands is printed as a 
comment, so if you accidentally delete your file of commands, you can run ADDFILES 
using the log file.

You can also merge files in your statistical analysis program from SPSS Inc. If you 
need to reorder cases, you can do so by opening the file in your statistical analysis 
program.
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ADDFILES is installed as part of the custom installation. If you do not currently have 
ADDFILES installed on your computer, rerun the setup program and choose the custom 
installation.

To Merge Data Files 

Imagine the following scenario: You want to collect all of your sales data for the year 
into an overall file, sales98.sav. You have sales data for the first two months of the year, 
jansales.sav and febsales.sav. This is the first time you are merging the files, so you 
will not use the MASTER subcommand. You will use the SAVE subcommand, which 
will create the sales98.sav file.

E Open Notepad or a similar text editor.

Figure 17-1
Syntax file in Notepad

E On the first line, type ADD.

E Type FILES = "jansales.sav" "febsales.sav"/ (names of the data files you want to 
merge).

E Type SAVE = "sales98.sav"/ (name of the product of the merge). 

E Type SOURCEVAR = sal. (rootname of the variable that will tell which file a variable 
came from).

E Save the syntax file as syntax.txt.
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Figure 17-2
Running ADDFILES in DOS

E At the DOS prompt, type ADDFILES /s syntax.txt.

Tips
To get usage help on using ADDFILES, type ADDFILES /? at the DOS prompt.

If you omit the optional commands, such as MASTER, make sure that your last line 
in the syntax file ends with a period (.); otherwise, use a slash (/).

ADDFILES Command Syntax

ADD
MASTER [=] "filename"/
FILES [=] "filename" "filename" …/
[SAVE [=] "filename"]
[SOURCEVAR [=] rootname].

MASTER. You use a master file for collection purposes and for dictionary information 
differences should they arise. When you specify a master file, the files you are merging 
are added to the end of the master file. The MASTER subcommand is optional. When 
you are merging files for the first time, you do not use the subcommand. You can either 
specify the final file in the SAVE subcommand or use one of the files you are merging 
as the final file. For example, you are merging jansales.sav and febsales.sav. You want 
to save the files to sales98.sav, which will contain all of your sales information for a 
year. The first time you merge your files, you do not use the MASTER subcommand. 
You use the SAVE subcommand and specify sales98.sav. The next time you merge files, 
you will use the MASTER subcommand and will specify sales98.sav as the master file. 
In the subsequent merge, you will not use the SAVE subcommand.



284

Chapter 17

FILES. Specifies the files that you want to merge. If you are not using the MASTER 
subcommand, be sure the file whose dictionary information you want to use is 
specified first. If you are not using the SAVE subcommand, be sure the file that you 
want your files saved to is specified first.

SAVE. Names the final file. This command is optional. If you do not specify a save file, 
the final file information is saved to the master file. If you do not specify a save file and 
do not have a master file, the first file specified in the FILES subcommand is used.

SOURCEVAR. This command is optional. The source variable allows you to know the 
origin of every case in your merged file. You specify a rootname for your output 
variables. The rootname cannot result in a variable name greater then 8 characters. The 
numbering system starts with 1 and leading zeros are used to create an 8-character 
name. For example, if you use march as your source variable and are merging three 
files, you create the variables march001, march002, and march003. The value of the 
source variable is 1 if the case came from the file and 0 if it did not. You will have a 
source variable for each file, and the final file should contain the same number of 
source variables as the number of files merged. 

ADDFILES Log

ADDFILES produces a plain text log file of its actions during the course of a file merge. 
The log file can show you what went wrong with an incomplete merge. Since the 
commands that ADDFILES executed are written to the log in the proper syntax format 
and the other items in the log are written as comments, you can use a log file as the 
syntax command file the next time you run ADDFILES. If you often merge the same 
files, you can use the log file from your first successful merge as your syntax file in 
subsequent merges.

Figure 17-3
ADDFILES log file
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A
Introduction to Data Entry 
Enterprise Server

The appendices describe the SPSS Data Entry Enterprise Server, which is a collection 
of software that provides tools to allow teams at your site to gather data from surveys. 
It supports all stages of the process—from survey design through data collection and 
storage. The Data Entry Enterprise Server allows multiple users to connect and add 
data simultaneously. 

The Data Entry Enterprise Server consists of two separate server components: the 
Data Entry Network Server and the Data Entry Web Server. The Data Entry 
Network Server receives survey cases from clients’ personal computers running Data 
Entry Builder, Data Entry Station, or Web browsers. The Data Entry Web Server 
allows end users to respond to your surveys from Web browsers.
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Figure A-1
Overview of steps to conduct a survey with Data Entry Enterprise Server

E Design. Use Data Entry Builder to design the survey questions, valid responses, and 
forms.

E Deploy. Use Data Entry Builder to register the master file for the survey on Network 
Server, which deploys the survey for users of Data Entry Station and enables data 
collection via the Web. Optionally, export the Survey as HTML and copy it to the 
publish directory of Data Entry Web Server, which deploys the survey on the Web.

E Collect data. Use Data Entry Station to connect to Data Entry Network Server, obtain 
a copy of the master survey file, and enter responses from paper forms. Optionally, 

Data Entry Builder

Data Entry Network ServerData Entry Web Server

1. Design

2. Deploy

3. Collect Data

Web browser Data Entry Station

paper surveys

4. Clean

SPSS statistical software

export HTML register master file

TML form
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master file

5. Analyze
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distribute the URL to the Web survey. Responses are automatically sent from Data 
Entry Web Server to Data Entry Network Server. The response data are stored in the 
master file by Data Entry Network Server.

E Clean data. Get the data from Data Entry Network Server and use Data Entry Builder 
to clean the data.

E Analyze the cleaned data. Save the clean data with Data Entry Builder and open it in 
SPSS statistical analysis software.

Software Components

The full suite of Data Entry Enterprise products includes the following software 
components:

Builder. Data Entry Builder allows the survey administrator to design surveys. Survey 
data can also be sent from Builder using the Design or Table view. Builder is typically 
installed on the survey designer's personal computer.

Station. Data Entry Station supports a subset of Builder features. Station allows data 
entry clerks to enter data from completed surveys. Station is typically installed on the 
data entry clerks’ personal computers. The use of Station is optional.

Network Server. Data Entry Network Server allows survey analysts and administrators 
to register surveys and extensions. It also has an Administrator utility that supports 
some configuration of Data Entry Enterprise Server. Once a survey is registered, the 
Network Server receives cases as they are sent from Station (or Builder) and, 
optionally, a respondent’s Web browser. The Network Server is typically installed on 
an analytic server (a server that is used to run analytic applications). 

Web Server. Data Entry Web Server, runs within Orion application server to deploy 
surveys as HTML forms to a Web browser, collect responses, and send responses to the 
Network Server. The Web Server is an optional part of the Data Entry Enterprise 
Server. The Web Server is typically installed on an HTTP server; however, it can be 
installed on the same computer as the Network Server. The use of Data Entry Web 
Server is optional.

Analysis software from SPSS. Statistical software products from SPSS Inc. allow the 
survey analyst to do further analysis of the survey responses after they are collected. 
The use of SPSS analysis software is optional.
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Appendix Overview

The appendices that follow describe how to perform the following tasks:

Designing a file for use as a master file

Sending data to the network server

Creating and deploying a Web survey
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B
Designing a File for Use As 
a Master File

This appendix explores issues relating to files that you want to register as master files, 
including:

Making decisions about when rules are to be activated

Creating a rule that will track which user entered each case

Registering a master file

Editing a master file

Double-entry and master files

Master Files and Rules Activation

When you design a file that you will use as a master file, you should make a decision 
about who will be responsible for cleaning the data. By setting the rules options, you 
can either require users to enter data that pass your Checking rules or allow them to 
override Checking rule errors, which would leave you to clean the data later. Thinking 
about this distinction before you register the master file may eliminate the need to 
change the rules options in the master file later. 
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Figure B-1
Rules Options dialog box

If you want the users to clean the data, make sure that Data are checked automatically is 
selected and that Allow an override for new entries is deselected. If you want to clean the 
data at a later time, make sure that Data are checked automatically is deselected and that 
Allow an override for new entries is selected. When the survey is completed, you can run 
a checking report and clean the data.

Tracking Cases

You can use the following Checking rule to track who entered each case and at what 
time the case was committed. A case is committed either when it is sent or when the 
user moves to the next case. To use this rule, you must create in your file two 
additional variables to store the user ID and the time. Both of these variables should 
be strings. In this example, the variables are named USERID and DATE. The 
Checking rule is named Track.
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function Track_Check()

{

Vars.USERID.Value =  UserID 

x = new Date ()

y = x.toLocaleString ()

Vars.DATE.Value = y

}

To Create the Checking Rule to Track Cases

E Create two string variables, USERID and DATE, to hold your information.

For more information on creating variables, see Chapter 7.

E From the Builder window menus choose:

Insert
Rule…

E Select Checking as the rule type, enter a name, and click OK.

E In the Rule Script window, enter the following:

Vars.USERID.Value =  UserID 

x = new Date ()

y = x.toLocaleString ()

Vars.DATE.Value = y

E Close the Rule Script window. 

E From the Builder window menus choose:

View
Rules

Your rule appears in the Builder window.
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Registering a Master File

When you have a survey file that you want users to access using Data Entry Network 
Server, you must register it as a master file. A master file is on the server and open to 
users. When users access a master file, they are actually making a copy of the file. Each 
user enters data into the copy of the file and sends cases back to the server.

To register a master file, the following conditions must be met:

The file must be a data entry file, created in Data Entry Builder, release 1.0.4 or 
later. If the file was created in a previous release of Builder, you can open it in 
release 1.0.4 of Builder and save it. If you open the file in SPSS, you must open it 
in release 1.0.4 of Builder and save it before registering it.

Note: Files saved in Builder release 2.0 are not readable in earlier releases.

If the file is stored anywhere other than on the server system, you must map a drive 
to that system. 

You must have physical access to the server to register a master file. 

Registering a master file is discussed in Appendix A.

When a file is registered, it is open to users of both Builder and Station, who can enter 
and send cases to the server. The cases are stored in the master file. Users cannot view 
the cases on (or make changes directly to) the master file, since the server locks the files 
for its own use.

To Map a Drive

The directory containing the file must be shared. To share the directory:

E Open an Explorer window on the system on which the file is stored.

E Right-click on the directory and select Properties from the context menu.

E In the Properties dialog box, click the Sharing tab and select Share As.

To map a drive to the shared directory:

E On the server, right-click on the My Computer icon.
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E Select Map Network Drive from the context menu.

E Choose a drive letter for the network drive.

E Select the appropriate computer and directory from the Shared Directories list.

E Make sure that Reconnect at Logon is selected. If the drive does not automatically 
connect, this will cause problems for users who want to connect to the file.

Editing a Master File

If you need to make changes to the master file: unregister it, make the changes using 
Builder, and then reregister the file. Like registering, unregistering a master file 
requires physical access to the server.

If users have connected to the master file and sent cases to it, you should notify them 
that you are making changes to the file. Once the master file is changed and 
reregistered, they will not be able to send cases back to the server via the file they 
originally connected to and saved locally. They must reconnect and get a copy of the 
new master file. If the users have saved cases in the local files, they cannot send those 
cases back to the master file if it has been modified since they originally connected to 
it. The local files, however, can be merged with the master file using the ADDFILES 
utility.

Note: There is a limitation to using ADDFILES to add cases to the master file. To use 
ADDFILES, you must unregister the master file. When you are finished using 
ADDFILES, you must open the file in release 1.0.4 or later of Builder and resave it 
before you can register it as a master file. The best course of action is to wait until the 
end of the data collection process to use ADDFILES. 

If you decide it is necessary to make changes to the master file, following these steps 
should provide a smooth transition: 

Establish a time period during which you will change the master file.

Inform the users of this time period and encourage them to send their cases to the 
server before the master file arrives.

After the new master file is registered, allow the users to connect to the new master 
file.

For more information on ADDFILES, see Chapter 17.
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Double-Entry Verification and Master Files

The Network Server is designed only to receive data; it cannot send data to Builder or 
Station. If you want to perform double-entry verification on a master file, you must 
follow this procedure:

E Create a file with variables designated for double entry.

E Register the file as a master file on the Network Server.

E Ask a user to connect to the master file on the Network Server.

E When the user finishes entering the data, he or she sends all of the cases to the Network 
Server.

E Unregister the master file and make a copy of it.

E Delete all of the cases from the copy of the file.

E Register the copy of the file as a master file on the Network Server.

E Give the copy of the file to a second user.

E The second user opens the file locally and switches to double-entry mode.

E The second user enters data into the file and all variables designated for double entry 
are verified.

E When the second user has finished entering the data, he or she sends all of the cases to 
the Network Server.

E You have now verified data in the master file.
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Sending Data to the 
Network Server

This appendix explores:

Connecting to the network server using Builder and Station

Sending data to the network server

Dealing with send failures

Connecting to the Server

You can connect to the Data Entry Network Server using either Builder or Station. 
When you start Station, the initial dialog box allows you to choose between opening 
a local file or a master file. The master files are stored on the server. 

Figure C-1
Data Entry Station dialog box
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Double-clicking More Files under Connect to a master file on the Data Entry Server will 
open the Select Server Master File dialog box, which will allow you to specify a server 
address and view the names of the master files.

If you are using Builder or if you already have Station open, you can connect to the 
server by choosing Connect to Master File on the File menu, which will open the Select 
Server Master File dialog box.

Figure C-2
Select Server Master File dialog box

The first time that you connect to the server, you must set the server system address. 
The server system address is the name or the IP address of the system on which the 
Data Entry Network Server is installed. Contact your survey administrator if you do 
not know the server system address. Once you have specified a server system address, 
you will not have to do so again unless the server location changes or you need to 
connect to a different network server on a different system.

Note: If you use the server name for the address, do not use slashes. For example, if the 
server name is DESERVR, you should enter DESERVR. Your survey administrator 
may specify a port number. If you should use DESERVR, port 1277, you should enter 
DESERVR:1277 as the address.

After you specify the server address, click the Refresh File List button. Then you can 
select the master file that you want to open.

When you open a file on the server, you are actually creating a local copy of the file 
without any cases in it. If you save the copy immediately, you can then access that copy 
for subsequent entry sessions. This allows you to download the copy only once and 
enter data for as long as the master file is registered.
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To Connect to a Master File

E In the Station dialog box, double-click More Files under Connect to a master file on the 
Data Entry Server.

or

E From the Station window menus choose:

File
Connect to Master File...

E In the Server dialog box, enter the server system’s name or IP address.

E Click the Refresh File List button.

E In the Master files list, double-click the file that you want to open.

E You can now enter cases into your copy of the master file.

Sending Cases Back to the Server

The data you enter are stored in your copy of the master file. Periodically, you should 
send your data back to the server. When you send cases to the server, they are stored in 
the master file and are not available for recall or viewing.

When you begin a session, send your first completed case to the server to make sure 
the server and the file are both available. You can send cases to the server as often as 
you wish. When you end the session, you will be asked if you want to save the file. 
Although you can save the file and send the cases back later (as long as the registered 
file has not changed), it is recommended that you send any remaining cases to the 
server before ending a session.

Note: If you receive the error message Cannot connect to the Data Entry Server, you 
should save your file locally. Contact your survey administrator. When the network 
server is available, you should restart Builder or Station, open the local file, and send 
your cases to the server.
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To Send Cases Back to the Server

E From the Form window menus choose:

Data
Send Case

or 

Data
Send All Cases

E Alternatively, to send just one case, you can use the Send Case icon on the toolbar.

Note: After you send cases to the server, you are unable to access them.

Dealing with Send Failures

There may be occasions in which you will receive notices of send failures. The server 
may be unreachable, in which case you should try to send the cases at a later time.

If you receive a warning indicating that there is no matching master file on the 
server, you should contact the survey administrator. It is possible that the master file 
was moved or changed. Save your file locally, since your survey administrator can use 
the ADDFILES facility to combine the data with the file.
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Creating and Deploying a 
Web Survey

With Data Entry Web Server, you can create surveys, deploy them on the Web, and 
automatically manage your data collection and cleaning.

Data Entry Web Server works in conjunction with your Web server software and 
our data collection server, known as the Network Server. Your Web server displays 
your survey as a normal HTML page. When an Internet user answers your survey and 
submits the information, the Data Entry Web Server collects the data and sends it to 
the Network Server, where it is saved in a master file in .sav format. When your 
survey is complete, you can open the .sav file in SPSS for data analysis or in SPSS 
Data Entry Builder for cleaning.

This appendix explores:

Creating a survey for the Web

Rules and the Web

Exporting your file to HTML

Registering a master file

Deploying your survey on the Web

Creating a Survey for the Web

The process for creating a form for the Web is the same as that for creating any form. 
Place questions on the form, define your variables, and, if you choose, create rules. 

When you export a form to HTML, the questions on your form are exported in the 
order in which they appear on the form. Questions are exported from left to right. The 
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order in which you create the questions and the tab order of the questions have no 
bearing on the order of questions when they are exported. The browser controls the tab 
order of questions. 

Question numbers are exported. Lines and rectangles are not exported. If you want 
to include lines in your HTML page, you can edit the HTML file.

When you create a form that you plan to export to HTML, you should keep in mind 
certain browser limitations. Although you can achieve two-dimensional layout in 
HTML, browsers do not support pinpoint placement of controls the way Builder does. 
Also, do not overlap questions or place controls inside one another.

People are more likely to fill out a form if it is easy to use. Following are some tips for 
making an online form easier to use:

The SPSS Data Entry Web Server works with Microsoft Internet Explorer 
(versions 4.0 and higher). Although Netscape Navigator (versions 4.0 and higher) 
is generally supported, certain versions may not function optimally. You may want 
to include a text annotation on your survey that tells users which browser to use. 
Add instructions in text annotations to aid the user. You should instruct the user to 
use the Previous Form and Next Form buttons to navigate between pages, instead of 
the Web browser’s Back and Next buttons. (The Previous Form and Next Form 
buttons are created automatically when you export your survey to HTML.)

Note: If users use the Web browser’s Back and Next buttons, rules may not behave as 
expected.

Break the form into pages by inserting forms.

Design the form with plenty of white space so that it does not appear cluttered. 
Unlike paper forms, you are not restricted to a single page or a single form. You 
can place many questions on a form and when the form appears in the browser, 
respondents can scroll easily through the questions.

Avoid creating disabled questions, since there is no way to disable and enable 
questions in the Web browser.

Use only the letters A–Z and numbers 0–9 in your filenames. Avoid using spaces.

Lines and rectangles are not exported to HTML. If you want lines in your form, you 
can edit the HTML file to include lines.

If you want to password-protect your survey, ask your Webmaster or system 
administrator to create a login and password facility compatible with your Internet 
server software. You can also specify that the survey is secure when you export. If 
you do this, contact your Data Entry Enterprise Server administrator.
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Graphics and the Web

You can include graphics on a form you are designing for the Web. The graphic file 
must be in either .jpg or .gif format. 

When you export a file that contains images, the graphics files are copied to the 
exported WebFiles folder. The graphics files are renamed according to their Form and 
Name properties in Builder. For example, a graphics file may be named 
Form1Picture1.jpg. 

Tip: Use the Name property in the Properties window to change the default name for 
pictures to something more descriptive or more closely matching the original filename 
of the graphic. 

Defining Variables for a Web-Based Survey

Defining variables for a Web-based survey is essentially the same as defining variables 
for an online or paper-based survey. You specify the name and type of the variable and 
can then specify variable values, missing values, and valid values.
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Figure D-1
Variable Properties General tab

However, there is one major difference in defining variables for Web-based surveys. 
When you select the default value using the General tab of the Variable Properties 
window, you may only use System missing or a defined number or string, such as 0 or 
Internet user. Same as previous case and Increment previous by 1 are not supported in 
surveys when exported to HTML and will be replaced with System missing during export.

Creating Rules for the Web

Rules behave slightly differently for Web forms than for conventional data entry forms. 
To account for these differences, you must set your Rule Options carefully. The special 
settings are as follows:
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Figure D-2
Rules Options dialog box

Data Checking. When Data are checked automatically is selected, Validation rules are 
activated when the Internet user answers the question, and Checking rules are activated 
when the Internet user submits a case or uses the Next Page button to advance to 
another form. If you do not select Data are checked automatically, your Validation and 
Checking rules are not exported to HTML. If you select Data are checked when filled by 

a rule, Validation rules are activated when a question is filled as part of a Skip & Fill 
rule. This setting is optional for forms that you want to export to HTML.

Action for Invalid New Data. You do not need to select Allow an override for new entries. 
This option is not applicable to Web forms. Allow new cases with checking rule violations 

to be saved controls whether a user can submit a case when a Checking rule is violated. 
How you set this option is a matter of personal preference. However, you may want your 
rules to be lenient for the Internet user, since people may not take the time to correct 
answers and may just abandon the survey if their initial answers are not accepted.

Skip & Fill Properties. If Test Skip & Fill rules is not selected, none of your Skip & Fill 
rules are exported to HTML. When a question loses focus and Upon tabbing from a field 
are not applicable to rules on the Web.
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You should also keep the following guidelines in mind to create better rules for the Web:

You are strongly encouraged to use the Rule Wizard to create rules that you plan 
to export with Web surveys. Rules created with the Wizard will always work on 
the Web.

People are going to fill out surveys only if they are easy to use and efficiently 
designed. If you create rules that are too strict, you may not get a good response 
rate because people may abandon a survey that is difficult or demanding.

To avoid confusion when you use Checking rules, questions that are being checked 
in relation to each other should appear on the same form. 

When you create a Checking or Validation rule, always specify a custom alert 
message that will make sense to a Web user. In your custom alert, you should 
specify the question number or question text as well as a hint that will help the user 
enter a correct value. Two examples are: Your answer to question 5 is invalid; please 
enter a number only or Your answer to the question “How old are you” is invalid; you 
must enter a number between 1 and 100. 

Note: Before exporting your file to HTML, you should always test your rules in Builder 
to ensure that they are working correctly.

Advanced Issues in Rule Creation

You can use the Rule Scripts window to create rules for the Web or to edit rules created 
in the Rules Wizard. You must be familiar with JScript to create complex or custom rules, 
and you should take special care in testing your rules in Builder and then on the Web. 

Note: You can use all functions, methods, and constants to create rules for the Web, 
with the exception of the color constants. For example, NMiss, Any, or NotAny are 
functions you can use in rules for the Web.

The following global methods are supported:

FormCount()

GetCurrentForm()

SetCurrentForm(name)



305

Creating and Deploying a Web Survey

The following global properties are supported:

Forms

Vars

The following properties and methods are supported for forms:

FormObjects

Name(+ Question, Set, Matrix Objects)

SetFocus()

GetFirstResponseGlyph()

GetNextResponseGlyph()

The following properties and methods are supported for questions:

Name

Varset

SetFocus()

GetDictItem()

The following properties and methods are supported for matrix questions:

Name(+ Question Objects)

The following properties and methods are supported for multiple response set 
questions:

Name(+ Question Objects)

VarSet

SetFocus()

GetDictItem() 
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The following properties and methods are supported for variables:

Value

Name(only get...)

IsValid()

IsNotValid()

IsMissing()

IsLabeled()

To Export to HTML

E From the Builder menus choose:

File
Export

To HTML...

Figure D-3
Export to HTML dialog box
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E In the Export to HTML dialog box, select the forms that you want to export.

E If necessary, click the arrow buttons to change the order of the forms. The order in 
which they appear on the list is the order in which they will be exported and linked 
together with the Previous Form and Next Form buttons. The Previous Form and Next 

Form buttons are created automatically when you export your survey to HTML.

E Select the options for the chart export:

Prevent multiple submissions by the same user. This option prevents ballot stuffing. 
When the user submits a survey, the Data Entry Web Server puts a cookie on the user's 
computer to prevent the user from accessing the survey again.

Display the question focus marker. This option displays an arrow in the HTML survey 
to indicate the current question.

Secure survey. This option limits access to the survey to only specific users. A user list 
must be imported into the mySQL database for Data Entry Enterprise Server. For more 
information about importing users, refer to the SPSS Data Entry Enterprise Server 
Administrator's Guide. The user will be prompted for a user name and password when 
accessing the Web survey. Secure surveys also provide users with a button for backing 
up the user's current responses and stopping the survey. When the user logs back in, the 
survey begins where the user left off.

E In the Data Entry Collection Server section, type the address of the Data Entry Network 
Server—for example, deserver. If you do not know the address of the Network Server, 
contact your system administrator.

E Click OK.
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Exported Files

When you export to HTML, you create two folders: WebFiles and Master. The two 
folders are created as subfolders of a folder named after the survey.

Figure D-4
Files for the Web server

The files found in the WebFiles folder include:

Formname.jsp. For each form in the survey that you export, you generate a JavaServer 
Page (JSP) file, which is named after a specific form. For example, if your survey 
contains two forms named GenderFrom and AgeForm, the name of the JSP files is 
GenderForm.jsp and AgeForm.jsp, respectively.  

Index.htm. Sets up the frames and controls how the form files are displayed in the 
browser.

Thankyou.htm. The final file that the user sees after submitting answers. You may want 
to edit this file to display contact or company information or to provide additional links 
to direct users after they have finished taking your survey. For example, you can 
provide a link to take users back to your company’s home page.

Wait.htm. The message that the user sees while waiting for the browser to load the survey. 

Filename.js. A JavaScript (JS) file that contains the rules for the survey. It is named after 
the name of the file you exported to HTML. For example, if the file you exported was 
named CustSat.sav, the Java Script file is named CustSat.js. You should not edit this file. 
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Image Files. If your survey includes images, copies of the files are placed in the 
WebFiles folder. 

Figure D-5
Files for the network server

The files found in the Master folder include:

Filename.ser. An important file that must reside with the .sav file in order to collect data 
properly.

Filename.sav. When you export a file to HTML, you create a copy of your original data 
entry file (.sav) in the Master folder. This is the file that you will register as a master 
file on the Network Server.

Filename.js. For each file that you export, you generate a JavaScript (JS) file, which is 
named after your file. For example, if the name of your file is WebSurvey, the name of 
your JS file is WebSurvey.js. 

Note: The original file remains on your system after your export to HTML, in addition 
to the copy in the Master folder. If you want to make substantial changes, such as 
deleting a variable, you should delete your exported folders, open your original file in 
Builder, make the changes, and export your file to HTML. When making changes, it is 
recommended that you edit your original .sav file and reexport instead of editing the 
copy of the survey created during the export process.
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Export Log
Figure D-6
Export log

You can use the export log as a diagnostic tool for examining problems with your 
exported forms and also to see exactly what was and was not exported. 

After you export your file to HTML, you can view the log by clicking the View Log 
button in the Export Status dialog box and save the log by clicking the Save Log button. 
It is recommended that you save your logs with unique names to avoid overwriting 
previous logs.
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Editing Your HTML

Once you export your file into HTML, you can view the file locally on your browser 
by dragging the file from an Explorer window into your browser. Open filename.htm 
instead of index.htm because index.htm will not allow you to see your questions. If you 
want to make changes to the way it looks, you can edit the HTML file. Before you edit 
your HTML file, you should save a copy of it. 

You can edit your HTML files in an HTML editor or in a text editor. When 
manually editing HTML files, you should make only minor or cosmetic changes. For 
example, you can add lines to enhance the appearance of your survey or change the 
colors. If you want to make substantial changes, such as deleting a question or 
changing the order of the questions, you should delete your exported folders, open the 
original file in Builder, make your revisions, and reexport the file to HTML.

Deploying Your Survey Online

Deploying your survey online is a two-step process:

Register your data entry file as a master file on the Network Server.

Place the WebFiles folder in your Web server’s public HTML directory.

Registering Your Master File

In order to receive data into your file, you must register it as a master file on the 
Network Server. 

To register a master file, the following conditions must be met:

The file must be a data entry file created in release 1.0.4 or later of Builder.

If the file is stored anywhere other than the server system, you must map a drive to 
that system. 

You must have physical access to the server to register a master file. 

To access the Network Server, double-click the SPSS Data Entry Network Server icon 
in the Control Panel.
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To Register a Master File

E From the Windows Start menu choose:

Settings
Control Panel

E Double-click the SPSS Data Entry Network Server icon.

E On the Files tab of the Server dialog box, click the Add button.

E In the dialog box, browse to find the file you want to register as a master file.

E Select the file and click Open.

Note: If the file you want to register is stored anywhere other than on the server system, 
you must map a drive to that system.

For more information on registering files and the Network Server, see Appendix A.

Deploying Your Survey on the Web

After you export your data file to HTML, you must place the WebFiles folder in your 
Web server’s designated public directory, which is the area where your Web server 
software stores the files it displays on the Web. If you do not know which directory this 
is, contact your system administrator. Once the survey is deployed on the Web, you can 
then publicize the link. Internet users will take the survey and submit the data to the 
Web server, which will then transmit the data to the master file on the Network Server, 
where it is saved in SPSS format.

If the survey designer identified the survey as a secure survey when exporting it to 
HTML, users must enter the correct user names and passwords before being able to 
access the survey. Additionally, users can exit the secure survey at any time by clicking 
Stop and return later. Clicking this button saves the user’s responses up to that point. 
When the user logs back in to the survey, the survey starts where the user left off. 
Clicking Stop and return later does not transmit the survey responses to the master file.

Completion of Data Collection

Once you have completed your Web survey, you can clean your data in Builder or 
SPSS, or you can analyze them in SPSS.
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accelerator keys
entering data, 262

ADDFILES, 281, 282
command syntax, 283

aliases, 127
multiple response sets, 168

aligning
form objects, 96, 99, 101
form text, 117

annotations
adding to forms, 188

Any operator, 216
arrows

drawing on forms, 189
autosave, 253
AutoTab, 180, 260

background color, 116
background style, 116
backup file

saving automatically, 253
bitmap graphic files, 189
borders

matrices, 139
bring to front, 102
Builder window, 41

multiple files, 43

caption alignment, 117
caption position, 117
cases

committing, 265, 266

deleting, 265
entering, 258, 259
inserting, 265
moving to specific, 261
printing, 268

cell borders
matrices, 139

changing question type, 113
check box controls

caption alignment, 117
caption position, 117

checking data
automatic checking, 222
by case, 271, 272
by file, 271
by rule, 271, 272
existing data files, 271
overriding errors, 261
report, 273
single case, 273

Checking report
by case, 272
by rule, 272

Checking rules, 202
copying and pasting, 223
creating, 204
example, 207
specifications, 203

cleaning data, 271, 272, 273
ClearViolation method, 233
cloning variables
color

form objects, 116
form text, 114

comparing files, 275, 279, 280
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control properties
specifying, 49, 50

control types
list boxes, 85
matrix, 129, 130, 131, 132
option buttons, 87
scale button matrix, 129, 130, 131, 132

controls
adding to questions, 105, 106, 107, 108, 109, 110
aligning, 96, 99, 101
copying and pasting, 107
customizing, 93
disabling, 118
hiding, 119
removing, 112
resizing, 98
selecting, 93

copying, 73
cases, 263
Checking rules, 223
controls, 107
forms, 183
previous case, 264
values, 263, 264
variables, 154, 155

counted values, 168
creating

forms, 182
questions, 55, 59
rules, 194

currency formats
customizing, 254

data, 258, 259, 266, 269
automatic checking, 222
checking, 271
entering, 258, 259, 266
exporting, 248
failures sending, 298
printing, 269
sending to the server, 297

Data Entry Builder, 7
Data Entry Station, 8

data files
comparing, 275, 279, 280

data types
display formats, 148

date formats
properties, 255

dates, 268
finding, 267

default font
setting for form, 115

default tool properties, 120
default value

variables, 153
deleting

response controls, 112, 119
rules, 219

Design view, 42
switching between views, 43

disabling controls, 118
displaying page breaks, 185, 186
docking toolbars, 47
double entry, 275, 277

master files, 294
double-entry verification, 275, 279, 280
drawing

arrows, 189
lines, 189
rectangles, 189

enabling controls, 118
entering data
export log, 310
exporting, 306
exporting data, 248

files, 251
copying, 250
exported to HTML, 308
managing, 249
managing multiple, 43
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opening, 247
properties, 251, 252
registering, 311, 312
saving, 247
without cases, 251

finding
dates, 268
strings, 267, 268
text in the Form window, 184
value during entry, 267, 268

flat style
questions and controls, 116

font
form text, 114, 115
size, 115

footers
creating, 186

Form Entry view, 42
entering data, 258
printing, 268
switching between views, 43

form layout grid, 101
form objects

aligning, 96, 99, 101
layering, 102
resizing, 98
selecting, 93

form properties
specifying, 49, 50, 183
title bar text, 183

form text
alignment, 117
editing, 96
sizing automatically, 98, 117
specifying font, 114, 115

form toolbox, 47
displaying, 48
specifying tool properties, 50

Form window size, 183
fixed, 185, 186

forms, 191, 192
adding pictures, 189
adding questions, 177
auto-creating, 62

copying, 179, 183
creating, 182
designing, 180, 181
headers and footers, 186
initial form, 253
naming, 183
page size, 185, 186
renaming, 177
selecting, 93
using the question libraries, 173

Functions/Methods/Constants window, 234

graphic files
adding to forms, 189

grid
aligning form objects, 101

group, 103, 104

headers
creating, 186

hiding
columns in Table Entry view, 259
controls on forms, 119
toolbars, 46

HTML files
editing, 311

icon graphic files, 189
inserting

cases, 265
multiple response sets, 165
new forms, 182
rules, 227

invisible controls, 119
IsLabeled operator, 216
IsMissing operator, 216
IsNotValid operator, 216
IsValid operator, 216
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JavaScript. See JScript
JScript, 194

aliases, 168
operators, 216

justification
form text, 117

keyboard shortcuts
entering data, 262

labels
adding to forms, 188

layering form objects
bring to front, 102
send to back, 102

layout grid, 101
lines

drawing on forms, 189
list box controls, 85, 86

creating, 85
list items, 86

locking controls, 118

master files
double entry, 294
editing, 293
failures sending data, 298
registering, 292
rules firing, 289
sending data to, 297
tracking entries, 290

matrix
cell borders, 139
creating, 129, 130, 131, 132
deleting rows and columns, 136
displaying caption text, 137
inserting rows and columns, 135
reordering rows and columns, 136
response items, 137, 138
row and column markers, 138
selecting, 134

matrix properties
specifying, 49, 50

merging files, 281, 282
command syntax, 283
log file, 284

metafile graphic files, 189
methods

ClearViolation, 233
RuleViolation, 232

missing values, 153
defining, 153

moving
between forms using rule scripts, 243
form objects, 97
to a new case using rule scripts, 245

multiple response questions, 160, 161, 163
adding subquestions, 105, 106, 107, 108, 109, 111
adding variables, 108
creating for sets coded as categories, 164
creating for sets coded as dichotomies, 161
creating from existing sets, 165

multiple response sets
coded as categories, 163
coded as dichotomies, 160, 161
copying and pasting, 154
creating, 165
deleting, 166
properties, 167, 168, 169

network server
connecting to the server, 295
send failures, 298
sending data back, 297

new forms
inserting, 182

NotAny operator, 216

object properties, 49, 50
specifying, 49, 50

Objects window, 231
open-ended questions, 79
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opening
databases, 247
files, 247
spreadsheets, 247

operators
in the Rule Wizard, 216
logical, 216

Operators window, 236
option button controls

caption alignment, 117
caption position, 117
square style, 116

ordering form objects, 102
other response

adding to questions, 90, 92

page breaks, 186
displaying, 185, 186

page size
forms, 185, 186

pasting, 154
cases, 263
controls, 107
previous case, 264
values, 263, 264
variables, 154

pictures
adding to forms, 189

primary selection, 93
printing

cases, 268, 269
data, 268, 269
forms, 181, 268

procedures, 239
creating, 240
debugging, 242
deleting, 242
example, 241
printing, 242

Procedures window, 240

program components
Data Entry Builder, 7, 10
Data Entry Station, 7, 8
SPSS Data Entry Enterprise Server, 9

properties, 49, 50
file properties, 251, 252
form objects, 95
number properties, 122
specifying, 49, 50, 95
using in rule scripts, 245, 246
variables, 144

Properties window, 49, 50

question libraries, 10, 171
adding files to, 175
adding folders to, 175
adding questions to forms, 173
copying questions to forms, 173
searching, 173
using, 171

question properties
specifying, 49, 50

question text
alignment, 117
editing, 96
multiple response sets, 168
selecting, 93
specifying font, 114

question types
changing, 113
list box questions, 85
matrix, 129, 130, 131, 132
scale button matrix, 129, 130, 131, 132

questionnaires
designing, 177
multiple forms, 179
printed, 181

questions, 53, 122
adding response controls, 105, 106, 107, 108, 109, 

110
connection with variables, 66, 67, 69, 71
copying and pasting, 72, 73, 74
copying from question libraries, 173
creating, 54, 55, 57, 59, 63, 65
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creating from variables, 63, 65, 66
customizing, 93
cutting, 75, 76
deleting, 76
disabling, 118
grouping, 103, 104
hiding, 119
moving, 73
numbering, 54, 121, 122
question libraries, 171
requiring a response, 59
resizing, 98
selecting, 93
toolbox, 57, 59
ungrouping, 105

raised style
questions and controls, 116

Range operator, 216
rectangles

drawing on forms, 189
relations

grouping, 217
negating, 217
removing, 217
separating, 217

removing response controls, 112, 119
reordering variables, 156
replacing

data values, 267, 268
strings, 267, 268
text in the Form window, 184

resizing form objects, 98
response control types

changing, 113
check boxes, 82, 83
drop-down lists, 83, 84
list boxes, 85
long text box controls, 80
matrix, 129, 130, 131, 132
option buttons, 80, 81, 87
scale button matrix, 129, 130, 131, 132
text box controls, 78

response controls, 77
adding to questions, 105, 106, 107, 108, 109, 110
changing type, 113
copying and pasting, 107
customizing, 93
disabling, 118
hiding, 119
removing, 112
resizing, 98
selecting, 93

response items
scale button matrix, 137, 138

responses
adding to questions and variables, 105, 106, 107, 

108, 109, 110
removing from questions, 112

rule options
turning rules off and on, 220

rule scripts
components, 234
creating, 227
debugging, 242
deleting, 242
editing, 228
examples, 243
how scripts work, 230
objects/properties/methods, 230
overview, 225
printing, 242
windows, 229

rule violations
overriding, 261

Rule Wizard, 195
adding relations, 217
creating Checking rules, 204
creating Skip & Fill rules, 210
creating Validation rules, 197
modifying relations, 217
operators, 216
specifying skip options, 213
viewing scripts, 196

rules
Checking, 202
copying and pasting, 222
creating for the Web, 302, 304
deleting, 219



319

Index

editing a rule created with Rule Wizard, 219
example, 201, 206, 214
JScript, 194
overview, 193
Rule Wizard, 195
Skip & Fill, 208
Validation, 196

RuleViolation method, 232

saving
files, 247

scale button matrix
cell borders, 139
creating, 129, 130, 131, 132
deleting rows and columns, 136
displaying caption text, 137
inserting rows and columns, 135
reordering rows and columns, 136
response items, 137, 138
row and column markers, 138
selecting, 134

security
password protection, 299

selecting
form objects, 93
form text, 93
matrices, 134
multiple objects, 93
primary selection, 93

send to back, 102
server. See network server
sets, 154, 165
shortcut keys

entering data, 262
showing

columns in Table Entry view, 259
toolbars, 46

single-selection list box controls, 85
creating, 85

sizing
objects on forms, 98

Skip & Fill rules, 208
creating, 210

example, 216
on a printed form, 181
specifications, 208
specifying skip options, 213

skip pattern, 208
creating, 210

snap to grid, 101
spell checking, 185
spreadsheet view of data, 180
SPSS Data Entry, 7, 8
SPSS Data Entry Enterprise Server, 9
square style
Statements window, 237
status bar text

specifying for questions, 119
subquestions

adding, 105, 106, 107, 108, 109, 111
copying and pasting, 107

sunken style
questions and controls, 116

surveys
designing, 177
multiple forms, 179
on the Web, 311, 312
printed, 181

system-missing value, 153

tab order, 191, 192
Table Entry view, 42, 260

displaying hidden columns, 259
entering data, 259
printing, 268
switching between views, 43

text
adding to forms, 188
alignment, 117
editing on forms, 96
sizing automatically, 98, 117
specifying font, 114, 115

text annotations
number aliases, 127
numbering, 124
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text box controls
caption alignment, 117

3-D appearance
questions and controls, 116

title bar text
specifying for form, 183

tool defaults, 120
tool properties, 120
toolbars, 46

docking, 47
form toolbox, 47
moving, 47
Navigation toolbar, 261
showing and hiding, 46

toolbox, 47, 57, 60
creating questions, 59
displaying, 48

ungroup, 105
user-missing values, 153

Validation rules, 196
creating, 197
creating from variable properties, 200
example, 202
specifications, 197

value labels
multiple response sets, 168

variable properties
display format, 147
level of measurement, 149
missing values, 151, 153
name, 145
valid values, 153
value labels, 150, 151

Variable Properties window, 51
variables, 141, 143

cloning, 154
computing using rule scripts, 246
connection with questions, 67, 71
copying and pasting, 154, 155
creating, 144

defining, 144
defining for the Web, 301
naming, 146

vertical alignment, 117
viewing page breaks, 185, 186
views

Design, 42
Form Entry, 42, 257
Table Entry, 42, 257

Visible property, 119

Web Server
data collection, 312
images, 301

window style
Form window, 185, 186

Windows metafile graphic files, 189
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